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1 Introduction

1.1 About This Helpfile

1.1.1 About This Helpfile

Version 2.6

This helpfile is designed as a guide for understanding and using the features and functions of
Software Audio Console (SAC). This product is continually being updated with new features which
will be included in the helpfile with each update. Once you receive an updated version, look for
details on any new features and maintenance fixes in the Latest Release Notes located in the Info
dropdown menu within the program. Updated .pdf manuals will be available for download at the SAC
website at www.SoftwareAudioConsole.com.

1.1.2 Helpfile Conventions and Terminology

The following chart contains symbols and formatting will be used throughout this helpfile to indicate
special terms, notes, warnings, and actions. SAC is designed to be primarily a mouse-driven
interface. Therefore, this chart also contains many mouse conventions which will be used throughout
this helpfile.

I The hand symbol will be used to indicate important notices and warnings.

F The pointing finger symbol will be used to indicate a point of mention about a particular
feature or concept.

» The clock symbol will be used to indicate a time saving suggestion.

8 The mouse symbol will be used next to instructional text to quickly denote that techniques
described involve using the mouse.

7 The keyboard symbol will be used next to instructional text to quickly denote that techniques
described involve using the keyboard.

7 8 The keyboard and mouse symbols together will be used next to instructional text to quickly
denote that techniques described involve using both the keyboard and the mouse.

7 /8 The keyboard and mouse symbols separated by a slash will be used next to instructional
text to quickly denote that techniques described involve using either the keyboard or the
mouse.

M The M symbol will be used next to instructional text to quickly denote that techniques
described involve accessing a menu.

7 M The keyboard and M symbols together will be used next to instructional text to quickly
denote that techniques described involve holding a key on the keyboard while access a
menu.

Italics Capitalized italics will be used to identify screen objects, menu items, and reference to
terms relating to audio will be written in italics. (Examples: Click the Cancel button; Move to
the Zoom Mixer; the current HotChan.)

[Bracketed] Keyboard commands and mouse moves will be indicated with a bracketed font.

Click or Select When instructions indicate to 'click' or 'select' an object, press and release the left mouse
button quickly.

http://www.myhomepage.com/index.html
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Left-Click When instructions indicate to 'Left-Click', press and release the left mouse button quickly.

Right-click When instructions indicate to 'Right-Click' an object, press and release the right mouse
button quickly.

Double-click When instructions indicate to 'Double-Click' an object, press and release the left mouse
button twice quickly.

Left-Holding When instructions indicate 'Left-Holding' press and hold the left mouse button.

Right-Holding When instructions indicate 'Right-Holding' press and hold the right mouse button.

Left-Dragging When instructions indicate 'Left-Dragging' press and hold the left mouse button while
dragging the mouse.

Right-Dragging When instructions indicate 'Right-Dragging' press and hold the right mouse button while
dragging the mouse.

Left-Right Clicking When instructions indicate 'Left-Right-Clicking' press and hold the left mouse button and
then tap the right mouse button once.

1.2 Product Overview

1.2.1 SAC Overview

SAC is the acronym for Software Audio Console. This program runs in Microsoft Windows and turns
your Windows PC into a powerful Virtual Live Mixing Console.

SAC opens new realms of live sound mixing capabilities with virtual mixing technology built around a
core hand coded assembly language engine. The look and feel of a fully controllable Front Of House
(FOH) console, coupled with 24 duplicate monitor mixing consoles with digital split points from 5
locations within the FOH Input Channels, or Master Monitor 1 channels, creates a whole new way of
mixing live sound while eliminating and replacing racks of physical equipment, snake cabling and
splitters.

The FOH Console

The virtual console is designed as a 72 input channel, 72 output channel FOH console, with Input
Source, Mono, Attenuator, Phase Reverse, Swap L/R, 5 Band Stereo fully parametric EQ with
additional Hi and Lo Cut filters, Keying Gate and Compressor with bandpass filter, Pre and Post FX
patch points, 6 Stereo Aux Sends with Pan, 24 Stereo Output Assigns, 8 point XY Surround Pan with
separate Sub and Center Chan, Solo, Mute, Stereo Pan, long throw Fader with a Stereo Hi
Resolution (-60 dB) Meter on each channel.

Any input channel may be assigned to any or all output channels at the same time. 8 Master Output
channels may be routed to any hardware output device while the remaining 16 Output channels can
be used as subgroup faders, folding back to any or all of the 8 Master Faders. In addition, the
subgroup faders can be used as fader latches to the input channels assigned to that group, similar to
VCA Fader groups. When used in this manner, the input channel signals are not routed through a
subgroup bus, but instead are linked to the use of the group fader as a master group control. The
group master can be re-located anywhere on the console, directly beside the channels it is
controlling. The Aux Sends may be internally routed as virtual or patched out to any device output,
and returned from any device input, in sync, direct into the FOH mix, through 6 independent Return
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channels, each with complete FX patching capabilities and their own Hi Resolution Meters.

XY Surround panning is built in and can be assigned in any manner to up to 6 discreet outputs. The
surround setup can be saved in templates making 5.1, 7.1, quad surround or any configuration
available at the touch of the mouse.

The console can be displayed in different views, independently or simultaneously, allowing quick
access to multiple perspectives of the current information.
The console has extensive navigation capabilities and is intimately linked to the different views. There
are popup navigation menus that display labeled channels and track references, allowing instant one-
click access to anywhere you need to go.

The Monitor Consoles

The FOH console inputs internally split to 24 monitor consoles, giving essentially duplicate versions
of all FOH console views and allowing you to mix monitors from master faders instead of Aux Sends
or Matrix knobs. This allows each monitor mix to be its own 72 channel stereo mix with its own
overlayed Eq and Dynamics sections, as well as its own 6 stereo Aux Sends and Returns.

Each Monitor console has 8 Master Stereo Output Channels, leaving 16 channels to be used as
subgroups, similar to the FOH mixer. The input splits can be taken from the FOH Src Pre Attenuator,
FOH Src Pre Attenuator, Pst EQ, Pst Dyn, Pre fader or Post Fader, or from the Monitor 1 mixer. This
allows the Monitor 1 mixer to be used as a completely separate master monitor mixer with all other
monitor mix taps coming from it. Monitor mixer 1 still taps from the FOH mixer, but the rest of the
Monitor mixers can use the FOH taps or monitor 1 taps labeled with the letter M at the end to tap from
Monitor mixer 1. This allows complete separation of the Monitor mixers and FOH for use with two
mixing engineers. FOH can use its own EQ and DYN and Monitor mixer 1 can act as a master Monitor
mixer with a src split tap and its own EQ and DYN. The rest of the Monitor mixers can then tap from
Monitor mixer 1 as a master, instead of FOH.

Each monitor console and individual input channel can use any one of those split points
independently of every other channel, opening up a brand new dimension in monitor mixing routing
and control.

Scenes And Automation

SAC offers some of the most comprehensive automation capabilities ever designed for the live sound
industry. The automation engine is based on a live streaming design, as well as a scene/snapshot
design, creating an incredibly smooth and fluid motion during automation and scene changes - with
down-to-the-sample timing accuracy.

A Scene View stores and recalls complete scene/snapshot storage for all 25 consoles. Each scene
has its own filter properties dialog which determines what controls, channels and mixers the scene
operates on. You can set a scene to operate just a mute switch on a certain channel on all monitor
mixers, or any combination of module controls and sections, along with channels and mixers. This
allows separate scenes to control only FOH, others to control only monitor mixers or any single
monitor mixer. This power is easily set and modified after the scene creation. Scenes can be
positioned in the listbox in any order and therefore easily grouped to the operator's desire.

Scenes can also contain a fade time property which controls the time it takes for the scene to
complete its action. This creates automatically timed and generated crossfades on all controls, with
switch action adjustable to occur at the fade start or end. Every control that fades will do so from its
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current position to its new destination position and complete its action at the same time. The fade
engine is independent of new scene recalls while the last scene is still fading, therefore you can
overlap scene recalls and live control adjustments without fear of cutting off a previous action
midstream.

A Sequence View allows you to arrange Scenes in any order to automate a complete show
performance. Scenes in the Sequence View can be adjusted to include fade times, which create
seamless crossfades between scene changes. SubScenes may also be created within a single Scene
cue which can execute in realtime as a sequence of complex events with a single Trigger command.

The Engine

The underlying architecture is an entirely new - from the ground up - virtual mixing engine, based on
many years of experience with the development and maturity of the SAW product line.

The focus of this new engine design is centered around the live, low latency input driven technology
that forces the engine to sense and trigger precisely from live input data stream timing. This engine
assembles the data, LIVE, on the fly, directly in front of the actual data being played out by the sound
devices, delivering instant reaction time and the feel of a physical console, without glitching the audio
data.

The engine makes extensive use of multi-processor and priority multi-threaded code design, and with
its hand coded assembly language techniques, is capable of reaching performance levels not thought
possible within the standard Windows environments.

The engine is also self correcting in the event that something in the Windows environment steps on
the processing threads and causes the loop to not have a buffer ready in time for output. This new
design detects and re-syncs the engine on the fly to eliminate any possible slipped buffer latency drift
over time.

The design uses advanced assembly language techniques to emulate all functions of the console
portion of the program. Faders, eq, dynamics, aux sends and returns, meters, echo/delay, reverb, etc.
are all emulated DSP routines, that rival the performance of hardware based units when used on
high-end computers. This design also eliminates the need for special DSP based hardware sound
devices, allowing standard audio sound cards access to all of the design features.

The new engine design allows for most every program operation to be performed live, while the
engine is running, without the need to stop the data stream to change device assignments, input and
output routing or save sessions and manipulate Scene and Sequence data.

Because of the low latency capabilities, this engine is a perfect match for external fader packs and
mixer controllers. SAC uses a complete virtual lookup table design to link incoming controller signals
to virtual console controls, and other internal functions of the engine. Different hardware controller
information can be stored in templates (without the need to update or rewrite the program code) that
can be instantly loaded into the program to change from one controller type to another, without the
need to restart the program! Templates are available for a wide variety of the most popular
controllers, and future templates will be made available for download, as new hardware is released.

FX Processing

A brand new powerful SAC API (Application Programming Interface) has been developed for handling
FX Plug-Ins. This interface offers one of the most direct and streamlined protocols for passing
information between the application and processing plug-ins. This design also offers enhanced power



SAC User Manual8

© 2008 - 2010 Robert Lentini and RML Labs

and control, including automation capability, while actually increasing overall efficiency. The API is
compatibile with most Native SAWStudio plugins.

The DirectX and VST protocols are seamlessly woven into the engine design, with all plug-ins of all
types showing in one common effects choice window. With the current availability of numerous
DirectX and VST plug-ins to choose from, you can begin FX processing immediately without waiting
for future development.

Effects are hot-patchable, meaning they can be plugged in and out in real-time during playback! The
engine will automatically initialize and insert the plug-in directly into the audio loop in perfect sync,
without the need to stop the stream.

Note that any plugin causing latency by witholding data can not be used in this live mixing
environment and will be detected by the engine and automatically bypassed internally.

TCP/IP Remote Network Access

SAC also includes an extensive internal networking engine that allows up to 28 remote users to
access the system via standard TCP/IP network connections. You can use a simple ethernet cable
and hub or switcher, or a wireless system to allow complete freedom to roam the venue and control
everything from a remote laptop. A set of user stats can control the access rights of anyone
connected to the host system. You can connect as a FOH engineer, which gives you access to FOH
and all 24 Monitor consoles. You can also connect as a MON engineer, which gives you access to
only the 24 Monitor consoles. A final tier allows a PERsonal connection to just 1 Monitor console,
which opens the door for any performer onstage to have complete control of his, and only his,
complete Monitor console.

Remote control of SAC is handled by a separate program spinoff called SACRemote and this program
is available as a free download from the website. This program can be freely distributed and installed
on desktop or laptop computers to be used as FOH, MON or Personal Monitor remote control stations
for a Host/Master SAC system. The SACRemote version has no audio engine or hosting abilities and
requires connection to a SAC Host/Master system to be functional, although all other interface
functions remain the same and it is also a perfect way to learn the basic SAC interface and create
session templates and scenes while run in stand-alone mode to be later imported into the main SAC
sessions.

The network protocol design allows users to remain independent and operate their separate mixers
without interference from others connected to the same host. The FOH engineer and Monitor
engineer can have separate solo buses and therefore solo simultaneously without interference from
each other. The Personal Monitor users have a special solo mode that keeps their signals in place
and routes to their own monitor output mix. This mode cuts all non-soloed signals by 12 db, thereby
allowing them to continue in perfect time with the performance while still featuring a soloed signal.

The scene recalls work independently for each user, allowing each to recall scenes that modify only
their mixers without interference with the rest. This allows the FOH engineer to use scene recalls
that control his mix, while the monitor engineer can recall scenes to control the monitor mixers, while
each individual personal user can recall his own scenes that just control his personal mix.

The focus of this design concept is to allow one master system to remain off the side of the stage,
with all mic inputs connecting there, eliminating the need for a large multi-pair snake feeding the
signals to the FOH position. The FOH engineer can connect with a remote computer and do all he
needs to do on the same system, while at the same time, the Monitor engineer can sit at the stage
system or any other remote location to handle monitors, and individual performers can also connect
and control their own personal mixes. This one system, powered by SAC, can replace two large
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mixing desks and at the same time add multiple separate mixing desks for all monitor mixes, while
replacing multiple snake cables and splitter boxes and external racks of graphic equalizers for all
the power amp racks. The art of Live Sound is about to change forever.

Direct Link To SAWStudio

SAC includes internal shared memory buffer hooks directly into the SAWStudio Lite and Full
programs. You can have SAWStudio running at the same time as SAC and linked with the Sac Link
option to pass audio data directly between the two programs in both directions. The beauty of this
design is that SAWStudio drops its connection to the soundcard hardware and reaches the outside
world directly through SAC. SAWStudio is internally set for larger buffers, so it operates in a relaxed
state, while SAC does all the hard work of handling the low latency monitoring. SAC will allow you to
select SAWStudio Input Channels and Output Channels as source signals and SAWStudio will
allow you to select SAC Channels as recording input sources. Recording a live performance from
the SAC FOH setup is a snap with SAWStudio running effortlessly in the background. You can even
pass mix setup information from SAC to SAWStudio or the other way around to make it easy to link
sessions between the two. The links allow both programs to function together transparently on the
same computer.

It's time to let SAC change the way you work with live audio forever. Welcome to the dawn of a new
era of Live Sound Mixing!

2 SAC Fundamentals

2.1 Terminology

2.1.1 SAC Terminology

This section is a brief glossary of terms which are used throughout this helpfile. Many terms are
similar in description and in some cases interchangeable. Use this guide as a reference if you need
further clarification on a specific term.

Buffer An area used to store data temporarily.

Channel Refers to a channel in any one of the mixer views. Three types are available.
Inputs, Returns, and Outputs.

Console Refers to the virtual mixing console. Used interchangeably with the term Mixer.

Default The values or configuration settings automatically loaded when SAC is started.

MIx Session Mix Session File, which stores all session related information including
automation, mixer configuration, scene and sequence data.

Hot Channel The currently selected channel in any mixer view.

Scene A complete snapshot of the current Mixer configuration and layout. Recalling a
scene will instantly return the entire console to an exact setup configuration.

Resolution The amount of detail in a digital audio image.
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Sample A snapshot of the original acoustic audio signal, which when assembled
sequentially with other samples, creates a facsimile of the original signal.

Samplerate The interval between Samples. The higher the samplerate, the closer the
facsimile is to the original.

Mix Template Mix Template File, which saves a console pre-set configuration, which can be used
as a starting point to save time and maintain consistency from session to session.

Zone An active area in the SAC workspace, (not considered a button) used for
navigation purposes and accessing menu options.

2.2 The Fundamentals Of Digital Audio

2.2.1 What is Digital Audio?

Prior to the computer age and the introduction of digital audio concepts, analog technology ruled the
audio recording industry. Analog audio can be considered a continuous stream of fluctuating
electronic pulses, a perfectly smooth facsimile of the original acoustic audio signal.

Digital audio, however, is actually a series of individual snapshots of the original acoustic audio
signal, taken at defined time intervals, which when sequentially reassembled, creates a facsimile of
the original signal.

Because the components of a digital audio signal are discreet in nature, they can easily be stored
and manipulated as files in a standard PC computer environment. Different data streams can be
mixed and processed solely in a math based environment without the need for complex circuitry and
mixing bus schemes to control and manipulate large audio mixing tasks.

The time intervals between snapshots we refer to as the SampleRate. The smaller these intervals are,
the more snapshots there are within a specified time. For example, if the time interval is a tenth of a
second, then ten snapshots will be taken per second, making the SampleRate ten. If the time interval
is a hundredth of a second, then 100 snapshots will be taken per second, making the SampleRate
100. The higher the SampleRate, the more snapshots per second there are, making the facsimile
closer to the original. We will refer to each snapshot as a sample.

Each sample in a digital audio signal represents the instantaneous volume level of the original audio
at the moment the sample was taken. PC computers represent number values as binary data. The
basic building block of binary data is called a bit. The higher the number of bits, the higher the value
they can represent. For instance, one bit can represent two values, 0 and 1. Two bits combined can
represent four values, 0, 1, 2, and 3. Eight bits can represent 256 values, 0 through 255. Sixteen bits
can represent 65,536 values.

When representing an audio signal with eight bits, the facsimile of the original is very limited in detail
(only 256 values available). When representing the same signal with 16 bits (65,536 values
available), the amount of detail captured more closely duplicates the original signal. The amount of
detail is referred to as resolution. The higher the resolution and the SampleRate, the higher the
quality of the digital audio captured.

The tradeoff to using the higher resolution and SampleRate values is the need for more computer
memory and speed to store and manipulate the data. For example, an 8 bit resolution, 44100 Hz
SampleRate stereo soundfile requires approximately 5.25 megabytes of hard disk storage per minute,
whereas a 16 bit resolution, 44100 Hz SampleRate stereo soundfile requires approximately 10.5
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megabytes of hard disk storage per minute.

2.2.2 Understanding Bit Resolution and Dither

Bit Resolution discussions have generated much controversy in recent years. Along with the
controversy has come a shroud of confusion and in many cases, misinformation. This section
attempts to cut through the confusion and at least shed some light on how SAC handles the audio
data stream resolution.

What Is Bit Resolution?

As mentioned earlier, each sample in a digital audio signal represents the instantaneous volume level
of the original audio at the moment the sample was taken. The computer represents the sample
values as binary data based on the building block called a bit. More bits can represent larger values.
For instance, one bit can represent two values, 0 and 1. Two bits combined can represent four
values, 0, 1, 2 and 3. The formula for figuring the number of values is 2 to the nth power (2n) where n
represents the number of bits.

Representing an audio signal with more bits of resolution can create a much finer and more detailed
rendering of the original signal. The theoretical dynamic range of a 16-bit digital audio signal is 96 db
from maximum to minimum signal, whereas for a 20-bit signal, it's 120 db, and higher for a 24-bit
signal.

Realize that as you approach these resolutions, many other factors come into play, such as amplifier,
thermal, and cable noise that pull the realizable dynamic signal range below these values, but
nevertheless, you can see that the higher the bit resolution, the better the digital audio image.

How Does SAC Handle Bit Resolution?

The internal audio data path in SAC is maintained at a full 24-bit resolution stored within full 32 bit
DWORD buffers. All audio input or file data is shifted up to 24-bit resolution as it comes in. This does
not add fidelity to 16-bit audio signals, but does place them in position to be processed and mixed
with other data that is at a higher resolution. The internal math is handled as high resolution integer
math, coded in assembly language with a full 64 bit internal overspill data register to allow for high
mixing levels without internal signal clipping thruout the data path. This engine can sum 128 channels
of 24 bit audio data at just under clipping levels without internally clipping any of the summing buffers.
This allows SAC to deliver smooth analog sounding results without the harshness and scrathiness
normally associated with digital audio systems.

Another advantage to working at the 24-bit internal resolution, even on 16-bit source data, is that all
signal processing, such as equalization, dynamics, reverberation, etc., will retain the extra low level
bits that result from the processing algorithms, and pass them through the chain to the final mix stage.

The final destination resolution decides what happens to the data at the output stage. If the final
resolution is less than the 24 bit internal data path, then the data is simply shifted down to the final
resolution setting and the low level bits are truncated. If the final resolution is set to 24 bits, then the
internal mxing path is left completely intact.
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2.3 Essential Basic Concepts

2.3.1 Active Windows

The SAC interface displays many windows at the same time. The window title bars can be used to
determine which window is the active window with the keyboard focus. The active window will display
its title bar text in yellow, while in-active windows will display their title bar text in dark gray. Clicking
inside of any window typically makes that the active window.

Many common keystrokes will cause different actions depending upon which window is the active
window. Make sure you take notice of which window is active before depending on keystroke
command functions.

2.3.2 Sizing and Moving Windows

If a window can be sized, you may do so by pointing the mouse arrow to the edge of the window until
a double-headed arrow is displayed. When you see the double-headed arrow, click and hold the left
mouse button and drag the window to the desired size.

Move any window by clicking and dragging its title bar and moving the window to a desired location.

2.3.3 Using a List Box

To navigate inside of a list box in SAC (such as the Scenes View window), use one of the following
methods:

· Use the Up and Down arrow keys to move up and down the list one item at a time.

· Use Page Up/Page Down keys to page up or down through the list, one screen at a time.

· Click the scroll bar arrows to move up or down one item at a time.

· Drag the scroll box inside of the scroll bar to move to a relative position.

· Click inside of the scroll bar on either side of the scroll box to move up or down a page at a time.

· Use the Home/End keys to go instantly to the top or bottom of the list.

· Use the Wheel control on a wheel mouse.

2.3.4 Using the File Dialog Boxes (Open/Save)

I Regarding File Management: It is recommended that you learn the basics of file management in
the Windows platform (Windows Explorer or My Computer) from one of the many books available
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on the subject, or by studying the online help files built into the Windows operating system.

Basic concepts:

· The Drive/Folder Drop Down List indicates the folder you are currently accessing. Click the arrow
to the right of the list box to display the hierarchy and drive information or select a new
drive/folder location.

· To navigate to a folder residing within the current folder, double-click the desired folder name
displayed within the Contents List. The newly selected folder name will be displayed in the
Drive/Folder Drop Down List, and its contents will be displayed in the Contents List.

· Use the Up One Level button to go backwards in the file structure.

· Use the Create New Folder button to create a new folder inside of the currently displayed folder.

· Use the Contents View button to display just the names of the files and folders in the Contents
List.

· Use the Detail View button to display the names of the files and folders along with the size, type,
and last modified date of each file.

· To open a file, navigate to the desired folder location, click the desired file name and click Open.

· To save a file, navigate to the desired folder location, type the name of the new file in the File
Name text box and click Save. Filename extensions will be appended automatically.

· Use the File Type drop-down listbox to choose a different file type extension.

· To use context sensitive help inside of a Windows dialog box, click the 'What's This' button then
click on the dialog box item you want more information on.  An applicable help screen will be
displayed.

· Click the Close button to close the Save As dialog box.

2.3.5 Using Online Help

The SAC helpfile is carefully written and very useful once you spend some time with it. In fact, it is
strongly recommended that you take a couple hours to read (or at least browse)  the entire file using
the >> and << buttons on the helpfile toolbar. The time you'll spend reading the helpfile will easily be
made up for when you find your sessions are requiring less and less time because you've expanded
your knowledge base of the program and can move much quicker.

If you need to look something up quick in the helpfile, use the FIND tab on the Help Contents window.
If you've not used this before, you will be given a one time prompt to let Windows build a helpfile
database which then displays a list of every word in the entire helpfile.  This is a great way to search
for help on something like "mute" or "solo bus". Once you've typed in a word to look up, you'll quickly
be given a list of each helpfile topic that contains that word. You can then pick the topic(s) that are
most applicable and read just those.

There are times when the INDEX tab may be more efficient. For  example, if you want to find out what
the UP button is used for in SoundFile View. Typing the word "up" in the INDEX tab will take you right
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to that button's helpfile. Typing the word "up" in the FIND tab will give you a complete list of every
help topic containing the word "up" no matter what the context, which would not be desirable this
case.

The SAC helpfile is a gold mine of information - not just in understanding SAC, but in understanding
digital audio and mixing concepts as well. Take advantage of the simple helpfile interface to maximize
your knowledge of the program and truly become a SAC pro.

2.4 Program Notes

2.4.1 Use Of The Alt key

The Alt key is used for a variety of operations and as a modifier key to force popup properties menus
in certain areas of the interface. As a result, its default behavior for accessing the main menu bar has
been altered from standard Windows behavior. You must press and release the Alt key to access the
main program menu bar via the keyboard, then press the associated keys to access the individual
menu options. While the Alt key is held down, SAC will be waiting and considering its use as a
special modifier key for varied operations and interface control.

2.4.2 Interactive Links

There are optional interactive links designed into the SAC interface between the Mixer Views and the
multiple control views that facilitate control of the environment. If active, these links can assist
tremendously in the complex control of the program. These links make it possible to display just one
zoomed mixer channel which will always follow the Full Mixer positioning, thereby placing all controls
for the track or channel of focus directly at your fingertips. This can save valuable screen real estate
for other views and windows.

The individual links can be broken, making it possible to lock a particular mixer view onto certain
channels making them always visible. This mixer view won't be affected unless you manually adjust it.

Read the Menu Reference Guide and experiment with the Navigation Links option found under the
Mixer menu.

F The SAC installation defaults to having most links active. References to this feature throughout
the helpfile will assume that links are active.

2.4.3 MouseWheel Support

MouseWheel support is included in SAC.

78 In the Mixer Views, the wheel will scroll the view left and right changing Hot Channels by one
increment per wheel click. Pressing the [Shift] key at the same time will change the view one
page at a time.
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2.4.4 Multi-Language HotKey Compatibility

If you have multiple language options installed in your Windows configuration, language switching
hotkeys must be disabled to prevent interference with SAC's use of the Control, Shift and Alt modifier
keys.

To disable hotkeys language switching in Windows XP:
1. Open the Control Panel and select "Regional and Language Options".
2. Click on the "Languages" tab.
3. Under Text Services and Input Languages, click "Details" button.
4. Under Preferences, click the "Key Settings" button.
5. Go Advanced Key Settings, and under "Hot Keys for Input Languages" disable all language

switching radio buttons.

To disable hotkeys language switching in Windows 2000:
1. Open the Control Panel and select "Keyboard".
2. Click on the "Input Locales" tab.
3. Under the Hot Keys for Input Locales section, click the "Change Key Sequence" button.
4. Be sure the "Enable Key Sequence" checkbox is not checked.

To disable hotkeys language switching in Windows NT:
1. Open the Control Panel and select "Keyboard".
2. Click on the "Input Locales" tab.
3. Under the Switch Locales section, be sure the radio button that says "None" is selected for each

language installed.

2.4.5 Forced Engine Shutdown

Special code has been added to activate a complete forced Engine Shutdown in the event of a driver
or audio engine lockup condition during playback or record. Pressing the [Break] key (labeled
"Pause" on many keyboards) will force all engine threads to shutdown in sequence to break the
engine out of a locked play loop. A Forced Engine Shutdown message will display on the screen
while the program attempts to reset the threads to a stable condition. If the engine is in a locked play
condition and you attempt to stop multiple times back to back by normal stop methods, it will force this
shutdown routine into action also.

F Some keyboards have separate 'Break' and 'Pause' keys, and many laptops may require the
use a special function key denotes by color coding on the keyboard. It is recommended that
you test this feature on your system during ordinary playback to determine which key or key
combination activates this break function, so in the event of a real lockup, you will have a
chance for a simple recovery.
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3 Getting Started

3.1 Installation

3.1.1 System Requirements

SAC is designed to run under Microsoft Windows NT, Windows 2000, or Windows XP on a high-end
PC-compatible system. Currently Windows 95/98 are not capable of handling the priority threading
required by the SAC engine.

SAC requires a Pentium 4 - 1.8ghz or higher with as much RAM as possible. The current min
requirement is 512 Mb but 1 gb is much better. The video card must handle 1024 x 768 or higher at
65,000 colors. SAC requires at least one Windows-compatible, multi-channel 16-bit audio device and
supports up to 36 stereo devices (72 simultaneous inputs/outputs).

A dual CPU or Hyperthreaded CPU can deliver much better display performance when the engine is
loaded down.

3.1.2 Setting Your Windows Display

SAC is able to display a substantial amount of information on the screen at any given time and
requires a video resolution of 1024x768 or higher with at least 65,000 colors. Video resolutions of
1280x1024 or higher are recommended for the most efficient use of the interface. The 768 vertical
height will not display the Wide Mixer View without overlapping the main Client Y Btn area.

Even though your video card and monitor might be capable of these higher resolutions, the Windows
operating system installs at a default resolution of 640x480. You must specifically select one of the
higher resolutions. Refer to your video card documentation, the manufacturer, or your computer
supplier for information on adjusting your video resolution.

The Use Of Dual Monitors

All window views in the interface are popup windows with no boundary restrictions that may be
positioned anywhere you desire on your desktop display area. This facilitates the use of dual monitor
displays to maximize screen real estate. In all cases, we recommend setting your screen resolution to
the highest settings possible with your equipment to maximize the ease of navigating through so
much visual display information.

3.1.3 Installing Your Audio Device (Sound Card)

Complete the installation of your audio device(s) according to the instructions that accompany the
device(s). Follow the manufacturer's recommendations and complete any necessary testing to insure
that the device is functioning prior to running SAC.

SAC requires that your soundcard be able to deliver stable performance at very low latency settings.
Buffer sizes of 3 x 128 or lower will be needed for live audio performance. SAC supports the older
MME protocol standard and the more recent ASIO driver standard. The newer soundcards and
Windows Vista no longer support MME, so you will most likely be forced to use the ASIO driver
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model. SAC also supports RML Labs own protocol called DWave, which we are currently attempting
to gain more support for from the various soundcard manufacturers. With ASIO, you should be able to
reach buffer settings of 1 or 2 x 64 for very realtime live audio performance.

I Regarding High Resolution Compatibility: Since the original Windows MultiMedia standard is
at best, loosely defined concerning resolution definitions beyond 16-bit, there may be
compatibility issues at the 20 and 24-bit resolution settings with certain audio device drivers.
There is a special 24 bit WDM compatibility mode that you can try, but in general, you should be
fine using the ASIO driver model.

3.1.4 Installing Your MIDI Device

SAC has the ability to generate and read MTC time code, and also send and receive MIDI mixer
control information with any MIDI device. Complete the hardware installation of your MIDI device
according to the manufacturers instructions that accompany the device. Refer to the Midi Device
Setup and Sync Device Setup options under the Options menu in the Menu Reference Guide for
further information on setting up SAC to use the installed MIDI device.

3.1.5 Installing SAC On Your Computer

To install the SAC program onto your computer, you should place the downloaded program file into a
folder on your harddrive (not on the desktop) and double-click the self-extracting program .exe file. I
recommend creating an INSTALL folder on one of your drives and then create subfolders for the
different companies or products that you download. For example: create a C:\Install\RML Labs
folder... place the downloaded programs in there and they are easy to find anytime you need to re-
install at a later time.

Installing SAC From A Downloaded Program File

8 From the Explorer window, navigate to the location where you saved the downloaded self-
extracting program file called SAC_xx.exe. [Double-Click] the file. Follow the prompts to
complete installation.

SAC will install into its own folder (you can specify a different one if you like). The installation
of SAC will in no way affect any of your system files. All files are installed to one location,
without adding files to system folders or changing existing configuration files or writing to the
Windows Registry.

The program will also create subfolders under the application folder for storage of various files
required for operation.

F Although the program defaults certain operations to these subfolders, it is recommended that
you use the File Path Setup option under the Options menu to setup alternate paths for the
session files and undo storage at a separate location outside of the program folder, preferably
on a large designated audio storage drive.

I Important Information Regarding Product Updates: Please read the Latest Release Notes
file (in the program's Info dropdown menu) for recent information about your current program
version. This file will always contain information and operation guidelines for new features
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added.

3.2 First Things First

3.2.1 Starting SAC

Once you have successfully completed the setup program installation, you are ready to run the SAC
program.

8 [Left-Click] the Start menu on the taskbar, point to Programs. Point to SAC and [Left-Click] the
SAC program icon.

F You may also create a program shortcut on the desktop and double-click the icon to start
the program. To create a shortcut icon, open the Windows Explorer, and size the window
so that a portion of the desktop is visible. Navigate to the SAC folder, [Right-Click] on the
SAC.exe file and choose Create Shortcut from the popup menu. This will leave the
shortcut in the SAC folder. [Left-Drag] the shortcut to the desktop. You could also simply
[Right-Drag] the file to a blank spot on the desktop and when you drop it, it will popup a
menu. Choose Create Shortcut to create a shortcut directly on the desktop.

7M [Left-Clicking] the X close button in the upper right corner of the program windows will close
SAC. You may also choose Exit from the File menu.

Startup Command Line Options

SAC accepts an .mxs filename on the command line when starting up. This will run the program and
automatically load the Mix Session file. The Live engine light will flash letting you know the mixer is
ready to go. Check your levels and connections and then start the Live engine by [Right-Clicking] on
the Live Light in the top left corner of the Main Window Client Y zone.

For example, to have SAC load a Mix Session on startup from a shortcut icon on the desktop:

1. From the Windows desktop, [Right-Click] the SAC shortcut icon.

2. Select Properties from the shortcut menu.

3. Click the Shortcut tab.

4. In the Target textbox, click at the end of the command line.

5. Add a space, then type the pathname for the MXS File.

Example:  C:\SAC\SAC.exe D:\Mix-Sessions\Test\Test.mxs

6. Click OK.

7. Double-click the icon to start the program.

Note that if any of the target line paths or names contain spaces, be sure to enclose the full pathname
in quotes.
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Example:  "C:\SAC\SAC.exe D:\Mix Sessions\Test 2\New Test.mxs"

3.2.2 Adjusting Device Parameters

When you first run SAC, you must configure the program to work with your audio device(s). From the
Options menu, choose Audio Device Setup. There are several options to adjust.

If you decide to use the ASIO protocol, the devices are automatically filled in for you. You may still
modify the list choices and save your preferences and the modified list will become the default.

First select the Audio Driver Model option from the Options menu. There you can select one of the
MME options, the DWave option, or the ASIO option. When selecting ASIO, a small popup menu will
be displayed with a list of available ASIO drivers for your installed hardware. Pick your soundcard and
the Audio Devices list will be filled in with all of the available device channels.

Note that all devices are treated as stereo pairs, although you can access individual mono inputs in
the mixers themselves. When using ASIO drivers, the numbering may display only the odd numbers
on each device listing, but that device is actually picking up the odd/even pair.

Performance Considerations

To use SAC effectively, you will want to achieve the lowest buffer latency settings you can while still
maintaining system stability. There are many things to consider in order to make this happen.

Your system may have a single fast processor or dual processors, or dual core processors in one
chip, or even a single core processor with Hyperthreading which makes it appear as a dual processor
to the system.

Dual processors are touted as a way to offer higher performance because the OS will delegate
multiple tasks to the different processors at the same time. But, this may not always pan out as
expected in the real world, especially in an application like SAC that will be switching between many
driver and data threads at speeds of a millisecond or less. The actual thread and context switching
time between processors, all sharing the same memory and data bus, can actually add overhead to
the time it takes to get the job done, as compared to keeping everything inline on one fast processor.
When using buffer sizes of 64 samples or less, you may find higher stability and performance in
single CPU mode on many multi-CPU systems. The processor and thread switching overhead can
interfere in many cases with the extremely fast loop times required to maintain these low latency
settings and actually start causing slipped buffers. Also note that drivers may still be spawning
multiple threads to multiple CPU's outside of SAC's control, and therefore total stability in a dual cpu
system involves potentially hundreds or thousands of interwoven code segments throughout the
entire system to be working in perfect sync. You may find much more stability by actually forcing the
boot to only seeing a single CPU by using the boot.ini /ONECPU flag.

You can tell if you have hyper-threading active or are running a dual cpu system by Right-Clicking the
TaskBar and selecting the Task Manager… select the Performance tab and look at the graph of the
cpu usage. If there is more than one graph, hyper-threading or more than one cpu is active.

You can force the system to boot to a single cpu mode by editing the boot.ini file found in the root of
the boot drive and add the /onecpu option flag at the end of the first line under the [operating
systems] section.

You may copy the line and change the name to reflect the single cpu option and create a boot choice
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that allows you to select single or dual mode when the machine first boots. For example, your boot.ini
file may look something like this:

[boot loader]
timeout=30
default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS
[operating systems]
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP
Professional" /fastdetect

The last line is the actual boot control that starts the OS. You can copy and paste the line so it looks
like this:

[operating systems]
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP
Professional" /fastdetect
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP
Professional" /fastdetect

Then modify the text within the quotes as follows:

[operating systems]
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows XP Professional
[Single CPU]" /fastdetect
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows XP Professional [Dual
CPU]" /fastdetect

Then add the /onecpu option at the end of the first line as follows:

[operating systems]
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows XP Professional
[Single CPU]" /fastdetect /onecpu
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows XP Professional [Dual
CPU]" /fastdetect

You will now see a screen when starting the system with the two text lines giving you a choice to
select the Single or Dual option.

Hyperthreading has been known to cause many low level issues in many systems when trying to do
realtime low latency audio streaming of the nature that SAC would like to achieve. At the time of this
writing, it is recommended that you turn Hyperthreading OFF in the bios before installing your
Windows system. If Windows is already installed with Hyperthreading active, you will need to boot the
system into single cpu mode by using the boot.ini file modification. Hyperthreading can and most
likely will cause low level driver interactions and glitches when trying to achieve low latency
performance.

Dual processors can add performance on heavily loaded sessions by splitting the display and meter
threads as well as splitting the low level driver threads across the two processors, you will just have to
experiment with your system. If you are having stability issues, try the single cpu boot method and
see if things stabilize.
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3.2.3 Wave Devices

The Audio Device Setup option from the Options menu first displays the wave output device
selections. Start with Wave Device Out 01 and select the audio device driver that matches the device
that you have installed. If you have more than one device installed, repeat this for each one. You may
assign devices in any order, and leave unassigned devices in any location. Click the Up/Down Arrow
zone to display the next 12 devices. You have three screens of 12 devices each. The devices are
listed as stereo devices representing a total of 36 stereo (72 mono) outputs. If using ASIO, you will
most likely only see the odd number channels listed, but each device actually represents the odd-
even pair of channels.

Next, click the Out/In device toggle zone to display the wave input device selections. Start with Wave
Device In 01 and select the audio device driver that matches the device that you have installed. If you
have more than one device installed, repeat this for each one. If your audio device has an unmatched
number of inputs and outputs, you should set the matching input and output pairs to the same device
number, leaving unmatched devices set to none. You may, however, assign devices in any order, and
leave unassigned devices in any location. Click the Up/Down Arrow zone to display the next 12
devices. You have three screens of 12 devices each. The devices are listed as stereo devices
representing a total of 36 stereo (72 mono) outputs. If using ASIO, you will most likely only see the
odd number channels listed, but each device actually represents the odd-even pair of channels.

F For example, if your audio device has four stereo analog outputs and one stereo digital output,
but only one stereo analog input and one stereo digital input (thereby creating an unmatched set
of inputs and outputs), set out device 1 to driver-out 1-2, out device 2 to driver-out 3-4, out
device 3 to driver-out 5-6, and out device 4 to driver-out 7-8, and out device 5 to driver-out
digital 1-2. Then set in device 1 to driver-in 1-2, and in device 5 to driver-in digital 1-2, leaving in
device 2, 3, and 4 set to none.

PreLoad Buffers

This setting controls how many buffers of data are preloaded to the audio device before output
streaming begins. This affects the response time of live controls such as mutes, solos, faders, etc. If
this setting is too low for your system, audio stuttering or glitching during playback may occur,
especially when minimizing or sizing windows, etc. on a complex session. This setting combines with
the Out Buffer Size setting to determine the final latency.

Use the PreLoad Buffers listbox to choose a setting between 1 and 6. Lower values will give you
faster response times.

Buffer Size

Use the Buffer Size listbox to choose from six different settings ranging from 32 to 1024 samples.

The combination of the Buffer Size and the PreLoad Buffer value control the latency of the real-time
engine. Lower latency values give live, instantaneous response and the feel of a real physical
console. You will need to acheive settings of 3 x 128 or lower for a realtime live audio console feel.

F Some combinations that result in the same low latency value will cause the system to glitch while
other combinations will perform comfortably. For instance, 4 buffers at 64 size might cause static
or glitching on certain audio devices, but the same latency value can be obtained by using 2
buffers at 128 size, and the audio device may play back perfectly.
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When you are finished with all adjustments, click OK, then save your default settings by clicking on
the File menu and selecting Preferences File | Save Default.

3.2.4 Setting Up Default File Paths

Having a thorough understanding of Windows file management is crucial to working with a program
such as SAC which creates and saves many related files for a single session. When working with
computers, understanding file management is one of the most important necessities. We suggest
either spending time with the Windows help files, or getting other file management instruction to aid in
getting familiar with how the Windows Explorer functions. Knowledge of the Windows Explorer will
greatly assist in the understanding of setting up default file paths in SAC.

Understanding Default File Paths

M From the Options menu, select File Path Setup to display the Default File Path Setup dialog
box. There are several path options available as follows:

· The Mix Session Path text box allows you to specify the default location you wish to
access when either opening or saving a Mix Session (mxs file). By default, this path is set
to the Mix folder inside the SAC program folder on the drive you installed the program.
This default is intended as a temporary path only. We recommend creating a Mix-Session
folder in a separate location from your SAC program folder, and on a drive containing
sufficient hard disk space. It is also recommended that for each new session project, you
first create a separate project folder and then place the mxs session files inside that.
Scenes and other operations will create other files and folders under the project folder.

· The Mix Template Path determines the default location for opening and saving a SAC mix
template.

· The Session Undo Path determines the default location for all session undo files. If left
blank, all undo files will be saved to the currently open Session file path location. You
may create a separate Undo folder to store all undos for all sessions, if desired. Another
option is to use a \ as the first character in the undo path and this will create a separate
folder under the project folder for each project, keeping all the undo files neatly tucked
away but within reach of each project folder. For example: entering \Undo will create an
Undo folder under each project folder.

Changing Default File Paths

8 [Left-click] inside the applicable text box, then click the Browse zone to display the Browse For
Folder dialog box. Navigate to the desired location, then click Ok to change the default path to
this new location. Click Ok on the Default File Path Setup window to accept your changes and
close the window.

F To permanently save any changes in the Default File Path Setup dialog, from the File menu,
choose Preferences File, and Save Default.  If you don't choose this step, once you close
SAC, your changes will be lost and your default paths will revert to their previous settings.

8 [Left-Clicking] inside of the text box whose path you wish to change, then [Left-Clicking] the
Current Path zone replaces the existing default path with the path of the currently opened
session.
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8 [Left-Clicking] the Reset zone can be used to revert back to the program default paths.

3.2.5 Creating Workspace Views

One of the biggest time-saving tips for working in SAC is in this section.

As you work with SAC and become more comfortable with the interface, you may wish to change the
view of the main screen by moving and sizing the different windows to more easily facilitate your
work. The Function-Keys are reserved as WorkSpace View Holders. You can arrange any
combination of windows however you like and save them to a Function-Key by pressing the Shift key
along with the desired function key. Pressing the applicable function key alone will instantly restore
the WorkSpace to the saved view making it extremely quick and easy to navigate to different views
within the same session. These function key sets can be saved in files for instant loading of different
WorkSpace sets.

SAC comes by default with a set of function key assignments already built-in. You should review
these defaults by pressing each Function-Key and get familiar with the different views. These can be
overwritten with new function key assignments at any time.

Assigning A Workspace View To A Function Key

7 After arranging the SAC display to your specifications, press [Shift-F1] (or whatever function
key you wish to assign the current view to. The F-Key Properties window will be displayed
allowing you to select certain properties that will affect the workspace recall. Activating the
Vertical Offset property will restore the current vertical offset position of the Zoom, Exploded,
or Full Mixer views. Activating the Start Channel property will force all unlocked mixer views to
restore to their current start channel position. Activating the Mixer property will force the
restore of the current mixer when the workspace is recalled. Activating the Hot Channel
property will force the Hot Channel to the current Hot Channel when the workspace is recalled.

Leaving these properties not active will maintain the current mixer and Hot Channel focus
when the workspace is recalled and the mixer views will redraw according to their navigation
link and lock status.

F For another layer of function key assignments, press [Alt-Shift-FunctionKey] for a total
of 24 workspace views on a 12 function key keyboard.

F When assigning a workspace view to a function key, the active window information is
also saved. Before saving your current view to a function key, be sure to click on the
window you wish to have as the active window when accessing that view.

78 To recall the view, press the assigned function key such as [F1], or press [Alt-FunctionKey] for
the second layer of alternate workspace views.

Saving Function Key Assignments

M After assigning desired workspaces to function keys, from the File menu select F-Key File |
Save. The Save F-Key File dialog box is displayed. Enter an F-key filename and click Save to
save the file with an .fky file extension.
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Saving Alternate Function Key Assignments

M After assigning desired workspaces to the alternate function keys, from the File menu select F-
Key File | Save Alternate. The Save F-Key File dialog box is displayed. Enter an F-key
filename and click Save to save the file with an .fky file extension.

Opening An Existing Function Key File

M From the File menu, select F-Key File | Open. Choose the desired .fky file and click Open.
This will load the complete set of workspace views from that template.

Opening An Existing Alternate Function Key File

M From the File menu, select F-Key File | Open Alternate. Choose the desired .fky file and click
Open. This will load the complete set of alternate workspace views from that template.

Saving The Current Function Key Setup As The Default

M From the File menu, select F-Key File | Save Default. A confirmation prompt is displayed. Click
OK to accept the changes, or click Cancel to close the dialog box and cancel the operation.

To Clear The Default Function Key File

M From the File menu, select F-Key File | Clear Default. A confirmation prompt is displayed. Click
OK to clear the file and revert back to the internal F-key defaults, or click Cancel to close the
dialog box and cancel the operation.

F Whenever the default F-key file is saved, the current workspace view becomes the default
startup view.

3.2.6 Using Undo

These features are not yet implemented!

SAC has some very powerful built-in undo features above and beyond the standard undo format.
Reading this section will give you some important insight into the ways you can recover your session -
from undoing a single manipulation, to actually recovering the state of an entire session from days or
months earlier!

Because SAC automatically maintains an undo history file, it is possible to recover an unsaved
session even after a system crash or a power failure. Take time now to understand the many undo
and recover options available. One of them may save the day for you when you most need it.

SAC's Undo system works by creating complete background .mxs files just before a function modifies
the session. SAC's assembly language code makes this possible while remaining virtually transparent
to the user.

Only in extreme cases of incredibly large and complex projects with many VST plug-ins that are slow
to initialize, etc. will there be a slight noticeable delay as you make changes to your session. In these
cases, you may turn off the auto-undo option under the Options menu to eliminate the background
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undo file creation each time you edit. If you disable this feature, it is suggested you use the SnapShot
function (* Key) to manually create undo files as you work.

Certain operations do not create auto undo files when their creation might interfere with normal
workflow. For instance, to create an undo history while moving a fader from zero db to minus infinity
would require the creation of 340 undo files, one for each 1/4 db step of the fade. Many mixing
controls do not create undo files. In these instances, you can always use the SnapShot function (*
Key) to manually create undo files prior to performing these operations. To become familiar with
which operations do and don't create undo files, you can open the Display Undo History view window
from the Edit menu and observe whether or not undo entries are added to the list when editing
functions are performed.

Undoing A Single Manipulation

M The Undo option under the Edit menu allows you to undo the last manipulation. SAC has the
ability to maintain up to 99 levels of multiple undos. Each time this option is used, SAC steps
backward one more level in the undo history. When the oldest undo level is recalled, this
option will be grayed and unavailable.

7 Pressing [Ctrl-<] performs the same function.

Redoing A Single Manipulation

M The Redo option under the Edit menu allows you to redo the last undo operation. SAC has the
ability to maintain up to 99 levels of multiple undos. Each time this option is used, SAC steps
forward one more level in the undo history. When the newest undo level is recalled, this option
will be grayed and unavailable.

7 Pressing [Ctrl->] performs the same function.

Recovering An Undo File

M The Recover Last Undo option under the Edit menu opens a file dialog displaying the U00
undo data information files for your different sessions. Pick the session of interest and the last
stored undo file will attempt to be opened. In most cases this will recover you from unsaved or
crashed data circumstances to the last, or close to the last, editing operation performed when
the session was last open.

F If your session crashed or was closed without saving, exercise this option to open the
session for the best chance of recovering potentially lost data. If this option fails to
recover your session, try the Display Undo History option to access all of the undo
history files available for this session.

Recovering An Undo

M The Recover Undo option under the Edit menu allows you to see all undo files (.u01 - .u99) for
each session in a folder. You may select any one of them to attempt to recover a session that
was somehow lost or corrupted.

Displaying Current Session Undo History

M The Display Undo History option under the Edit menu displays an Undo History listbox, with
undo history listed from the most recent change to the oldest change, going back as many
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levels as you have setup in the Set Undo Levels configuration. Each entry will have a date and
time stamp and a text message describing the event. [Double-Clicking] any of the items will
safely open that undo file allowing you to freely look around the entire history. This does not
damage the list or main file in any way. The top of the list is the most recent operation saved.
Sometimes one more level of redo is available to reach the final status of the session.

F Undo history is saved as separate MXS files, and can be accessed at anytime - even
weeks or months after the session was last open.

Clearing An Undo History File

M The Clear Undo History option under the Edit menu clears the undo files and the history of the
open session or a session of your choice if there is no active session open.

If the current session has not been named, selecting this option opens the File dialog box,
displaying all .u00 files for all sessions. Select the session history file you wish to clear, and
click OK.  All associated .uxx history files for that session will be deleted.

If the current session is named, a confirmation prompt is displayed. Click OK to delete the
history files for the current session, or Cancel to cancel the operation.

Setting Undo Levels

M The Set Undo Levels option from the Edit menu allows you to select the number of undo levels
that will be saved during session manipulations.
When selecting this option, a dialog box is displayed allowing you to enter a number from 1 to
99.
This setting can be saved with your preferences.

I Regarding setting undo levels: It is recommended that undo levels be set to a
reasonable number like 10 or 20 to avoid creating large numbers of history files for
each of your sessions and using up valuable hard drive space unnecessarily. In most
cases, the session condition has changed significantly after 10-20 manipulations, most
likely making it meaningless to recover an undo beyond that level.

Special Snapshot Function

7 Pressing the [*] key on the keyboard numpad will force a snapshot (undo) of your current
session. This can later be recovered as an undo item. Use this before performing automation
or recording so you can revert back to before the numerous changes were made if you change
your mind.

F This feature overrides the Auto Undo option. This allows you to turn off Auto Undo
under the Options menu for quicker editing when sessions are loaded down with plug-
ins, and still create an instant undo backup file anytime you wish.
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4 Navigation

4.1 Main Window

The Main Window encases the entire SAC interface and should be stretched to fit across your
available monitor space. You can size the window to any size, and save F-Key workspaces that do
not fill the entire screen, but it is highly recommended that you also enclose all SAC windows within
that Main Window space.

Menu Bar

The top of the window displays the Main Menu Bar which contains options for many commands and
functions within the SAC environment. See the Menu Reference Guide section for details on all menu
options.

Title Bar

Underneath the Menu Bar is the TitleBar which you can use to grab and position the window within
the available screen space. The TitleBar also displays certain network icons as well as the current
Mix Session file name.

Live Light

This light displays the current state of the mix engine. When this light is off or flashing, the engine is
not active and no audio will pass through the consoles. When you first load a new Mix Session or Mix
Template, the light will flash when the consoles are routed and all control settings are ready to go.

8 [Right-Clicking] on the Live Light will activate the mix engine and start streaming audio. [Right-
Clicking] it again will stop the engine and shutdown all audio streaming.

8 [Left-Clicking] on the Live Light when it is flashing in Rdy Mode, will cancel the Rdy Mode and
turn off the light.

8 [Shift-Left-Clicking] on the Live Light while the engine is active will re-sync all engine buffer
pointers by stopping and immediately re-starting the engine. If the engine slips buffers and
starts loosing sync, adding latency, use this function.

Load Display

The Load display shows the current engine load percentage. This value will be different than the Task
Manager CPU percentage, as it reflects only the load of the mix processing engine. This value is
calculated as a percentage of time it takes to complete a cycle through the mix engine and process all
25 consoles to get the next buffer of data ready in time for the soundcard to stream it to the hardware.
Depending on SampleRate and buffer size, there is a fixed amount of time between buffers going out
to the hardware. This value represents how close to that allotted time it takes the engine to get the
next set of buffers ready. As the value climbs up towards the 100% mark, the engine is working extra
hard to process the amount of data required by your setup. If you are using a single processor
system, the graphic and meter display redraws will begin to slow down when the load climbs above
50% because the display code will take a backseat to the mix processing code. If you are using 2 or
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more processors, the load can climb very close to 100% without affecting the screen displays
because the engine is split between processors.\

8 [Left-Clicking] on the Load Display will popup a small message window which displays the
current count of input and output slipped buffers since the engine has been started. This slippage will
have been automatically re-synced so there is no overall latency drift. If your system is running
completely stable under load, these values should remain zero.

Solo Light

This light will flash as an indicator when one or more active Solo switches are pressed somewhere on
one of the consoles.

8 [Left-Clicking] the light (when active) automatically clears all active Solo switches.

8 [Left-Clicking] the light when no solo switches are active turns the light green and engages a
special Output Master Chan Solo Mode. The first Master Out Chan will be soloed so you can
hear the main mix for the current mixer. Engaging any other Master Out Chan solo will add that
to the Master Out Solo Template for that mixer and will automatically recall each time you
engage the special solo mode. While monitoring in this mode, engaging any input chan, return
chan, or non-master out chan will override the master out solo and act as a normal solo per
chan. When disengaging the last of these solo switches, the original special Master Out solo
mode will be automatically reset. If you change mixers while in this special solo mode, the
Master Out Chan Solo mode will chase to the new mixer allowing you to monitor its Master Out
Solo Template. [Left-Clicking] the solo light again will disengage this special solo mode.

8 [Alt-Left-Clicking] on the Solo Light when no solo switches are active turns on Hot Channel
Solo Mode. The light turns solid red and the current Hot Channel is soloed. Changing to
another Hot Channel automatically causes the solo to follow, always keeping the Hot Channel
soloed. The solo buttons are locked out when this mode is active. You may change Hot
Channels from the Full, Zoom or Wide Mixer Views.

8 [Alt-Shift-Left-Clicking] on the Solo Light when no solo switches are active turns on Hot
Channel Solo Mode, keeping the Return channels active so you can hear the Return effects.
Each time you switch to a new Hot Channel it will react to the [Shift] key, so you can switch the
Returns on and off at will as you jump around by pressing the [Shift] key or not.The light turns
solid red and the current Hot Channel is soloed. Changing to another Hot Channel
automatically causes the solo to follow, always keeping the Hot Channel soloed. The solo
buttons are locked out when this mode is active. You may change Hot Channels from the Full,
Zoom or Wide Mixer Views. This mode only works when the Solo Mode is the Solo In Place
option.

8  [Left-Clicking] on the Solo Light again, turns this mode off.

8  [Right-Clicking] on the Solo Light will display a popup menu of level settings for the master
solo bus mode level.

I, R, O Jump Zones

8 [Left-Clicking] on any of the three jump zones labeled I, R, and O will jump you to the first
Input, Return, or Output channel respectively, and will force the applicable section to the left
edge of any open mixer views.

8 [Shift-Left-Clicking] in one of these zones will jump to the next channel in sequence of that
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section and keep incrementing until the end of the section is reached, at which time the jump
will start at the beginning of the section again. These jumps will follow the physical sequential
order regardless of how the channels are re-arranged.

8 [Alt-Left-Clicking] in one of these zones jumps you back to the last selected Hot Channel for
that section. This allows you to jump to the output section, for example, and then immediately
jump back to the last selected Hot Channel you were working on in the input or return section.

8 [Right-Clicking] in one of these zones jumps you back to the last selected Hot Channel for that
section (emulating the Alt-Left-Click function). This allows you to jump to the output section, for
example, and then immediately jump back to the last selected Hot Channel you were working
on in the input or return section. Repeated [Right-Clicking] in the same zone will jump to the
next channel in sequence of that section and keep incrementing until the end of the section is
reached, at which time the jump will start at the beginning of the section again. These jumps
will follow the physical sequential order regardless of how the channels are re-arranged
(emulating the Shift-Left-Click function).

Sync Light

This light flashes yellow whenever a trigger mode is activated and waiting for sync. When the trigger
point is reached, the Sync Light turns green. The Sync Light will also turn green during any operation
that is generating sync.

Current Mixer Zone

This zone displays the current mixer you are working on. It is either the Front Of House (FOH) mixer
or one of the 24 Monitor mixers.

8 [Left-Clicking] in this zone displays a popup menu of mixer choices allowing you to instantly
switch to a different mixer.

F The Monitor mixer choices will display the name entered on the first Master Output channel of
the Monitor mixer.

8 [Right-Clicking] in the Current Mixer zone will display a popup menu of options for duplicating
sections of mixers to other mixers. The options are:

Ø Duplicate Fdrs/Pans From
This option displays another popup menu of choices for which mixer to duplicate from. To use
the features, change to the mixer you wish to create a new mix on, and then select the source
mixer to duplicate from.

Ø Duplicate Src-Ins From
This option displays another popup menu of choices for which mixer to duplicate from. To use
the features, change to the mixer you wish to create a new mix on, and then select the source
mixer to duplicate from.

Ø Duplicate Eq From
This option displays another popup menu of choices for which mixer to duplicate from. To use
the features, change to the mixer you wish to create a new mix on, and then select the source
mixer to duplicate from.

Ø Duplicate Dynamics From
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This option displays another popup menu of choices for which mixer to duplicate from. To use
the features, change to the mixer you wish to create a new mix on, and then select the source
mixer to duplicate from.

F These features make it easy to quickly setup a new Monitor mix by duplicating the faders and
pans from the FOH or from any other Monitor mix, as well as duplicating input source settings
and eq and dynamics. All of these options will respond to Selected Channels and only modify
those channels.

Ø Duplicate Chan Order From
This option displays another popup menu of choices for which mixer to duplicate from. To use
the features, change to the mixer you wish to create the new chan order on, and then select
the source mixer to duplicate from.

4.2 Operating Console Controls

There are three basic console control types for adjusting mixer settings.

Knobs And Faders

8 [Left-Dragging] a knob or fader control allows direct adjustment of their levels. [Left-Right-
Clicking] or [Ctrl-Left-Clicking] while grabbing a knob or fader control, will reset the control to
its default setting. Beside many of these controls are two small arrows. [Left-Clicking] on or
near one of those arrows will adjust the control one value at a time in the direction of the
arrow. A special version of this control type is also seen in the Eq graphic display bar near the
bottom of the Eq section. This display, as well as graphically displaying the Eq level settings,
can be grabbed as individual adjustment controls.

78 [Left-Clicking] in the up/down arrow zone in the channel main faders increments and
decrements the fader value by ¼ dB. [Ctrl-Left-Clicking] in the up/down arrow zone increments
and decrements the fader value by 1 dB.

8 [Left-Clicking] a meter display in any mixer view displays a Meter Options Menu. The Clear
Current Meter Peaks option will clear the current meter's peak limit displays. The Clear All
Meter Peaks will clear all meter's peak limit displays.

7 Pressing [Up-Arrow] or [Down-Arrow] in any mixer view will adjust the Hot Channel fader up or
down in .5db steps.Pressing [Shift-Up-Arrow] or [Shift-Down-Arrow] will adjust the Hot Channel
fader in 1db steps and pressing [Ctrl-Up-Arrow] or [Ctrl-Down-Arrow] will adjust the Hot
Channel fader in .25db steps.

Switches
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8 There are numerous on/off switches in the SAC environment such as Mute and Solo switches.
[Left-Clicking] these controls will toggle their state between On and Off.

Display/Control Combo Boxes

8 This type of control offers the most amount of power in the least amount of space, replacing
rotary knob controls and separate display value windows. All of these controls have direction
arrows in the right or left side of the display window. [Left-Clicking] on one of those arrows
adjusts the control one value at a time in the direction of the arrow.

[Left-Holding] changes the mouse cursor to a Plus/Minus icon. Pushing the mouse up or down
will latch an automatic adjustment mode. This mode will increment or decrement values at a
speed dependent on how far you push the mouse off the center point which engaged the
action. You do not have to keep the mouse moving, just positioned above or below the point
which engaged the action. If the Right mouse button is tapped while in this mode, the control
will be reset to its default setting.

Some of these controls have been enhanced for quicker control operation, displaying a popup
variable-sized fader for instant and direct adjustment with a fader knob. The fader will adjust
its length to fit the exact number of parameter values available for the control. When you
release the mouse, the fader will disappear. The fader will popup to the right of the control
zone to allow the readout to be used as a visible reference while you adjust the value. The
mouse will automatically jump to the current fader position and return back to its original
position when the fader disappears.

Some of these control types will contain a small triangular mark in the upper left corner of the
display window. [Left-Clicking] the left side of one of these controls will popup a menu listing of
all possible values for this control. [Left-Clicking] a selection will instantly set the control to this
value. The default value is displayed in bold and the current value is displayed with a
checkmark.

F When a triangular mark appears next to a control label or in a control section, [Left-
Clicking] on that label or section will display other information. For example, you will
find a triangular mark next to the labels Pre Fader and Pst Fader on the mixer views.
[Left-Clicking] these labels will display the applicable FX patch windows.

4.3 Full View Mixer Window

The Full View Mixer window displays the mixing console in a reduced view for a larger overview of
individual channels within the available screen resolution. The faders, and mute and solo buttons are
directly reachable. The colored link buttons can be used as shortcut jumps into an exploded view of
any specific section of the console. The Titlebar will display the current mixer (FOH or Monitor Mixer)
being viewed. Monitor mixers will display a deep red titlebar color.

8 [Right-Clicking] in this view will popup a menu listing of every channel on the console, with
named labels, allowing you to instantly jump to any particular channel by [Left-Clicking] on
your selection. The selected channel will become the first displayed channel in the view,
unless there are not enough channels left to fill the window size, in which case the display will
adjust to fit to the end. You may also switch to any Monitor Console from this menu.
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Knobs And Switches

8 [Left-Clicking] on a fader, mute or solo switch will activate that control.

Hot Channel

8 [Left-Clicking] on any other part of the console display will change that channel to be the Hot
Channel. The Hot Channel displays with a red highlight around it. This also links (optional) the
Zoom and Wide Mixer View and the Patch Effects Views changing those views to reflect this
new Hot Channel.

Link Buttons

8 [Double-Clicking] on a colored link button or a non-control area of a channel displays an
exploded view of the entire channel starting at the specific section of the channel you clicked
on. For example, double clicking on the red Eq button links to an exploded view of the
channel, positioned at the Eq section. [Right-Clicking] inside or [Left-Clicking] outside the
Exploded View closes that view.

78 [Left-Clicking] on a colored link button of a channel will vertical scroll displayed Z-Mixer
sections. The dead zones at the top of the Full Mixer faders are also active zones for jumping
to the fader sections.

F These colored links are also used to display I/A, Eq, Dyn and Fx status information. The I/A
link display live input assignment information. L-Only sources display as a bar on the left side
of the zone. R-Only sources display as a bar on the right side of the zone. Stereo and other
combined mono sources display as a bar in the center of the zone. The Eq link displays Eq
switch information in the center of the zone. The Dyn link displays Gate switch information to
the left side of the zone and Compressor switch information to the right side of the zone. The
Fx link displays Pre Patch information to the left side of the zone, Post Patch information to the
right side of the zone.

Link Keys

7 Keyboard shortcuts can also be used to vertical scroll displayed Z-Mixer and E-Mixer sections.
Pressing the [I] key will scroll to the Input/Attenuator section; Pressing the [E] key will scroll to
the Eq section; Pressing the [D] key will scroll to the Dynamics section; Pressing the [A] key
will scroll to the Aux section; Pressing the [O] key will scroll to the Output Assign section;
Pressing the [L] key will scroll to the Label section; Pressing the [F] key will scroll to the Fader
section.

7 Keyboard shortcuts can also be used to switch to different mixers by using two number keys
(not on the NumPad) in sequence. The mixers are numbered from 00 (FOH) to 24. After
pressing the first number key, a mixer list will be displayed with mixer labels. The list will be hi-
lited to display the range of active remaining selections. Press the second number key to
select the desired mixer. For instance, if you first press 1, then the list will display the mixers
with 10 to 19 hi-lited and expect the second number for the desired mixer. You can also press
the M-key (Mixer) to pop the list up as a reference, and then enter the two number keys.
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Label Display Zone

8 [Shift-Left-Clicking] in the Label Display zone displays a channel label dialog box, allowing a
name for the channel to be entered. You must press the [Enter] key for the name to be
accepted.

78 [Ctrl-Left-Clicking] in the Label Display zone allows you to enter labels for sequential
channels. Pressing the [Enter] key after a label name has been entered will automatically
prompt for a label name for the next channel. To close or cancel the label dialog box, [Left-
Click] either the close button or outside of the box, or press the [Esc] key.

F Names entered on the FOH Mixer or Master Monitor Mixer 1 Input channels will automatically
pass through to all channels on the following Monitor mixers. Names entered on any Monitor
Mixer 2 or higher are only entered on that mixer. Pressing the [Alt] key along with one of the
[Shift] or [Ctrl] options to create a label, will block the automatic pass thru, allowing you to
label changes on the current mixer without affecting other mixers.

Set Channel Label Color

78 [Alt-Right-Clicking] in any mixer view displays the Store/Recall menu. Selecting the Set
Channel Label Color option allows you to select one of the 16 label outline colors for this
channel or no label color. If this channel is one of a group of selected channels, then all
selected channels will be affected. The default behavior sets this chan color for all mixers. If
you press the [Alt-Key] when activating the menu choice, only the current mixer will be
affected. This data saves with mix sessions, mix templates and with scenes. On scene recalls
with active label properties, the chan label color will change with the label text. You might set a
group of  vocals to one color and horns to another… etc. Or you may find it useful to just set
the first vocal chan to a color and then the first horn chan to a different color to visually mark
and separate the groups without flooding the label area with colors.

Scrolling

8 [Left-Dragging] the mouse cursor to the left or right edge of this window, or inside of the mixer
label area, initiates an automatic scroll in that direction. [Left-Clicking] near the left or right
edge of this window initiates a single scroll action.

8 [Right-Holding] will change the mouse cursor to a vertical directional arrow icon and latch a
vertical scroll mode (if the window is sized smaller than the full height of the graphic). This
mode will scroll the window at a speed dependent on how far you push the mouse off the
center point which engaged the scroll action. You do not have to keep the mouse moving, just
positioned above or below the point which engaged the action.

7 The [Left-Arrow] key scrolls the view to the left one channel at a time. Pressing [Shift-Left-
Arrow] scrolls the view to the left one page (complete view width) at a time. Pressing [Ctrl-Left-
Arrow] scrolls the view to the previous section from Outputs to Returns to Inputs. The [Right-
Arrow] key scrolls the view incrementing one channel at a time. Pressing [Shift-Right-Arrow]
scrolls the view incrementing one page (complete view width) at a time. Pressing [Ctrl-Right-
Arrow] scrolls the view to the next section from Inputs to Returns to Outputs. The mousewheel
may also be used to increment and decrement channels.

The [Home] key scrolls the view to the first channel. The [End] key scrolls the view to the first
output channel.
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The [Tab] key scrolls the mixer view to the next section from Inputs to Returns To Outputs,
then back to Inputs. The [Shift-Tab] works in reverse.

Channel Selecting

8 [Left-Clicking] or [Left-Dragging] in the channel label area just beneath the title bar toggles
channel selection on and off.

78 [Alt-Left-Clicking] in the channel label area just beneath the title bar toggles channel selection
from the last toggled channel to the current channel on and off. The selected channels are
indicated by an inverse coloring of this label area. Selected channels are grouped and any
selected channel can become the group master. Adjusting any control on the group master will
also adjust the same control on all other selected channels. Any control that reaches its max
or min levels will maintain its over-range internal value and keep its relative position within the
group as the levels are brought back into range.

8 [Right-Clicking] in the channel label area just beneath the title bar toggles all selected
channels off.

F Whenever channels are selected, the mixer mouse pointer will change to indicate that
channels are selected. Selected channels respond as a group to mixer adjustments and this
mouse pointer serves as a reminder that channels that may not be in view are currently
selected, so you may clear those selections if desired before adjusting controls.

Channel Re-Ordering

8 [Shift-Left-Dragging] on a channel number area just beneath the title bar allows a channel to
be dragged to a new location out of order from the normal sequential count.

78 [Ctrl-Left-Clicking] on any channel number area just beneath the title bar automatically
arranges all channels in numerical order. You will be prompted to OK this action.

78 [Shift-Left-Clicking] a channel number when one or more channels have been selected
(channel number inversed) will move all selected channels to this new destination and group
them together. For example, to move channels 8, 10, and 12 up to channel position 2, select
channels 8, 10, and 12 by [Left-Clicking] in the channel numbers (inversing them), then [Shift-
Left-Click] channel 2 as the destination. The new channel order will then be set as 1, 8, 10, 12,
2, 3, 4, etc.

Using Channel Group Menu Options

Groups

8 [Right-Clicking] on the Full Mixer View title bar displays the popup Group menu. This menu
allows you to save and recall preset channel groups. There are 32 Group preset assignments
and a few special groups for mixer section selections (ie inputs, returns, and outputs).

78 [Shift-Left-Clicking] one of the 32 Group preset options creates a new group and assigns the
currently selected channels to that group and prompts for a group name.

8 [Left-Clicking] on one of the 32 Group preset options clears any existing selected mixer
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channels and selects that group of mixer channels.

8 [Left-Clicking] on the Select All option selects all input, return, and output mixer channels.
[Left-Clicking] on the Select All Inputs, Select All Returns, or Select All Outputs option selects
the corresponding mixer channels.

78 [Ctrl-Left-Clicking] one of the 32 Group preset options will blend the preset with any currently
selected mixer channels.

When a group of channels are selected, any control adjustment on one of those selected
channels activates the adjustment on all of the group channels  simultaneously. You may
override the group at anytime by using the [Alt] key as you adjust individual channel controls.

When you are finished with the group operation, simply [Right-Click] in the channel label area
just beneath the title bar to clear the group.
The group assignments will save with the session and mix templates.

Latches

These work similar to Group presets but add the power of automatic latching anytime one of
the preset latched channels is adjusted. These latched groups do not require pre-selection
before adjusting controls, the latch between channels is automatic when any one of the latch
preset channels is adjusted. These latch presets can be very handy for creating stereo-latched
L and R channels which will then always adjust the pair simultaneously. You may override the
latch at anytime by using the [Alt] key as you adjust channel controls. These latch presets save
with Mix Template and Mix Session Files.

8 [Right-Clicking] on the Full Mixer View title bar displays the popup Group menu. This menu
also allows you to save and recall preset Latch groups. There are 32 latch preset
assignments.

78 [Shift-Left-Clicking] one of the 32 Latch preset options creates a new latch group and assigns
the currently selected channels to that latch group and prompts for a latch group name.

8 [Left-Clicking] on one of the 32 Latch preset options clears any existing selected mixer
channels and selects that group of mixer channels. Note that this is not needed to utilize the
group itself... simply adjust anyone of the latched channels and the entire group will be
affected.

View Switching

78 [Shift-Right-Clicking] on any area of the console displays the Wide Mixer View on the current
channel.

View Locking

8 [Right-Clicking] on the Close button of the Full Mixer view locks or unlocks the view. Moving
around in any of the other views will not cause the current locked view to chase along. You
may still change chans in the locked view itself, but it will no longer be linked to affect other
views. The Close button will change to display a small padlock when the view is locked.
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4.4 Zoom View Mixer Window

The Zoom View Mixer window displays the mixing console in a zoomed view showing all individual
controls for each channel. The knobs and switches are directly reachable. This view can be expanded
to display more than one channel at a time. The Titlebar will display the current mixer (FOH or
Monitor Mixer) being viewed.  Monitor mixers will display a deep red titlebar color.

8 [Right-Clicking] in this view will popup a menu listing of every channel on the console, with
named labels, allowing you to instantly jump to any particular channel by [Left-Clicking] on
your selection. The selected channel will become the first displayed channel in the view,
unless there are not enough channels left to fill the window size, in which case the display will
adjust to fit to the end. You may also switch to any Monitor Console from this menu.

Knobs And Switches

8 [Left-Clicking] on any control will allow direct adjustment of its setting.

Hot Channel

8 [Left-Clicking] on any non-control part of the console display will change that channel to be the
Hot Channel. The Hot Channel displays with a red highlight around it. This also links (optional)
the Full and Wide Mixer View and the Patch Effects Views changing those views to reflect this
new Hot Channel.

Link Keys

7 Keyboard shortcuts can also be used to vertical scroll displayed Z-Mixer and E-Mixer sections.
Pressing the [I] key will scroll to the Input/Attenuator section; Pressing the [E] key will scroll to
the Eq section; Pressing the [D] key will scroll to the Dynamics section; Pressing the [X] key
will scroll to the Fx section; Pressing the [A] key will scroll to the Aux section; Pressing the [O]
key will scroll to the Output Assign section; Pressing the [L] key will scroll to the Label section;
Pressing the [F] key will scroll to the Fader section.

7 Keyboard shortcuts can also be used to switch to different mixers by using two number keys
(not on the NumPad) in sequence. The mixers are numbered from 00 (FOH) to 24. After
pressing the first number key, a mixer list will be displayed with mixer labels. The list will be hi-
lited to display the range of active remaining selections. Press the second number key to
select the desired mixer. For instance, if you first press 1, then the list will display the mixers
with 10 to 19 hi-lited and expect the second number for the desired mixer. You can also press
the M-key (Mixer) to pop the list up as a reference, and then enter the two number keys.

Label Display Zone

8 [Shift-Left-Clicking] in the Label Display zone displays a channel label dialog box, allowing a
name for the channel to be entered. You must press the [Enter] key for the name to be
accepted.

78 [Ctrl-Left-Clicking] in the Label Display zone allows you to enter labels for sequential
channels. Pressing the [Enter] key after a label name has been entered will automatically
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prompt for a label name for the next channel. To close or cancel the label dialog box, [Left-
Click] either the close button or outside of the box, or press the [Esc] key.

F Names entered on the FOH Mixer or Master Monitor Mixer 1 Input channels will automatically
pass through to all channels on the following Monitor mixers. Names entered on any Monitor
Mixer 2 or higher are only entered on that mixer. Pressing the [Alt] key along with one of the
[Shift] or [Ctrl] options to create a label, will block the automatic pass thru, allowing you to
label changes on the current mixer without affecting other mixers.

Set Channel Label Color

78 [Alt-Right-Clicking] in any mixer view displays the Store/Recall menu. Selecting the Set
Channel Label Color option allows you to select one of the 16 label outline colors for this
channel or no label color. If this channel is one of a group of selected channels, then all
selected channels will be affected. The default behavior sets this chan color for all mixers. If
you press the [Alt-Key] when activating the menu choice, only the current mixer will be
affected. This data saves with mix sessions, mix templates and with scenes. On scene recalls
with active label properties, the chan label color will change with the label text. You might set a
group of  vocals to one color and horns to another… etc. Or you may find it useful to just set
the first vocal chan to a color and then the first horn chan to a different color to visually mark
and separate the groups without flooding the label area with colors.

Scrolling

8 [Left-Dragging] the mouse cursor to the left or right edge of this window, or inside of the mixer
label area, initiates an automatic scroll in that direction. [Left-Clicking] near the left or right
edge of this window initiates a single scroll action.

[Right-Holding] will change the mouse cursor to a vertical directional arrow icon and latch a
vertical scroll mode. This mode will scroll the window at a speed dependent on how far you
push the mouse off the center point which engaged the scroll action. You do not have to keep
the mouse moving, just positioned above or below the point which engaged the action.

7 The [Left-Arrow] key scrolls the view to the left one channel at a time. Pressing [Shift-Left-
Arrow] scrolls the view to the left one page (complete view width) at a time. Pressing [Ctrl-Left-
Arrow] scrolls the view to the previous section from Outputs to Returns to Inputs. The [Right-
Arrow] key scrolls the view incrementing one channel at a time. Pressing [Shift-Right-Arrow]
scrolls the view incrementing one page (complete view width) at a time. Pressing [Ctrl-Right-
Arrow] scrolls the view to the next section from Inputs to Returns to Outputs. The mousewheel
may also be used to increment and decrement channels.

The [Page-Up] key scrolls the view up to the next console section (Faders, Labels, Out
Assigns, Aux Sends, FX Patch, Dynamics, Eq, Input/Attenuator). The [Page-Down] key scrolls
the view down to the next console section (Faders, Labels, Out Assigns, Aux Sends, FX
Patch, Dynamics, Eq, Input/Attenuator).

[Ctrl-PgUp] snaps you to the top of the module. [Ctrl-PgDn] snaps you to the bottom of the
module.

The [Home] key scrolls the view to the first channel. The [End] key scrolls the view to the first
output channel.

The [Tab] key scrolls the mixer view to the next section from Inputs to Returns To Outputs,
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then back to Inputs. The [Shift-Tab] works in reverse.

Channel Selecting

8 [Left-Clicking] or [Left-Dragging] in the channel label area just beneath the title bar toggles
channel selection on and off.

78 [Alt-Left-Clicking] in the channel label area just beneath the title bar toggles channel selection
from the last toggled channel to the current channel on and off. The selected channels are
indicated by an inverse coloring of this label area. Selected channels are grouped and any
selected channel can become the group master. Adjusting any control on the group master will
also adjust the same control on all other selected channels. Any control that reaches its max
or min levels will maintain its over-range internal value and keep its relative position within the
group as the levels are brought back into range.

8 [Right-Clicking] in the channel label area just beneath the title bar toggles all selected
channels off.

F Whenever channels are selected, the mixer mouse pointer will change to indicate that
channels are selected. Selected channels respond as a group to mixer adjustments and this
mouse pointer serves as a reminder that channels that may not be in view are currently
selected, so you may clear those selections if desired before adjusting controls.

Channel Re-Ordering

8 [Shift-Left-Dragging] on a channel number area just beneath the title bar allows a channel to
be dragged to a new location out of order from the normal sequential count.

78 [Ctrl-Left-Clicking] on any channel number area just beneath the title bar automatically
arranges all channels in numerical order. You will be prompted to OK this action.

78 [Shift-Left-Clicking] a channel number when one or more channels have been selected
(channel number inversed) will move all selected channels to this new destination and group
them together. For example, to move channels 8, 10, and 12 up to channel position 2, select
channels 8, 10, and 12 by [Left-Clicking] in the channel numbers (inversing them), then [Shift-
Left-Click] channel 2 as the destination. The new channel order will then be set as 1, 8, 10, 12,
2, 3, 4, etc.

Using Channel Group Menu Options

Groups

8 [Right-Clicking] on the Full Mixer View title bar displays the popup Group menu. This menu
allows you to save and recall preset channel groups. There are 32 Group preset assignments
and a few special groups for mixer section selections (ie inputs, returns, and outputs).

78 [Shift-Left-Clicking] one of the 32 Group preset options creates a new group and assigns the
currently selected channels to that group and prompts for a group name.

8 [Left-Clicking] on one of the 32 Group preset options clears any existing selected mixer
channels and selects that group of mixer channels.
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8 [Left-Clicking] on the Select All option selects all input, return, and output mixer channels.
[Left-Clicking] on the Select All Inputs, Select All Returns, or Select All Outputs option selects
the corresponding mixer channels.

78 [Ctrl-Left-Clicking] one of the 32 Group preset options will blend the preset with any currently
selected mixer channels.

When a group of channels are selected, any control adjustment on one of those selected
channels activates the adjustment on all of the group channels  simultaneously. You may
override the group at anytime by using the [Alt] key as you adjust individual channel controls.

When you are finished with the group operation, simply [Right-Click] in the channel label area
just beneath the title bar to clear the group.
The group assignments will save with the session and mix templates.

Latches

These work similar to Group presets but add the power of automatic latching anytime one of
the preset latched channels is adjusted. These latched groups do not require pre-selection
before adjusting controls, the latch between channels is automatic when any one of the latch
preset channels is adjusted. These latch presets can be very handy for creating stereo-latched
L and R channels which will then always adjust the pair simultaneously. You may override the
latch at anytime by using the [Alt] key as you adjust channel controls. These latch presets save
with Mix Template and Mix Session Files.

8 [Right-Clicking] on the Full Mixer View title bar displays the popup Group menu. This menu
also allows you to save and recall preset Latch groups. There are 32 latch preset
assignments.

78 [Shift-Left-Clicking] one of the 32 Latch preset options creates a new latch group and assigns
the currently selected channels to that latch group and prompts for a latch group name.

8 [Left-Clicking] on one of the 32 Latch preset options clears any existing selected mixer
channels and selects that group of mixer channels. Note that this is not needed to utilize the
group itself... simply adjust anyone of the latched channels and the entire group will be
affected.

View Switching

78 [Shift-Right-Clicking] on any area of the console displays the Wide Mixer View on the current
channel.

View Locking

8 [Right-Clicking] on the Close button of the Zoom Mixer view, locks or unlocks that view.
Moving around in any of the other views will not cause the current locked view to chase along.
You may still change chans in the locked view itself, but it will no longer be linked to affect
other views. The Close button will change to display a small padlock when the view is locked.



SAC User Manual40

© 2008 - 2010 Robert Lentini and RML Labs

4.5 Exploded View Mixer Window

The Exploded View Mixer window displays a single channel of the mixing console in a zoomed view
showing all individual controls for that channel. The knobs and switches are directly reachable.
Monitor mixers will display a deep red titlebar color.

8 This view can be opened by [Double-Clicking] on a color link button or non-control area of the
Full View window. The window may be closed by [Left-Clicking] outside of its boundaries, or
[Right-Clicking] within its boundaries, or clicking the close button in the upper right corner of
the mixer window.

Knobs And Switches

8 [Left-Clicking] on any control will allow direct adjustment of its setting.

Link Keys

7 Keyboard shortcuts can also be used to vertical scroll displayed Z-Mixer and E-Mixer sections.
Pressing the [I] key will scroll to the Input/Attenuator section; Pressing the [E] key will scroll to
the Eq section; Pressing the [D] key will scroll to the Dynamics section; Pressing the [A] key
will scroll to the Aux section; Pressing the [O] key will scroll to the Output Assign section;
Pressing the [L] key will scroll to the Label section; Pressing the [F] key will scroll to the Fader
section.

7 Keyboard shortcuts can also be used to switch to different mixers by using two number keys
(not on the NumPad) in sequence. The mixers are numbered from 00 (FOH) to 24. After
pressing the first number key, a mixer list will be displayed with mixer labels. The list will be hi-
lited to display the range of active remaining selections. Press the second number key to
select the desired mixer. For instance, if you first press 1, then the list will display the mixers
with 10 to 19 hi-lited and expect the second number for the desired mixer. You can also press
the M-key (Mixer) to pop the list up as a reference, and then enter the two number keys.

Label Display Zone

8 [Shift-Left-Clicking] in the Label Display zone displays a channel label dialog box, allowing a
name for the channel to be entered. You must press the [Enter] key for the name to be
accepted.

F Names entered on the FOH Mixer or Master Monitor Mixer 1 Input channels will automatically
pass through to all channels on the following Monitor mixers. Names entered on any Monitor
Mixer 2 or higher are only entered on that mixer. Pressing the [Alt] key along with one of the
[Shift] or [Ctrl] options to create a label, will block the automatic pass thru, allowing you to
label changes on the current mixer without affecting other mixers.

Set Channel Label Color

78 [Alt-Right-Clicking] in any mixer view displays the Store/Recall menu. Selecting the Set
Channel Label Color option allows you to select one of the 16 label outline colors for this
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channel or no label color. If this channel is one of a group of selected channels, then all
selected channels will be affected. The default behavior sets this chan color for all mixers. If
you press the [Alt-Key] when activating the menu choice, only the current mixer will be
affected. This data saves with mix sessions, mix templates and with scenes. On scene recalls
with active label properties, the chan label color will change with the label text. You might set a
group of  vocals to one color and horns to another… etc. Or you may find it useful to just set
the first vocal chan to a color and then the first horn chan to a different color to visually mark
and separate the groups without flooding the label area with colors.

Scrolling

8 [Right-Holding] will change the mouse cursor to a vertical directional arrow icon and latch a
vertical scroll mode. This mode will scroll the window at a speed dependent on how far you
push the mouse off the center point which engaged the scroll action. You do not have to keep
the mouse moving, just positioned above or below the point which engaged the action.

The [Page-Up] key scrolls the view up to the next console section (Faders, Labels, Out
Assigns, Aux Sends, FX Patch, Dynamics, Eq, Input/Attenuator). The [Page-Down] key scrolls
the view down to the next console section (Faders, Labels, Out Assigns, Aux Sends, FX
Patch, Dynamics, Eq, Input/Attenuator).

[Ctrl-PgUp] snaps you to the top of the module. [Ctrl-PgDn] snaps you to the bottom of the
module.

7 The [Left-Arrow] key scrolls the view to the left one channel at a time. The [Right-Arrow] key
scrolls the view incrementing one channel at a time. The mousewheel may also be used to
increment and decrement channels.

Channel Selecting

8 [Left-Clicking] in the channel label area just beneath the title bar toggles channel selection on
and off.

78 [Alt-Left-Clicking] in the channel label area just beneath the title bar toggles channel selection
from the last toggled channel to the current channel on and off. The selected channels are
indicated by an inverse coloring of this label area. Selected channels are grouped and any
selected channel can become the group master. Adjusting any control on the group master will
also adjust the same control on all other selected channels. Any control that reaches its max
or min levels will maintain its over-range internal value and keep its relative position within the
group as the levels are brought back into range.

8 [Right-Clicking] in the channel label area just beneath the title bar toggles all selected
channels off.

F Whenever channels are selected, the mixer mouse pointer will change to indicate that
channels are selected. Selected channels respond as a group to mixer adjustments and this
mouse pointer serves as a reminder that channels that may not be in view are currently
selected, so you may clear those selections if desired before adjusting controls.

Using Channel Group Menu Options

Groups
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8 [Right-Clicking] on the Full Mixer View title bar displays the popup Group menu. This menu
allows you to save and recall preset channel groups. There are 32 Group preset assignments
and a few special groups for mixer section selections (ie inputs, returns, and outputs).

78 [Shift-Left-Clicking] one of the 32 Group preset options creates a new group and assigns the
currently selected channels to that group and prompts for a group name.

8 [Left-Clicking] on one of the 32 Group preset options clears any existing selected mixer
channels and selects that group of mixer channels.

8 [Left-Clicking] on the Select All option selects all input, return, and output mixer channels.
[Left-Clicking] on the Select All Inputs, Select All Returns, or Select All Outputs option selects
the corresponding mixer channels.

78 [Ctrl-Left-Clicking] one of the 32 Group preset options will blend the preset with any currently
selected mixer channels.

When a group of channels are selected, any control adjustment on one of those selected
channels activates the adjustment on all of the group channels  simultaneously. You may
override the group at anytime by using the [Alt] key as you adjust individual channel controls.

When you are finished with the group operation, simply [Right-Click] in the channel label area
just beneath the title bar to clear the group.
The group assignments will save with the session and mix templates.

Latches

These work similar to Group presets but add the power of automatic latching anytime one of
the preset latched channels is adjusted. These latched groups do not require pre-selection
before adjusting controls, the latch between channels is automatic when any one of the latch
preset channels is adjusted. These latch presets can be very handy for creating stereo-latched
L and R channels which will then always adjust the pair simultaneously. You may override the
latch at anytime by using the [Alt] key as you adjust channel controls. These latch presets save
with Mix Template and Mix Session Files.

8 [Right-Clicking] on the Full Mixer View title bar displays the popup Group menu. This menu
also allows you to save and recall preset Latch groups. There are 32 latch preset
assignments.

78 [Shift-Left-Clicking] one of the 32 Latch preset options creates a new latch group and assigns
the currently selected channels to that latch group and prompts for a latch group name.

8 [Left-Clicking] on one of the 32 Latch preset options clears any existing selected mixer
channels and selects that group of mixer channels. Note that this is not needed to utilize the
group itself... simply adjust anyone of the latched channels and the entire group will be
affected.



Navigation 43

© 2008 - 2010 Robert Lentini and RML Labs

4.6 Wide View Mixer Window

The Wide View Mixer window displays a single channel of the mixing console in a wide view showing
all individual controls for a complete mixer channel at one time. The knobs and switches are directly
reachable. The Titlebar will display the current mixer (FOH or Monitor Mixer) being viewed. Monitor
mixers will display a deep red titlebar color.

78 This view can be opened by [Shift-Right-Clicking] in any area of the Full or Zoom View
window.

8 The window may be closed by [Left-Clicking] the close button in the upper right corner of the
mixer window.

8 [Right-Clicking] in this view will popup a menu listing of every channel on the console, with
named labels, allowing you to instantly jump to any particular channel by [Left-Clicking] on
your selection. The selected channel will become the first displayed channel in the view,
unless there are not enough channels left to fill the window size, in which case the display will
adjust to fit to the end. You may also switch to any Monitor Console from this menu.

Knobs And Switches

8 [Left-Clicking] on any control will allow direct adjustment of its setting.

Link Keys

7 Keyboard shortcuts can also be used to switch to different mixers by using two number keys
(not on the NumPad) in sequence. The mixers are numbered from 00 (FOH) to 24. After
pressing the first number key, a mixer list will be displayed with mixer labels. The list will be hi-
lited to display the range of active remaining selections. Press the second number key to
select the desired mixer. For instance, if you first press 1, then the list will display the mixers
with 10 to 19 hi-lited and expect the second number for the desired mixer. You can also press
the M-key (Mixer) to pop the list up as a reference, and then enter the two number keys.

Label Display Zone

8 [Shift-Left-Clicking] in the Label Display zone displays a channel label dialog box, allowing a
name for the channel to be entered. You must press the [Enter] key for the name to be
accepted.

78 [Ctrl-Left-Clicking] in the Label Display zone allows you to enter labels for sequential
channels. Pressing the [Enter] key after a label name has been entered will automatically
prompt for a label name for the next channel. To close or cancel the label dialog box, [Left-
Click] either the close button or outside of the box, or press the [Esc] key.

F Names entered on the FOH Mixer or Master Monitor Mixer 1 Input channels will automatically
pass through to all channels on the following Monitor mixers. Names entered on any Monitor
Mixer 2 or higher are only entered on that mixer. Pressing the [Alt] key along with one of the
[Shift] or [Ctrl] options to create a label, will block the automatic pass thru, allowing you to
label changes on the current mixer without affecting other mixers.
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Set Channel Label Color

78 [Alt-Right-Clicking] in any mixer view displays the Store/Recall menu. Selecting the Set
Channel Label Color option allows you to select one of the 16 label outline colors for this
channel or no label color. If this channel is one of a group of selected channels, then all
selected channels will be affected. The default behavior sets this chan color for all mixers. If
you press the [Alt-Key] when activating the menu choice, only the current mixer will be
affected. This data saves with mix sessions, mix templates and with scenes. On scene recalls
with active label properties, the chan label color will change with the label text. You might set a
group of  vocals to one color and horns to another… etc. Or you may find it useful to just set
the first vocal chan to a color and then the first horn chan to a different color to visually mark
and separate the groups without flooding the label area with colors.

Scrolling

7 The [Left-Arrow] key scrolls the view to the left one channel at a time. Pressing [Shift-Left-
Arrow] scrolls the view to the left one page (complete view width) at a time. Pressing [Ctrl-Left-
Arrow] scrolls the view to the previous section from Outputs to Returns to Inputs. The [Right-
Arrow] key scrolls the view incrementing one channel at a time. Pressing [Shift-Right-Arrow]
scrolls the view incrementing one page (complete view width) at a time. Pressing [Ctrl-Right-
Arrow] scrolls the view to the next section from Inputs to Returns to Outputs. The mousewheel
may also be used to increment and decrement channels.

The [Home] key scrolls the view to the first channel. The [End] key scrolls the view to the first
output channel.

The [Tab] key scrolls the mixer view to the next section from Inputs to Returns To Outputs,
then back to Inputs. The [Shift-Tab] works in reverse.

View Locking

8 [Right-Clicking] on the Close button of the Wide Mixer view, locks or unlocks that view. Moving
around in any of the other views will not cause the current locked view to chase along. You
may still change chans in the locked view itself, but it will no longer be linked to affect other
views. The Close button will change to display a small padlock when the view is locked.

Channel Selecting

8 [Left-Clicking] in the channel label area just beneath the title bar toggles channel selection on
and off.

78 [Alt-Left-Clicking] in the channel label area just beneath the title bar toggles channel selection
from the last toggled channel to the current channel on and off. The selected channels are
indicated by an inverse coloring of this label area. Selected channels are grouped and any
selected channel can become the group master. Adjusting any control on the group master will
also adjust the same control on all other selected channels. Any control that reaches its max
or min levels will maintain its over-range internal value and keep its relative position within the
group as the levels are brought back into range.

8 [Right-Clicking] in the channel label area just beneath the title bar toggles all selected
channels off.
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F Whenever channels are selected, the mixer mouse pointer will change to indicate that
channels are selected. Selected channels respond as a group to mixer adjustments and this
mouse pointer serves as a reminder that channels that may not be in view are currently
selected, so you may clear those selections if desired before adjusting controls.

Using Channel Group Menu Options

Groups

8 [Right-Clicking] on the Full Mixer View title bar displays the popup Group menu. This menu
allows you to save and recall preset channel groups. There are 32 Group preset assignments
and a few special groups for mixer section selections (ie inputs, returns, and outputs).

78 [Shift-Left-Clicking] one of the 32 Group preset options creates a new group and assigns the
currently selected channels to that group and prompts for a group name.

8 [Left-Clicking] on one of the 32 Group preset options clears any existing selected mixer
channels and selects that group of mixer channels.

8 [Left-Clicking] on the Select All option selects all input, return, and output mixer channels.
[Left-Clicking] on the Select All Inputs, Select All Returns, or Select All Outputs option selects
the corresponding mixer channels.

78 [Ctrl-Left-Clicking] one of the 32 Group preset options will blend the preset with any currently
selected mixer channels.

When a group of channels are selected, any control adjustment on one of those selected
channels activates the adjustment on all of the group channels  simultaneously. You may
override the group at anytime by using the [Alt] key as you adjust individual channel controls.

When you are finished with the group operation, simply [Right-Click] in the channel label area
just beneath the title bar to clear the group.
The group assignments will save with the session and mix templates.

Latches

These work similar to Group presets but add the power of automatic latching anytime one of
the preset latched channels is adjusted. These latched groups do not require pre-selection
before adjusting controls, the latch between channels is automatic when any one of the latch
preset channels is adjusted. These latch presets can be very handy for creating stereo-latched
L and R channels which will then always adjust the pair simultaneously. You may override the
latch at anytime by using the [Alt] key as you adjust channel controls. These latch presets save
with Mix Template and Mix Session Files.

8 [Right-Clicking] on the Full Mixer View title bar displays the popup Group menu. This menu
also allows you to save and recall preset Latch groups. There are 32 latch preset
assignments.

78 [Shift-Left-Clicking] one of the 32 Latch preset options creates a new latch group and assigns
the currently selected channels to that latch group and prompts for a latch group name.

8 [Left-Clicking] on one of the 32 Latch preset options clears any existing selected mixer
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channels and selects that group of mixer channels. Note that this is not needed to utilize the
group itself... simply adjust anyone of the latched channels and the entire group will be
affected.

4.7 Effects View Windows

Top-Client Area - FX Choices List

Group Button

8 [Left-Clicking] the Group button on the FX Choices list window will allow you to group selected
effects for easy organization and location. Up to 30 groups can be created. As groups are
created, they are automatically saved to disk for exact recall the next time the program is run.

Navigation

Scrolling

7/8 The Effects View windows may be scrolled by [Left-Dragging] the right scroll bar area, or by
pressing the [Up-Arrow] or [Down-Arrow] keys.

Top-Client Area - FX Patch Lists

These windows will chase the current Hot Channel when active and display the list of plugins
currently patched on that channel.

Each of the two FX Patch List windows include the following buttons:

Add Button

8 [Left-Clicking] the Add button on any Pre or Pst patch window will add the selected effect from
the FX Choices list to the respective patch window.

Rem Button

8 [Left-Clicking] the Rem button on any Pre or Pst patch window will remove the selected effect
from the respective patch window.

Clr Button

8 [Left-Clicking] the Clr button on any Pre or Pst patch window will clear all effects from the
respective patch window. If the current channel is one of a group of selected channels, then all
selected channels will be affected.

78 Pressing the [Ctrl] key when activating this function will clear all channels of the associated
Pre or Pst patches.
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FX Button

8 [Left-Clicking] the FX button on any Pre or Pst patch window will display the FX Choices
window.

F The title bar on each of the FX Patch windows contains a track label for easy channels
identification.

4.8 Scenes View Window

The Scenes View window displays all Scenes that have been created as part of the current session.
Scenes are snapshots of all 25 mixer settings and can be used to instantly recall the consoles to a
preset state. Each scene contains a powerful properties dialog that can control exactly what settings
are affected when the scene is recalled. You can activate or de-activate individual controls and
module sections, as well as control which channels and mixers will be affected. You can also set a
fade time for the scene in milliseconds and also select whether switches react first or last when a fade
is active.

A Scene also saves and recalls the patched plugins and plugin settings for each chan on each mixer.
If the plugin patch list stays the same within a mixer channel from scene to scene, the plugin patches
will not be altered and only the plugin settings will be saved and recalled. If the plugin patches on a
channel are different from scene to scene, the patch list will be cleared and the new plugin patches
will be recalled. Therefore, you can actually have a scene add or remove plugin patches from any
mixer channel, as well as only alter plugin settings. The appropriate FX Pre and FX Pst options in the
Scene Properties window must be active for the Plugins to be affected by the scene recall.

Mixer channel re-ordering and channel labels can also be saved and recalled with a scene. The Mixer
Channel re-ordering option operates on all channels within a specific mixer, so the Mixer properties
must be active for the desired mixers to be affected. This can be very useful for doing festival type
jobs where there is more than one band setup. Now each band can have a starting scene that can
reset everything, including new chan labels and chan re-ordering setups without having to stop the
engine and load a new session file. If you are not using these features in a particular scene, turn off
these scene properties options to improve scene recall performance.

Top-Client Area

Options Icon

8 [Left-Clicking] the blue pyramid Options Icon opens a popup menu of various options.

Auto Advance After Recall

This option automatically advances to the next scene entry after a scene recall operation…
perfect for stepping through a series of scenes in a show lineup, and can be saved with the
preferences.

Disable SpaceBar Scene Recall

This option will disable the spacebar from activating a scene recall, and can be saved with the
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preferences.

Rename Current Scene

This option allows you to rename an existing scene and it will handle the details in the
background by copying the scene file  to a new one with the new name and altering the name in
the listbox. This method allows other sessions linked to the old scene file to still operate
correctly. You must save and update the session to retain the scene listbox changes and the
new scene file links..

Import Scene To Current Session

This option will copy a scene file from another folder into the current session Scenes folder and
add the scene into the current session scene list. If there is a scene name conflict in the list,
you must change the name. If there is a duplicated scene file name already in the current scene
folder, you will be given the option to adjust the name or keep it as is. In the latter case, the
current scene file will be used and the new scene added to the list. This allows you to link in
scenes from different mix session spinoffs within the same folder.

New Button

8 [Left-Clicking] the New button allows you to create a new Scene which takes a snapshot of the
current state of all 25 mixers. A name dialog window is displayed so you can name the Scene.
You must first be in an active Mix Session before you can create Scenes, since the Scenes
are files that are placed in a \Scenes folder under the project folder. Scene names must also
be legal filenames with only numbers, letters, spaces, underscores, hyphens and a few other
specific punctuation characters allowed. Entering a new scene filename that contains illegal
characters will flag you with a message listing all legal characters you can use and then allow
you to re-enter the name, or cancel.

F You should always create a new folder for each project and place the session files in that
folder. This will keep the \Scenes folder unique to that project and prevent corruption between
projects with the same scene names.

F You can create partial scenes which will overlay only selected channels on selected mixers
and not disturb other mixers and channels when recalled. To create a partial scene, first select
only the channels on whichever mixers you want to be altered when the scene is recalled, and
then create the new scene or update an existing one.

F Each time a scene is created or altered, the scene properties dialog will display that allows
you to set which controls and switches are active within a scene and which mixers will be
affected. You can also set a fade time for the scene in milliseconds and also select whether
switches react first or last when a fade is active. Fades require the engine to be live since they
use the sample-clock for timing. The display will also show you the channel list of the scene's
active channels. You can see and adjust these options by [Right-Clicking] on a scene in the
Scene View window also. Once in the dialog you can click OK or use the Enter key to exit and
save the changes or click Cancel or use the ESC key to exit and cancel any changes.

Updt Button
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8 [Left-Clicking] the Updt button allows you to update an existing Scene. The selected Scene is
overwritten with the current state of all 25 mixers.

F You can create partial scenes which will overlay only selected channels on selected mixers
and not disturb other mixers and channels when recalled. To create a partial scene, first select
only the channels on whichever mixers you want to be altered when the scene is recalled, and
then create the new scene or update an existing one.

F Each time a scene is created or altered, the scene properties dialog will display that allows
you to set which controls and switches are active within a scene and which mixers will be
affected. You can also set a fade time for the scene in milliseconds and also select whether
switches react first or last when a fade is active. Fades require the engine to be live since they
use the sample-clock for timing. The display will also show you the channel list of the scene's
active channels. You can see and adjust these options by [Right-Clicking] on a scene in the
Scene View window also. Once in the dialog you can click OK or use the Enter key to exit and
save the changes or click Cancel or use the ESC key to exit and cancel any changes.

Del Button

8 [Left-Clicking] the Del button allows you to delete an existing Scene. The selected Scene is
removed from the Scenes listbox. The actual file is not deleted from the \Scenes folder in case
other spinoff Mix Sessions are also using this Scene.

Clr Button

8 [Left-Clicking] the Clr button allows you to delete all existing Scenes. All Scenes are removed
from the Scenes listbox. The actual files are not deleted from the \Scenes folder in case other
spinoff Mix Sessions are also using any of these Scenes.

Recall Button

8 [Left-Clicking] the Recall button allows you to recall a Scene. Using the [Alt] key with the
Recall button will cancel any fade action that is part of the scene properties. Using the [Ctrl]
key with the Recall button will overide the Partial Chan Selecet property and force the
selection of partial scene channels as a temporary group.

Navigation - Scenes List Area

Scrolling

7/8 The Scenes List may be scrolled by [Left-Dragging] the right scroll bar area, or by pressing the
[Up-Arrow] or [Down-Arrow] keys.

Scene Selection In The Listbox

78 [Left-Clicking] on a Scene selects and highlights it in the listbox.

7 Using the [Up-Arrow] and [Down-Arrow] keys scrolls up and down the list selecting one Scene
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at a time.

7 The [Home] key will jump to the first Scene in the list. The [End] key will jump to the last Scene
in the list.

Recalling Scenes

8 [Double-Clicking] any Scene in the listbox will instantly recall the scene and alter the settings
of all 25 mixers according to the scene properties.

7 Pressing the [SpaceBar] will instantly recall the scene and alter the settings of all 25 mixers
according to the scene properties.

F Pressing the [Alt] key when recalling a scene will cancel any fade action that is part of the
scene properties .

F Pressing the [Ctrl] key when recalling a scene will overide the Partial Chan Selecet property
and force the selection of partial scene channels as a temporary group.

F Touching any control that is part of an active scene fade will disengage and overide that
control.

Changing Scene Properties

8 [Right-Clicking] any Scene in the listbox will display the scene properties dialog and allow you
to alter what controls and mixers are affected in the scene, as well as adjust fade times and
switch channel group selection options.

7 Pressing the [Enter] key will display the scene properties dialog of the seleceted scene and
allow you to alter what controls and mixers are affected in the scene, as well as adjust fade
times and switch channel group selection options.

F Fades require the engine to be live since they use the sample-clock for timing. Make sure to
also set the Switches First option on or off depending on whether you want the switches to
operate before or after the fade.

Moving Scenes Within The List

7 Pressing [Ctrl-Up Arrow] or [Ctrl-Down Arrow] will move the scene position up or down in the
listbox, allowing you to group the scenes in any order you desire. It can be useful to create
blank scenes that take no action (everything off in the scene properties) and use them as title
separators between scene groups. Name them with dashes or stars and a label, for example "-
- - - - Mute Groups - - - - -".
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4.9 Touch Panel View

This floating, always ontop, window gives access to important keyboard functions when using
a touch screen or tablet type laptop which covers the keyboard. The functions can also be
used with a mouse if desired. The window position and an auto display option may be saved
with the preferences file.

Left-Client Area

ÙÚ×Ø

These icons function as the Arrow keys on the keyboard, and couple with the use of the modifier
options next to them.

7

This icon opens a virtual keyboard for typing in labels and filenames.

0 1 2 3 4 5 6 7 8 9

These numbers function as the number keys across the top of the keyboard and can be used to
switch monitor mixers quickly.

ESC

This icon functions as the Escape key.

ÿ

This icon forces the taskbar and Windows Start Menu to the top if they are hidden. The Start Menu
will close after a few seconds, leaving the taskbar available to jump to other programs.

Right-Client Area

CTRL Lite

This icon can be clicked to engage Ctrl-Mode. The lite will flash and as long as it is flashing, all
mouse or touch actions will act as if the Ctrl-Key is depressed. Some functions may automatically
disengage this mode when completed. Otherwise, clicking again on this icon will clear it and stop the
flashing. This may be used in combination with the Shft and Alt Mode lites. Right-Clicking anywhere
in the Touch Panel view will disengage all active modifier modes.

SHFT Lite
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This icon can be clicked to engage Shft-Mode. The lite will flash and as long as it is flashing, all
mouse or touch actions will act as if the Shft-Key is depressed. Some functions may automatically
disengage this mode when completed. Otherwise, clicking again on this icon will clear it and stop the
flashing. This may be used in combination with the Ctrl and Alt Mode lites. Right-Clicking anywhere
in the Touch Panel view will disengage all active modifier modes.

ALT Lite

This icon can be clicked to engage Alt-Mode. The lite will flash and as long as it is flashing, all
mouse or touch actions will act as if the Alt-Key is depressed. Some functions may automatically
disengage this mode when completed. Otherwise, clicking again on this icon will clear it and stop the
flashing. This may be used in combination with the Ctrl and Shft Mode lites. Right-Clicking anywhere
in the Touch Panel view will disengage all active modifier modes.

F1 - F12

These icons function like the F-Keys and can be used to switch F-Key WorkSpace views. Coupled
with the SHFT modifier, F-Key views can be created.

4.10 Operating Special Dialog Box Controls

SAC  control dialog boxes, such as the Enter Smpte Start Offset dialog, allow you to adjust individual
parameters in a number of ways.

8 [Left-Clicking] in the right side of a parameter display zone increments or decrements the
value by one depending on whether the mouse position is above or below the vertical center
of the zone. [Left-Holding] the mouse in the right side of a parameter display zone changes the
cursor to a +/- shape that then allows you to increment or decrement the value by pushing or
pulling the mouse position from vertical center. The further from the center that you push or
pull, the faster the movement. [Right-Clicking] during this operation will reset the value to zero.

8 [Left-Clicking] in the left upper portion of a parameter display zone pops up a menu list of all
possible values. The default value is bolded and the current value has a checkmark displayed
next to it.

78 [Left-Clicking] in the left lower portion of a parameter display zone latches keyboard entry
mode. You may type the maximum number of characters in a zone, and automatically jump to
the next zone, or you may type fewer characters and press the [Tab] key to jump to the next
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zone. Pressing the [Enter] key accepts the values and exits the dialog. Pressing the [Escape]
key cancels any adjustments made and exits the dialog.

8 Each parameter zone has a Lock zone above it. [Left-Clicking] these zones toggles the zone
between locked and unlocked mode. When a zone is locked, the value is displayed with gray
text and the zone is no longer adjustable. [Left-Clicking] the Default To Keyboard button
automatically sets dialog entry to keyboard mode so you can begin typing immediately.

8 [Left-Clicking] the Close zone in the upper right corner of the dialog will cancel any changes
made and exit the dialog.

5 Understanding The Virtual Console

5.1 Routing And Signal Flow

5.1.1 Input Modules

The console is divided into three main sections - the Input Channel modules, the Return/Aux Master
Channel modules, and the Output Channel modules. There are a total of 25 consoles in the SAC
interface. One Front Of House (FOH) console and twenty-four Monitor consoles. All physical
hardware device inputs feed the FOH console and the Monitor consoles are fed from signal tap-off
points along the FOH channels. Monitor Mixer 1 can be designated as a master Monitor mixer and
signals for mixers 2-24 can be tapped from that mixer, instead of FOH. This allows true spearation of
FOH and Monitor mixes in the case where there is a separate monitor engineer. The FOH console is
also capable of feeding Aux Sends to hardware device outputs and the Returns can also take signal
back from hardware device inputs, allowing the FOH console to use hardware Reverb and Effects
units as an insert into the Aux Send / Return loops.

Input Modules

There are 72 Input Modules. The following information will help with understanding the signal flow
through an Input Module.

I Regarding Signal Flow: The FOH input module Eq, Dynamics, and Pre-Fx Patch insert point
signal flow may be altered from the default. The Pre-Fx Patch insert point may be moved in
front of the Eq / Dynamics section, and the Dynamics section can be moved in front of the Eq
section using the signal flow options from the Mixer menu. For details, see the Mixer Menu
section in the Menu Reference chapter.

Chan Disable

Each FOH Input channel has a channel disable switch which can completely disable the chan while
leaving all of it's settings intact. When a channel is disabled, it contributes no cpu load to the engine
loop and it will display a red X in the mixer chan number display zones at the top of each mixer view.

Input Source

Each FOH Input channel can obtain its source audio data from the soundcard hardware device inputs
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as either a stereo or mono signal, or from SAWStudio Input and output channels, or from an FX Pre-
Patch point using a VST Synth or other audio generating  plugin. A popup menu displays these
choices and also displays a * char next to each device that is currently in use and already assigned,
for your reference.

Each Monitor console (beneath it) can obtain its source audio from one of 6 tap-off points on the FOH
channel above it, or the Monitor 1 mixer can be used as a master monitor and feed taps to the rest of
the Monitor mixers below. You can select from Src-Pre Attenuator, Src-Pst Attenuator, Pst Eq, Pst
Dyn, Pre Fdr (Pst Mute), or Pst Fdr tap. Monitor mixers 2 thru 24 can also select the Src-Split M, Pst
Eq M, Pst Dyn M, Pre Fdr M (Pst Mute), or Pst Fdr M taps coming from the Monitor 1 mixer used as
the master.

F When a channl is not being used for input, it should be set to OFF to eliminate it's load on the
cpu.

Using buffer settings of 3 at 128 or less will actually emulate realtime. The console is capable of
realtime performance for live input sound reinforcement operation with these low latency buffer
settings.

Multiple input channels may be assigned to the same source input device for internally duplicated
signal creation. All routing assignments can be done in realtime with the engine live and SAC will
sync the new signals into the mix loop perfectly on the fly.

Input Mono Switch

This switch sums the left and right signals together and applies a 6 dB level adjustment to the result.
By default, the resulting data will be exactly the same on both the left and right signal paths from this
point on. This switch will also engage when selecting mono input sources and activate the L-Only or
R-Only modes.

8 [Left-Clicking] on the "Mono" label next to the button displays an options menu. The choices
are: L Plus R (-6db);  L Plus R;  L Only;  R Only;  L Minus R (-6db);  L Minus R.

F Deactivating and reactivating the Mono button will return the setting to the default L Plus R (-
6dB.)

Input Attenuator

The data next passes through the Input Attenuator routine which can trim the signal level down from 0
dB (data untouched), to a muted condition, or up to +20db to add signal gain to the entire channel for
weak signals. This can be used to adjust the level of very strong source data right at the top of the
module to eliminate potential clipping problems in the following processing sections, and/or to adjust
the final working range of the channel fader more into the nominal range of the fader's position when
mixing. In most cases this control can be left at its default 0 dB setting.

Input Phase Reverse Switch

This switch will flip the audio phase of the data 180 degrees. This can help adjust frequency
cancellation problems with out-of-phase microphone placements and reverse phased signal cabling
problems that might be part of the original signal.
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8 [Left-Clicking] on the "Phs Rvs" label next to the button displays an options menu. The choices
are: Both;  L Only;  R Only.

This can be useful when a stereo file contains left and right signals that are out of phase.
Playing such a file in mono will cause the signal to cancel badly. Using the Left Only or Right
Only phase reverse can instantly solve this problem.

F Deactivating and reactivating the Phs Rvs button will return the setting to the default - Both.

Input Swap L/R Switch

This switch swaps the left and right signals of the stereo source data.

Input EQ Section

The data next passes through the EQ routines (Optional). There are five high-resolution bandpeaking
filters that can be adjusted independently or all at the same time. Each filter includes an overlapping
frequency center from 40 to 15,000 hertz. The BW or bandwidth adjustment ranges from .1 to 3
octaves, and the boost/cut gain ranges from plus to minus 15 dB.

There is also a Hi Cut filter that ranges from 15,000 to 40 hertz which attenuates frequencies above
the filter setting using an 12 dB per octave roll-off.

There is also a Lo Cut filter that ranges from 40 to 40 hertz which attenuates frequencies below the
filter setting using an 12 dB per octave roll-off.

A set of graphic adjustable bars can be used for quick boost and cut adjustment, much like a simple
set of graphic EQ sliders.

At the bottom of the EQ section is a Reset Flat switch which resets all gain adjustments to flat and the
master EQ In/Out switch to allow for quick bypass of the EQ routines for comparison or for use in
automating the EQ in and out of the mix.

Input Dynamics Section

The data next passes through the Dynamics routines (Optional). Both the Gate and Compressor use
the same Key Buffer to activate their threshold detecting routines. The Key Buffer contains the source
data used to trigger the Gate and Compressor into action. This data is available from the channel
source data itself (Self), or from any other channel source data (1 - 72). The data is processed
through a Hi Cut and Lo Cut overlapping EQ routine that pre-processes what the threshold detecting
routines see. This can be used effectively to allow the Compressor to work as a de-esser or the Gate
and Compressor to trigger and respond to a limited range of frequencies.

The Key Listen switch acts as a Solo switch for the Key Buffer. This allows you to audition precisely
what the threshold detecting routines are seeing.

The Gate Attack setting controls how fast the Gate opens up when the signal goes above the
threshold setting.

The Gate Release setting controls how fast the Gate shuts down when the signal drops below the
threshold again.
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The Gate Floor setting controls how far the Gate shuts down. The lower the setting, the farther the
signal is attenuated.

The Gate Threshold setting determines the trigger level where the Gate responds.

The Gate Rvrs switch causes the gate to operate in reverse. When the signal is greater than the
threshold, the gate closes down to the floor setting and when the signal falls below the threshold, the
gate opens back up to full. This can be used to create a simple and powerful ducking processor by
assigning the key to another track which will then control when this track lowers its level. Set the floor
value to the desired ducked level and adjust the attack, release and threshold to control the overall
timing. You can also use this mode with self keying to create a new sounding limiting effect. When the
signal rises above the threshold on loud transients, the gate will lower the level to the fixed floor level.
This sounds different than limiting or compression, because the transient is actually dropped below
the level of the rest of the average signal.

The Gate On switch allows for a quick bypass of the Gate routines for comparison or for use in
automating the Gate in and out of the mix.

The Compressor Attack setting controls how fast the Compressor starts to squeeze when the signal
goes above the threshold setting.

The Compressor Release setting controls how fast the Compressor lets go when the signal drops
below the threshold again.

The Compressor Ratio setting determines the ratio of signal attenuation when the Compressor is
triggered.

The Compressor Threshold setting determines the trigger level where the Compressor responds.

The Compressor On switch allows for a quick bypass of the Compressor routines for comparison or
for use in automating the Compressor in and out of the mix.

The Dynamics Gain setting allows you to adjust the overall output gain of the Gate or Compressor
when either one or both are active.

The Dynamics Gain Reduction Meter displays the overall amount of signal gain reduction occurring
as a combination of the Gate and Compressor action.

Input FX Pre Fader Patch

The data next passes through the FX Pre Fader Patch (Optional). This allows you to patch in SAC or
SAWStudio native plug-ins, or DirectX or VST plug-ins. These FX process in the order they are
patched.

8 The yellow FX icon will display a bar graphic across the two holes when plug-ins are assigned.
[Left-Clicking] on this icon will display a broken bar, which means the plug-ins are bypassed.

This FX Patch processes the data at an internal resolution of 24 bits, regardless of the final session
resolution setting.

F If you are using VSTi Synth plug-ins that generate sound, you would probably want to route
the FX Pre Fader Patch point in front of the Eq/Dyn section so that you could use the EQ and
Dynamics processing to alter the signal.
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Input Aux Sends

At this point the data stream can be split off into multiple directions at once. There are six stereo Aux
Sends which can mix the channel data stream with other channel data streams into the Aux Master
section. The Aux Masters can be routed back to the Return channels virtually, allowing reverb and
other plug-ins to be processed across multiple channels at once, or can be routed externally to any of
the audio device outs for headphone monitor feeds or external processing units like reverbs, which
can then be brought back into the mix live, in almost perfect real-time sync.

The Aux Send Pan allows left/right balance adjustment of the data being sent to the Aux Master mix.

The Aux Send Volume Slider allows level adjustment of the data being sent to the Aux Master mix.

The Aux Send In switch allows the send to be activated or deactivated.

The Aux Send Post Fader switch forces the data split off to occur after the channel fader and pan
controls when engaged and before the fader and pan controls when not engaged.

8 [Left-Clicking] on the individual Aux Number text (1, 2, 3, etc.) or the main Aux Asgn text in
any of the Aux Send sections will display a menu of special Aux Send options.

Aux Master Labels

This section displays the Aux Master labels for reference only. Selecting any item will close the menu.
No action will be taken.

Input Solo Switch

The data next passes through the Solo routine. The output and input solos may be operated together,
and output group solos may be nested with individual channels still contained within the group. The
routines keep an internal updated count on each channel that is soloed.

You may combine solos from multiple channels to hear a blend of selected signals.

78 Pressing the [Shift] key when activating the first Solo switch, keeps the Return channels active
so you may hear the blend of reverb returns with the soloed channels. This only works when
the solo mode is the Solo In Place option.

Whenever any solo is activated, a flashing Solo Mode light in the top left corner of the Main top-client
area will keep you informed.

8 [Left-Clicking] on this flashing light automatically clears all active solo switches.

When using one of the Solo Bus modes, two independent solo buses are available, one for FOH and
one for MON. Each operator can have their own solo bus out device to maintain separation during a
solo operation between the FOH and Monitor engineers.

8 [Right-Clicking] any mixer Solo Switch when in Solo Bus Mode will display a popup menu of
level settings for that channel's solo bus send. This data is stored with the mixer settings and
is saved with Mix Session and Mix Template files. This can be very useful in balancing input
chan solos against output chan solos, or low level signals against high level signals in Pre
Bus mode.
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Input Mute Switch

The data next passes through the Mute routine. This switch mutes all data from this point on. All
signals before this switch are still active and untouched.

This switch has a slope value associated with it that controls how fast the muting action occurs.
Smaller slope values create a more instant response, and larger values create a slower response,
which can be used in place of a quick fade to ramp a signal up or down smoothly.

78 Pressing the [Ctrl] key when activating the mute switch will mute the FOH and all monitor
mixers also for that channel. This can be very useful for muting output channels or returns
across all mixers at the same time. Temporary grouped channels will also respond to this
feature.

8 [Right-Clicking] any Mute switch on the FOH or Monitor Mixer 1 console view will display the
Mute-Thru Monitors Latch option. If this is activated on an FOH channel,  that channel's mute
switch will always latch thru to all monitor mixers regardless of the mixer tap point. If this is
activated on a Monitor Mixer 1 channel, that channel's mute switch will always latch thru to all
the rest of the monitor mixers, independent of the FOH mixer. In this way, you can maintain the
separation between a Monitor and  FOH engineer. This option can be very handy for RF mic
channels, for example, where it may be desirable to mute those channels in all monitor mixers
with the press of the FOH mute switch, even though the monitor mixers are tapped at SRC or
other points that normally do not follow the FOH mutes.

Input Channel Fader

The data next passes through the Channel Fader routine. This controls the overall direct signal
strength for this channel in the mix.

This control has a slope value associated with it that controls how fast the level change occurs.
Smaller slope values create a more instant response, and larger values create a slower response.

Input Pan Slider

The data next passes through the Pan routine. This controls the left/right balance of the data in the
overall stereo levels of this channel signal.

This control has a slope value associated with it that controls how fast the level change occurs.
Smaller slope values create a more instant response, and larger values create a slower response.

Input FX Post Fader Patch

The data next passes through the FX Post Fader Patch. This allows you to patch in SAC or
SAWStudio native plug-ins, or DirectX or VST plug-ins. These FX process in the order they are
patched.

8 The yellow FX icon will display a bar graphic across the two holes when plug-ins are assigned.
[Left-Clicking] on this icon will display a broken bar, which means the plug-ins are bypassed.

This FX Patch processes the data at an internal resolution of 24 bits, regardless of the final session
resolution setting.
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Input XY Surround Pan (FOH Console Only)

The data next passes through the XY Surround Pan routine. This joystick type control adjusts the
balance of signal levels split off to the eight surround points designated around the perimeter of the
control. These eight split off signals are blended together in the surround pan internal buffers and
output to discreet audio device outs based on the XY Pan Out Assignments on the output channels.

The Sub Send controls the signal level sent to the separate Sub XY Pan Out Assignment.

The Center Send controls the signal level sent to the separate Center XY Pan Out Assignment.

The XY Pan In/Out switch enables or disables the use of the XY Pan routine for this channel. If
surround panning is not being used, this switch should be left out, so there is no unnecessary extra
load on the CPU. Processing the signal to the surround buffers will add processing load to the overall
playback performance.

The XY Pan has individual node point control. You may click on each of the eight node surround
points on any channel, and the node will toggle between active and inactive. The node turns red
when it is inactive. When a node is inactive, audio from that XY Pan will not feed that particular output
bus. You may use this feature to keep music out of the center channel for instance. These nodes may
be automated, allowing you to toggle them during automated playback.

Input Out Assign

The data ends up at the Out Assign switches. These switches control the destination routing of the
channel signal. These switches may be combined allowing the channels to be routed to multiple
output destination devices at the same time.

These switches represent stereo audio device outputs. To force the destination to one side of the
output device, use the Pan Slider, coupled with the Mono switch if needed.

When using the XY Surround Pans, the Out Assign switches should most likely be left off and the final
signal destination will be controlled by the XY Pan Out Assignments on the Output Channels.

5.1.2 Return/Aux Master Modules

There are six Return Modules. The following information will help in understanding the signal flow
through a Return Module.

Aux Master Out Assign

The mix of data sent from the Aux Sends arrives at the top of the Aux Master section. The mix for
each of the Aux Sends can be routed to either the internal Virtual Buffers or any of the audio device
outputs.

When set to the Virtual Buffers, the data is passed straight down to the corresponding Return Section
below it.

When set to an audio device output, the data is fed to the final output stage which feeds directly to
the assigned audio device. This allows the data to be used externally for headphone monitor feeds or
as a feed to an external processing unit.



SAC User Manual60

© 2008 - 2010 Robert Lentini and RML Labs

Aux Master Pan Slider

The data next passes through the Aux Master Pan routine. This controls the left/right balance of the
data in the overall Aux Master signal.

Aux Master Channel Fader

The data next passes through the Aux Master Channel Fader routine. This controls the overall direct
signal strength for this Aux Master Send.

This control has a slope value associated with it that controls how fast the level change occurs.
Smaller slope values create a more instant response, and larger values create a slower response.

Return Input Source

Each FOH Return channel can obtain its source audio data from either the internal Virtual Buffers or
from any one of the hardware device inputs. When set to the internal Virtual Buffers, the data is
gathered directly from the corresponding Aux Master above it. The Aux Master must also be set to
Virtual in order to complete the connection. Each Monitor console (beneath it) can obtain its signal
source from one of two tap-off points on the FOH console above it. You can select from a Pre Fdr or
Pst Fdr tap.

Return Mono Switch

This switch sums the left and right signals together and applies a 6 dB level adjustment to the result.
By default, the resulting data will be exactly the same on both the left and right signal paths from this
point on. This switch will also engage when selecting mono input sources and activate the L-Only or
R-Only modes.

8 [Left-Clicking] on the "Mono" label next to the button displays an options menu. The choices
are: L Plus R (-6db);  L Plus R;  L Only;  R Only;  L Minus R (-6db);  L Minus R.

F Deactivating and reactivating the mono button will return the setting to the default L Plus R (-
6dB.)

Return Attenuator

The data next passes through the Return Attenuator routine which can trim the signal level down from
0 dB (data untouched), to a muted condition, or up to +20db to add signal gain to the entire channel
for weak signals. This can be used to adjust the level of very strong source data right at the top of the
module to eliminate potential clipping problems in the following processing sections, and/or to adjust
the final working range of the channel fader more into the nominal range of the fader's position when
mixing. In most cases this control can be left at its default 0 dB setting.

Return Phase Reverse Switch

This switch will flip the audio phase of the data 180 degrees. This can help adjust frequency
cancellation problems with out of phase microphone placements and reverse phased signal cabling
problems that might be part of the original signal.
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8 [Left-Clicking] on the "Phs Rvs" label next to the button displays an options menu. The choices
are: Both;  L Only;  R Only.

This can be useful when a stereo file contains left and right signals that are out of phase.
Playing such a file in mono will cause the signal to cancel badly. Using the Left Only or Right
Only phase reverse can instantly solve this problem.

F Deactivating and reactivating the Phs Rvs button will return the setting to the default L Plus R
(-6dB.)

Return Swap L/R Switch

This switch swaps the left and right signals of the stereo source data.

Return FX Pre Fader Patch

The data next passes through the FX Pre Fader Patch. This allows you to patch in SAC or
SAWStudio native plug-ins, or DirectX or VST plug-ins. These FX process in the order they are
patched.

8 The yellow FX icon will display a bar graphic across the two holes when plug-ins are assigned.
[Left-Clicking] on this icon will display a broken bar, which means the plug-ins are bypassed.

This FX Patch processes the data at an internal resolution of 24 bits, regardless of the final session
resolution setting.

Return Solo Switch

The data next passes through the Solo routine. The output and return solos may be operated
together, and output group solos may be nested with individual channels still contained within the
group. The routines keep an internal updated count on each channel that is soloed.

You may combine solos from multiple channels to hear a blend of selected signals.

F The Return solos are enhanced to maintain the in-place solo feature while still allowing both
pre and post Aux Send input channel information to reach the Return bus. Therefore you may
solo just Return tracks and hear the blend of all Aux Send information coming through that
Return.

78 Pressing the [Ctrl] key when deactivating any Solo switch will automatically deactivate all
engaged Solo switches.

Whenever any solo is activated, a flashing Solo Mode light in the top lefrt corner of the Main top-client
area will keep you informed.

8 [Left-Clicking] on this flashing light automatically clears all active solo switches.

8 [Right-Clicking] any mixer Solo Switch when in Solo Bus Mode will display a popup menu of
level settings for that channel's solo bus send. This data is stored with the mixer settings and
is saved with Mix Session and Mix Template files. This can be very useful in balancing input
chan solos against output chan solos, or low level signals against high level signals in Pre
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Bus mode.

Return Mute Switch

The data next passes through the Mute routine. This switch mutes all data from this point on. All
signals before this switch are still active and untouched.
This switch has a slope value associated with it that controls how fast the muting action occurs.
Smaller slope values create a more instant response, and larger values create a slower response,
which can be used in place of a quick fade to ramp a signal up or down smoothly.

8 [Right-Clicking] any Mute switch on the FOH or Monitor Mixer 1 console view will display the
Mute-Thru Monitors Latch option. If this is activated on an FOH channel,  that channel's mute
switch will always latch thru to all monitor mixers regardless of the mixer tap point. If this is
activated on a Monitor Mixer 1 channel, that channel's mute switch will always latch thru to all
the rest of the monitor mixers, independent of the FOH mixer. In this way, you can maintain the
separation between a Monitor and  FOH engineer. This option can be very handy for RF mic
channels, for example, where it may be desirable to mute those channels in all monitor mixers
with the press of the FOH mute switch, even though the monitor mixers are tapped at SRC or
other points that normally do not follow the FOH mutes.

Return Channel Fader

The data next passes through the Channel Fader routine. This controls the overall direct signal
strength for this channel in the mix.

This control has a slope value associated with it that controls how fast the level change occurs.
Smaller slope values create a more instant response, and larger values create a slower response.

Return Pan Slider

The data next passes through the Pan routine. This controls the left/right balance of the data in the
overall stereo levels of this channel signal.

This control has a slope value associated with it that controls how fast the level change occurs.
Smaller slope values create a more instant response, and larger values create a slower response.

Return FX Post Fader Patch

The data next passes through the FX Post Fader Patch. This allows you to patch in SAC or
SAWStudio native plug-ins, or DirectX or VST plug-ins. These FX process in the order they are
patched.

8 The yellow FX icon will display a bar graphic across the two holes when plug-ins are assigned.
[Left-Clicking] on this icon will display a broken bar, which means the plug-ins are bypassed.

This FX Patch processes the data at an internal resolution of 24 bits, regardless of the final session
resolution setting.

Return XY Surround Pan (FOH Console Only)
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The data next passes through the XY Surround Pan routine. This joystick type control adjusts the
balance of signal levels split off to the eight surround points designated around the perimeter of the
control. These eight split off signals are blended together in the surround pan internal buffers and
output to discreet audio device outs based on the XY Pan Out Assignments on the output channels.

The Sub Send controls the signal level sent to the separate Sub XY Pan Out Assignment.

The Center Send controls the signal level sent to the separate Center XY Pan Out Assignment.

The XY Pan In/Out switch enables or disables the use of the XY Pan routine for this channel. If
surround panning is not being used, this switch should be left out, so there is no unnecessary extra
load on the CPU. Processing the signal to the surround buffers will add processing load to the overall
playback performance.

The XY Pan has individual node point control. You may click on each of the eight node surround
points on any channel, and the node will toggle between active and inactive. The node turns red
when it is inactive. When a node is inactive, audio from that XY Pan will not feed that particular output
bus. You may use this feature to keep music out of the center channel for instance. These nodes may
be automated, allowing you to toggle them during automated playback.

Return Out Assign

The data ends up at the Out Assign switches. These switches control the destination routing of the
channel signal. These switches may be combined allowing the channels to be routed to multiple
output destination devices at the same time.

These switches represent stereo audio device outputs. To force the destination to one side of the
output device, use the Pan Slider, coupled with the Mono switch if needed.

When using the XY Surround Pans, the Out Assign switches should most likely be left off and the final
signal destination will be controlled by the XY Pan Out Assignments on the Output Channels.

5.1.3 Output Modules

There are 24 Output Modules. The first 8 Output channels are designed as hardware Master device
outputs. The remaining Output channels can be used as Sub-Groups and routed back to any one of
the Master Output channels. The following information will help with understanding the signal flow
through an Output Module.

The source data for all Output channels comes from the Input and Return channels that are assigned
to this particular Output as a destination and/or the XY Surround Pan Buffers, if assigned.

Output Mono Switch

This switch sums the left and right signals together and applies a 6 dB level adjustment to the result.
By default, the resulting data will be exactly the same on both the left and right signal paths from this
point on.

8 [Left-Clicking] on the "Mono" label next to the button displays an options menu. The choices
are: L Plus R (-6db);  L Plus R;  L Only;  R Only;  L Minus R (-6db);  L Minus R.
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F Deactivating and reactivating the mono button will return the setting to the default L Plus R (-
6dB.)

Output FX Pre Fader Patch

The data next passes through the FX Pre Fader Patch. This allows you to patch in SAC or
SAWStudio native plug-ins, or DirectX or VST plug-ins. These FX process in the order they are
patched.

8 The yellow FX icon will display a bar graphic across the two holes when plug-ins are assigned.
[Left-Clicking] on this icon will display a broken bar, which means the plug-ins are bypassed.

This FX Patch processes the data at an internal resolution of 24 bits, regardless of the final session
resolution setting.

Output Solo Switch

The data next passes through the Solo routine. The output and input solos may be operated together,
and output group solos may be nested with individual channels still contained within the group. The
routines keep an internal updated count on each channel that is soloed.

You may combine solos from multiple channels to hear a blend of selected signals.

78 Pressing the [Ctrl] key when deactivating any Solo switch will automatically deactivate all
engaged Solo switches.

Whenever any solo is activated, a flashing Solo Mode light in the top left corner of the Main top-client
area will keep you informed.

8 [Left-Clicking] on this flashing light automatically clears all active solo switches.

8 [Right-Clicking] any mixer Solo Switch when in Solo Bus Mode will display a popup menu of
level settings for that channel's solo bus send. This data is stored with the mixer settings and
is saved with Mix Session and Mix Template files. This can be very useful in balancing input
chan solos against output chan solos, or low level signals against high level signals in Pre
Bus mode.

Output Mute Switch

The data next passes through the Mute routine. This switch mutes all data from this point on. All
signals before this switch are still active and untouched.

This switch has a slope value associated with it that controls how fast the muting action occurs.
Smaller slope values create a more instant response, and larger values create a slower response,
which can be used in place of a quick fade to ramp a signal up or down smoothly.

8 [Right-Clicking] any Mute switch on the FOH or Monitor Mixer 1 console view will display the
Mute-Thru Monitors Latch option. If this is activated on an FOH channel,  that channel's mute
switch will always latch thru to all monitor mixers regardless of the mixer tap point. If this is
activated on a Monitor Mixer 1 channel, that channel's mute switch will always latch thru to all
the rest of the monitor mixers, independent of the FOH mixer. In this way, you can maintain the
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separation between a Monitor and  FOH engineer. This option can be very handy for RF mic
channels, for example, where it may be desirable to mute those channels in all monitor mixers
with the press of the FOH mute switch, even though the monitor mixers are tapped at SRC or
other points that normally do not follow the FOH mutes.

Output Channel Fader

The data next passes through the Channel Fader routine. This controls the overall direct signal
strength for this channel in the mix.

This control has a slope value associated with it that controls how fast the level change occurs.
Smaller slope values create a more instant response, and larger values create a slower response.

Output Pan Slider

The data next passes through the Pan routine. This controls the left/right balance of the data in the
overall stereo levels of this channel signal.

This control has a slope value associated with it that controls how fast the level change occurs.
Smaller slope values create a more instant response, and larger values create a slower response.

Output FX Post Fader Patch

The data next passes through the FX Post Fader Patch. This allows you to patch in SAC or
SAWStudio native plug-ins, or DirectX or VST plug-ins. These FX process in the order they are
patched.

8 The yellow FX icon will display a bar graphic across the two holes when plug-ins are assigned.
[Left-Clicking] on this icon will display a broken bar, which means the plug-ins are bypassed.

This FX Patch processes the data at an internal resolution of 24 bits, regardless of the final session
resolution setting.

Output XY Pan Assign (FOH Console Only)

If XY Surround Panning is being used and has been assigned on Input and Return channels, these
switches are used to control the final destination for each of the eight surround points and the
separate sub and center channels.

· LR Front
This switch mixes the Left and Right Front surround points into this Output channel.

· LR Center
This switch mixes the Left and Right Center surround points into this Output channel.

· LR Rear
This switch mixes the Left and Right Rear surround points into this Output channel.

· FB Center
This switch mixes the Front and Back Center surround points into this Output channel.
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· Sub
This switch mixes the separate Sub send into this Output channel.

· Center
This switch mixes the separate Center send into this Output channel.

Output Out Assign

The data ends up at the Out Assign control. This controls the final destination routing of the Output
channel signal.

· Master Direct Audio Device Output
The first 8 Output channels are designated as Master Outputs. These will send the audio direcrtly
to a hardware device output.

Master Direct Audio Device Output channels will display their fader and pan knobs as a deep red
color.

· Sub-Group Output
The remaining Output channels are designated as sub-group outputs and will re-route their

signal data back to the selected Master destination channel or multiple Master destination channels,
or be used as a Group Latch VCA type fader to control the actual input channel faders as a group
master. In this case, the signal is not re-routed through the output summing group bus. Any input or
return chan assigned to the group bus will be controlled as a group by the sub fader. Pressing the Alt-
Key while moving the group latch fader will temporarily disengage it from the group. This concept
allows you to set an offset limit by riding the group fader near the bottom or top of its range. Using the
[Left-Right-Click] feature on an Output Group Latch fader will return the fader to its default zero db
position and offset the latched fader channels by the same amount of change. This can be useful to
return all latched channels to a starting default position after having made mix adjustments. The Mute
and Solo switch will also operate on the group.

These assignment selections represent stereo audio device outputs. To force the destination to
one side of the output device, use the Pan Slider, coupled with the Mono switch if needed.

Sub-Group Output channels will display their fader and pan knobs as a pale red color.

F Multiple Output channels may be assigned to the same hardware device out and the signals will
be properly mixed together as if routed through an external hardware mixer. You can also use
this feature to assign two separate monitor mixers to the same hardware stereo device pair, but
use the Master Mono switch and pan on each one to force all audio to one side only on each
mixer. This will allow you to obtain two separate mono mixes from each side of a stereo device
output pair, one mixer feeding the left hardware output, the other mixer feeding the right.

5.1.4 Channel Store/Recall

The Channel Store/Recall feature allows you to store all or part of the mixer channel settings to one of
eight possible memory cell locations. You can then recall those settings from any of the memory cells
to the same or a different mixer channel. This allows instant copying of channel settings, including FX
plug-ins with all the plug-in parameters, between channels.

If the Recall channel is one of a selected group of channels, the recall operation will duplicate the
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settings and FX plug-ins on all selected channels. The recall ignores all device in and out
assignments so you can recall channel control settings from other channels without affecting input
source and output device destinations. You can also use this for a quick compare between different
settings on a single channel; for example, storing different EQ settings to different cells, and then
recalling them for an instant compare between settings.

The eight memory cells are stored as internal clipboards and will retain stored information until the
SAC application is closed. This allows you to transfer settings from one Mix Session to another.

Applying Stored Channel Settings to Another Channel

78 [Alt-Right-Clicking] or [Left-Right-Clicking] in any mixer view displays the Store/Recall menu.

8 Select one of the Store options to choose which section of the channel you wish to store in
one of the cells. To apply the stored channel information to another channel, switch to the
destination channel and choose the desired Recall option. Stored channel date must be
recalled to the same channel type (i.e. Inputs to Inputs, Returns to Returns, and Outputs to
Outputs). All memory cells are set to console channel default settings when SAC is first run,
therefore recalling a cell section that had nothing stored to it will apply default settings.

I Regarding Channel FX Store/Recall: Recalling FX plug-ins will clear and overwrite any
currently patched plug-ins in the destination channel. For more efficient handling, the FX recall
options will not automatically open patched FX windows.

Saving Channel Settings

78 [Alt-Right-Clicking] in any mixer view displays the Store/Recall menu. The Save All To File
From Memory and Load All From File To Memory options allow any memory cell to be saved
to a disk channel template file or loaded from a disk channel template file. The file extension
used is .cht.

78 The Store All From Channel To File and Recall All From File To Channel options allow direct
transfers to and from channel template files to mixer channels through memory cell 1. This can
act as a very powerful partial mix template system.

These options operate across selected channels. The starting channel opens the File Dialog
allowing you to specify a path and name. The default name is filled in to match the channel
label. Each selected channel will write a separate file named the same as the channel label.
This creates a channel mix template of individual files, one per selected channel. Recalling
channel settings from a file also operates across selected channels. The starting channel
opens the File Dialog allowing you to specify a path and name. The default name is filled in to
match the first channel label. Each selected channel will look for a file named the same as its
label and if one is found in the specified path, it will load. If no matching file is found it will
leave this channel alone. This allows you to recall settings to multiple channels in a new
session with channel labels that match the channel template names. By labeling channels in a
similar fashion across all sessions, you can easily exchange mix settings from one unrelated
session to another, one channel at a time, or all at once.

78 The Recall All From File And Duplicate To Selected Channels option opens the file dialog and
allows you to select a file. The settings will be recalled and duplicated on all selected
channels.

Clearing Channel Settings
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78 [Alt-Right-Clicking] in any mixer view displays the Store/Recall menu. Selecting the Clear
Current Channel option clears the current channel to default settings. If the current channel is
one of a group of selected channels, all selected channels are cleared.

Set Channel Label Color

78 [Alt-Right-Clicking] in any mixer view displays the Store/Recall menu. Selecting the Set
Channel Label Color option allows you to select one of the 16 label outline colors for this channel or
no label color. If this channel is one of a group of selected channels, then all selected channels will
be affected. The default behavior sets this chan color for all mixers. If you press the [Alt-Key] when
activating the menu choice, only the current mixer will be affected. This data saves with mix sessions,
mix templates and with scenes. On scene recalls with active label properties, the chan label color will
change with the label text. You might set a group of  vocals to one color and horns to another… etc.
Or you may find it useful to just set the first vocal chan to a color and then the first horn chan to a
different color to visually mark and separate the groups without flooding the label area with colors.

6 Using Effects Views

6.1 Overview

6.1.1 Effects View Overview

SAC will display all installed plug-ins in the FX Choices view. These plug-ins may be grouped for
easy location and organization. Supported effects include all plug-ins written under the SAC and
SAWStudio API, and any DirectX or VST and VSTi Synth plug-ins.

The patched plug-in window position and visibility information is saved with the session so that any
opened FX plug-ins will re-open to their same position when you open the Mix Session. All of the FX
View windows can also be saved with the F-Key workspace views.

I Regarding installation of VST Plug-ins: Many VST installers will ask for a destination folder.
You should choose the VST_PlugIns folder under the SAC main folder. Some of these
installers will create another subfolder inside of the chosen folder. For VST plug-ins to show
up correctly inside of SAC, they must be directly inside of the VST_PlugIns folder. If a VST
plug-in does not show up in the SAC FX Choices list, check the VST_PlugIns folder to see if a
subfolder was created and simply move the applicable plug-in .dll file(s) into the VST_PlugIns
folder directly.

Some VST Plug-In installations will hardcode or otherwise force their plug-in path to remain
intact as installed and will not allow the .dlls to be moved into the SAC VST_PlugIns folder.
SAC will allow VST plug-ins to reside in any folder on any drive by placing an .ini file
substitute in the VST_Plugins folder pointing to the full path of the dll file itself. Create an ascii
text .ini file in the Notepad and name it the same as the original .dll file. Inside the file, type the
full drive and path and original .dll filename on the first line of the file. Make sure to finish the
line with a carriage return. For example, if a VST plug-in called TestPlug.dll is installed to
D:\VST\Work, then create an .ini file called TestPlug.ini and inside the file type the line
D:\VST\Work\TestPlug.dll followed by a carriage return. This .ini file, placed in the
VST_PlugIns folder under SAC, will now link SAC to find the VST plug-in in its originally
installed path. This can help solve compatibility issues with hardwired path plug-ins and their



Using Effects Views 69

© 2008 - 2010 Robert Lentini and RML Labs

various copy protection schemes.

I Regarding VST Plug-In Latency: Some VST plug-ins add a certain amount of latency delay
to the processed buffers depending on their processing algorithms. SAC will not allow the use
of latency causing plugins because it is designed to be a live input driven engine and buffer
size altering or witholding is not possible in a live data stream without causing a delayed
signal. SAC will attempt to detect latency causing plug-ins and automatically bypass them
keeping the live signal data stream in sync.

6.2 Interface

6.2.1 Effects View Top-Client Area - FX Choices List

Group Button

8 [Left-Clicking] the Group button on the FX Choices list window will allow you to group selected
effects for easy organization and location. Up to 30 groups can be created. As groups are
created, they are automatically saved to disk for exact recall the next time the program is run.

Group Button Menu
[
Left-Clicking] the Group button displays a group menu which allows you to create, name and maintain

plug-in groups.

Add Selected To
This option allows you to add the currently selected plug-ins to any group.

Remove Selected From
This option allows you to remove the currently selected plug-ins from any group.

Clear All From
This option allows you to clear all plug-ins from any group.

Rename
This option allows you to enter names for any group.

Group 1 Thru 30
Choosing one of these options clears the listbox and displays only those plug-ins belonging to the
selected group. Plug-ins may belong to multiple groups.

Set Cur Group As Default
This option displays the current default group and will change it to the currently active group when
selected. The default group will be the active group when the program first starts.
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6.2.2 Effects View Top-Client Area - FX Patch Lists

Each of the Pre, Pst and Solo FX Patch List windows include the following buttons:

Add Button

8 [Left-Clicking] the Add button on any Pre or Pst patch window will add the selected effect from
the FX Choices list to the respective patch window.

Rem Button

8 [Left-Clicking] the Rem button on any Pre or Pst patch window will remove the selected effect
from the respective patch window.

Clr Button

8 [Left-Clicking] the Clr button on any Pre or Pst patch window will clear all effects from the
respective patch window. If the current channel is one of a group of selected channels, then all
selected channels will be affected.

78 Pressing the [Ctrl] key when activating this function will clear all channels of the associated
Pre or Pst patches.

FX Button

8 [Left-Clicking] the FX button on any Pre, Pst or F-Res patch window will display the FX
Choices window.

The Solo Patch List windows also includes the following button:

FOH / MON Button

8 [Left-Clicking] the FOH / MON button on the Solo patch window will swicth the list to look at
the FOH or MON Solo Bus.

6.2.3 Effects View Navigation

Scrolling

7/8 The Effects View windows may be scrolled by [Left-Dragging] the right scroll bar area, or by
pressing the [Up-Arrow] or [Down-Arrow] keys.

Selection

8 [Left-Clicking] on an Effect View entry selects and highlights it in the listbox, clearing all other
selections. [Left-Dragging] selects all entries included in the drag.

78 [Shift-Left-Clicking] on an entry selects it and all entries between it and the last selected entry.



Using Effects Views 71

© 2008 - 2010 Robert Lentini and RML Labs

[Ctrl-Left-Clicking] an entry selects and adds it to the other selected entries.

7 Using the [Up-Arrow] and [Down-Arrow] keys scrolls up and down the list selecting one entry
at a time. [Shift-Up-Arrow] maintains the originally selected entry and adds contiguous entries
one at a time moving up the list. [Shift-Down-Arrow] maintains the originally selected entry and
adds contiguous entries one at a time moving down the list.

7 The [Home] key will jump to the first entry in the list. The [End] key will jump to the last entry in
the list.

6.3 Operation

6.3.1 Effects View Editing And Control

Opening Effects View Windows

M To open an Effects View window, from the View menu, click the desired FX window. Three
views are available for effects handling:

· FX Choices
This window displays a list of all effects plug-ins installed, including SAC and SAWStudio
Native, DirectX, VST, and VSTi.

· FX Pre Patches
This window displays a list of all plug-ins patched to the Pre Fader FX patch on the current
mixer Hot Channel. This window chases the Hot Channel and updates the list.

· FX Post Patches
This window displays a list of all plug-ins patched to the Post Fader FX patch on the
currentmixer Hot Channel. This window chases the Hot Channel and updates the list.

· FX Solo Patches
This window displays a list of all plug-ins patched to the FOH or MON Solo Bus patch. The
listbox top client area displays which bus you are looking at and this can be selected by
clicking on the FOH / MON button. Note that these FX will only process whenever a solo is
active, and for about five seconds of blank buffers after the solo is released, to allow plugin
meters to decay back to infinity after the signal goes away. This design then releases any FX
cpu load when solos are not engaged.

8 [Left-Clicking] the Pre Fader or Pst Fader labels on any mixer view will display the applicable
FX patch window.

» Hint: Quickly get to the effects portion of the Zoom Mixer view by clicking on the FX hot
link in the Full Mixer view.

» Create at least one F-Key workspace view that contains the Effects View windows you
use, arranged neatly in their own space with no window overlapping. This way, you
may simply press the assigned F-Key when you need to add, remove, or otherwise
access your plug-ins.
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Patching In Plug-Ins

8 Plug-ins are patched by first selecting a plug-in from the FX Choices window and then [Left-
Clicking] the Add button of the desired patch window. Assigning a plug-in to any of the patch
windows will display a connecting patchbar on the FX portions of the Zoom, Exploded and
Wide Mixer views, and will automatically open the plug-in for adjustment.

78 [Shift-Left-Clicking] the Add button of the desired patch window will assign the selected plug-in
without opening the plug-in setup window.

8 [Left-Clicking] on the yellow FX icon on the mixer will toggle between Bypass and Normal FX
mode. Bypass is displayed as a broken patchbar.

F Plugins that cause latency by buffer size changing or witholding can not function in SAC, due
to the fact that SAC is tied to a live input data stream. These plugs will be detected and
automatically bypassed internally during the engine loop.

Re-Ordering Patches

7 Selecting any patched plug-in from any of the patch views and pressing [Ctrl-Up-Arrow] will
shift the plug-in up one position in the patch order.

7 Selecting any patched plug-in from any of the patch views and pressing [Ctrl-Down-Arrow] will
shift the plug-in down one position in the patch order.

F This procedure can be done live during active operation with no interruption in the signal flow.
Plugins are processed in the order in which they are patched.

Clearing Pre and Pst Patches

8 [Left-Clicking] the Rem button on any Pre or Pst patch window will remove the selected effect
from the current Hot Channel for the associated patch window.

[Left-Clicking] the Clr button on any Pre or Pst patch window will clear all effects from the
current Hot Channel from the associated patch window. If the current channel is one of a
group of selected channels, then all selected channels will be affected.

78 Pressing the [Ctrl] key when activating this function will clear all channels of the associated
Pre or Pst patches.

Clearing Solo Patches

8 [Left-Clicking] the Rem button on the Solo patch window will remove the selected effect from
the current Solo Bus.

[Left-Clicking] the Clr button on the Solo patch window will clear all effects from the current
Solo Bus.
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7 Using Plug-In Effects

7.1 Equalizer

Overview

This plug-in effect offers many different ways to alter the frequency content of your audio. Adjusting
the slider controls creates a somewhat-graphic representation of the overall shape of the resulting EQ
curve. Each of the seven bands has adjustments for center-frequency and bandwidth. There are also
adjustable Hi-Cut and Lo-Cut filters and a control to trim the output volume.

The Equalizer plug-in interface includes a popup menu list of all settings for each control. The
frequencies for each band include the entire range from 40 to 15k with many smaller increments in
between. The bandwidth ranges from 1/10 to 3 octaves. All parameters can be automated, except the
reset switch.

This effect is completely non-destructive and operates in real-time.

Operation

Slider Controls

The Slider Controls adjust the amount of boost or cut at the associated center frequency. The dB
representation is displayed above each control.

8 [Left-Dragging] a slider adjusts the EQ.
[Left-Right Clicking] resets any control back to zero dB.

Freq

The Freq controls adjust the center frequency for each of the seven frequency bands. The frequency
range covers the full spectrum from 40-15000 cycles, allowing complete versatility in setting
frequency combinations.

Each frequency band is a high-resolution bandpeaking filter that affects only the audio frequencies
that are near the center frequency setting and lie within the bandwidth range evenly balanced on
either side.

8 [Left-Holding] the right half of a frequency control and moving the mouse forward or backward
changes the frequency setting.

[Right-Clicking] turns the individual band on or off.

[Left-Clicking] the left half of a frequency control button displays a popup menu of all available
settings. Click the desired setting, or click anywhere outside of the menu to close it.

F The default value for this control is displayed in bold on the menu.

[Left-Right Clicking] on the right half of a control resets it to the default frequency for that
band.
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Width

The Width controls adjust the bandwidth of the frequency range affected by the filter. A smaller
bandwidth has a sharper sound and can be used to zero in tight on a specific frequency. A larger
bandwidth has a smoother sound and can be used to affect a wider range of frequencies with one
control.

8 [Left-Holding] the right half of a bandwidth control and moving the mouse forward or backward
changes the bandwidth setting.

[Left-Clicking] the left half of a bandwidth control button displays a popup menu of all available
settings. Click the desired setting, or click anywhere outside of the menu to close it.

F The default value for this control is displayed in bold on the menu.

[Left-Right Clicking] the right half of a control resets it to the default bandwidth.

Hi-Cut Filter

The Hi-Cut filter control is a shelving filter that will attenuate high frequencies above the cutoff
frequency setting. The rate of attenuation is 12 dB per octave.

8 [Left-Holding] the right half of the control and moving the mouse forward or backward changes
the filter setting.

[Right-Clicking] the control turns the filter on or off.

[Left-Clicking] the left half of the control displays a popup menu of all available settings. Click
the desired setting, or click anywhere outside of the menu to close it.

F The default value for this control is displayed in bold on the menu.

[Left-Right Clicking] the right half of the control resets it to its default setting.

Lo-Cut Filter

The Lo-Cut filter control is a shelving filter that will attenuate low frequencies below the cutoff
frequency setting. The rate of attenuation is 12 dB per octave.

8 [Left-Holding] the right half of the control and moving the mouse forward or backward changes
the filter setting.

[Right-Clicking] the control turns the filter on or off.

[Left-Clicking] the left half of the control displays a popup menu of all available settings. Click
the desired setting, or click anywhere outside of the menu to close it.

F The default value for this control is displayed in bold on the menu.

[Left-Right Clicking] the right half of the control resets it to its default setting.

Vol Trim

The Vol Trim control can be used to trim the overall volume to eliminate clipping that may occur when
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boosting or cutting frequency bands in a loud section of audio.

8 [Left-Dragging] the Vol Trim slider trims the volume. When this control is at the top, no volume
processing occurs.

Mixer - Channel Number Display

The Track Number Display shows the reference mixer and channel for the currently displayed
settings. Opening a new EQ on another track will change settings and channel reference numbers on
the same open window.

8 [Left-Clicking] the Channel Number Display shows a list of all mixer-channels that have an EQ
assigned, and allows you to select another channel to view.
There is also an Auto Tracking option at the top of the list which allows the display to change
automatically with the current Hot Chan selection in the Mixer views. This option may be saved
with the module preferences.

[Left-Click] anywhere in the Equalizer window to close the popup list box without changing
selections.

Reset

8 [Left-Clicking] the Reset button resets all EQ frequency bands to the center, flat position. This
button does not change the frequency or bandwidth settings.

Bypass

8 [Left-Clicking] the Bypass button bypasses this effect without affecting other modules patched
into this track.

Close

8 [Left-Clicking] the Close button closes the EQ window. Any settings that were made remain in
effect.

Options Icon

8 [Left-Clicking] on the blue pyramid Options icon displays a small popup menu containing the
following options:

Save Preferences
This option allow you to save preferences for the EQ module which includes the load and save file
paths, and the current EQ window position.

Load Presets
This option loads a previously saved preset file containing all adjustable settings for a specific EQ
setup. A file dialog box is displayed allowing you to select the folder and file name of the preset file
you wish to load. Equalizer preset files use the .EQ extension.

Save Presets
This option saves a preset file containing all adjustable settings for the current EQ setup. A file dialog
box is displayed allowing you to select a folder and enter a file name for the preset file you wish to
save.
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About
This option displays the About information window including current version information.

7.2 Echo/Delay

Overview

This effect creates a variety of digital delay and repeating echo effects. Individual left and right
controls are available for the Delay Time, Feedback and Strength of the delayed signals. There is
absolutely no noise and no degradation of the audio signal on repeating echoes.

The Echo/Delay plug-in interface includes a popup menu list of all settings for each control.

This effect is completely non-destructive and operates in real-time.

Operation

Left/Right Delay Time

The Delay Time setting determines the amount of time between echo repeats. Pressing the [Ctrl] key
when adjusting the left or right settings will latch both channels together.

8 [Left-Holding] the right half of the Delay Time readout area and moving the mouse forward or
backward changes the delay time by 1 millisecond (ms) increments.

[Shift-Left-Holding] doubles the speed of the changes.

[Left-Clicking] the left half of the Delay Time control displays a popup menu of available
settings in various increments. This menu also displays a reference distance in Feet or Meters
(selectable in the Blue Pyramid Options) based on the speed of sound through dry air at 68
degrees-F (20 degrees-C). Click the desired setting, or click anywhere outside of the menu to
close it.

F The default value for this control is displayed in bold on the menu.

F The DelayTime and FeedBack controls can be stereo latched when using the [Ctrl] key
and any of the control adjustment methods.

[Right-clicking] on the Delay Time setting will cause it to match the delay time value of the
opposite channel.

[Left-Right Clicking] the right half of the control resets it to its default setting.

Left/Right Tap Lights

These Lights activate Tap Mode which allows you to set Delay Time by tapping to the tempo.
Pressing the [Ctrl] key when clicking either of these lights will latch both channels together.

8 [Left-clicking] in the Tap zone between the lights twice in succession, when either light is
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active, will calculate the delay time between taps and set the active channels.

7 Pressing the [Left-Arrow], [Right-Arrow], [Up-Arrow], or [Down-Arrow] keys twice in succession
(when the Echo plugin is the active window) will calculate the delay time between taps and set
the active channels.

7 Pressing the [Space-Bar] key twice in succession (when the Echo plugin is the active window)
will calculate the delay time between taps and set the active channels.

F You can tap any combination of these keys once each for quicker response times and
the delay time will be calculated between taps.

Left/Right Feedback

The Feedback setting determines how much of the echo signal is fed back to the input. This creates
repeating echoes, spaced at the Delay Time interval, each one at a slightly lower volume than the
previous, eventually fading away to nothing. Using 0% Feedback creates a single echo of the original
sound, acting as a simple delay effect. Pressing the [Ctrl] key when adjusting the left or right settings
will latch both channels together.

8 [Left-Holding] the right half of the Feedback readout area and moving the mouse forward or
backward will change the Feedback amount by 1% increments.

[Shift-Left-Holding] doubles the speed of the change.

[Left-Clicking] the left half of the Feedback control displays a popup menu of available settings
in increments of five. Click the desired setting, or click anywhere outside of the menu to close
it.

F The default value for this control is displayed in bold on the menu.

[Right-clicking] on the Feedback setting will cause it to match the feedback value of the
opposite channel.

[Left-Right Clicking] the right half of the control resets it to its default setting.

Left/Right Strength

 Pressing the [Ctrl] key when adjusting the left or right fader will latch both channels together.

8 [Left-Dragging] the Strength setting controls the loudness of the main echo relative to the
original audio volume. It will also affect how many repeats are heard at a particular Feedback
setting.

[Right-clicking] on the Strength setting will cause it to match the feedback value of the
opposite channel.

[Left-Right Clicking] resets the control to its default setting.

Src Vol
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8 [Left-Dragging] the Src Vol control will adjust the level of the original source signal in the
output mix. Dropping the level to zero will remove the original source signal completely,
leaving only the echoes and delays.

[Left-Right Clicking] resets the control to its default setting.

Mode

8 [Left-Clicking] the Mode setting switches between Normal and Cross delay.

[Left-Holding] in the Mode readout area and moving the mouse forward or backward will also
change the setting.

Normal delay mode keeps the left and right echoes in place on their respective channels.

Cross delay mode crosses the left channel echo over to the right channel and the right channel echo
over to the left channel. With a high percentage of feedback, you can create a ping-ponging effect of
echoes bouncing back and forth between channels. With 0% feedback and a delay time of 20 to 40
ms, you can create the effect known as Cross Delay Stereo, which can give the illusion of a wider
overall stereo image from a mono signal source.

F Creating a Cross Delay Stereo effect requires that the plug-in be patched in Post Fader. The
source track must be panned to one side or the other, and the Delay Time should be set
between 20-40 ms. Set the Strength for that channel to the maximum setting and select Cross
delay mode. This should result in the mono signal being spread across the left/right stereo
image. The width of the spread can be controlled by the delay setting.

Mixer - Channel Number Display

The Channel Number Display shows the reference mixer and channel for the currently displayed
settings. Opening a new Echo/Delay on another channel will change settings and channel reference
numbers on the same open window.

8 [Left-Clicking] the Channel Number Display shows a list of all mixer-channels that have an
Echo/Delay assigned, and allows you to select another channel to view.
There is also an Auto Tracking option at the top of the list which allows the display to change
automatically with the current Hot Chan selection in any Mixer view. This option may be saved
with the module preferences.

8 [Left-Click] anywhere in the Echo/Delay window to close the popup list box without changing
selections.

Bypass

8 [Left-Clicking] the Bypass button bypasses this effect without affecting other modules patched
into this track.

Close

8 [Left-Clicking] the Close button closes the Echo/Delay window. Any settings that were made
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remain in effect.

Options Icon

8 [Left-Clicking] on the blue pyramid Options icon displays a small popup menu containing the
following options:

Save Preferences
This option allows you to save preferences for the Echo/Delay module which includes the load and
save file paths and the current Echo/Delay window position.

Load Presets
This option loads a previously saved preset file containing all adjustable settings for a specific
Echo/Delay setup. A file dialog box is displayed allowing you to select the folder and file name of the
preset file you wish to load. Echo/Delay preset files use the .EKO extension.

Save Presets
This option saves a preset file containing all adjustable settings for the current Echo/Delay setup. A
file dialog box is displayed allowing you to select a folder and enter a file name for the preset file you
wish to save.

Ms Menu Distance-Reference In Feet
This option displays the Ms distance reference in feet. This option saves with the plugin preferences.

Ms Menu Distance-Reference In Meters
This option displays the Ms distance reference in meters. This option saves with the plugin
preferences.

About
This option displays the About information window including current version information.

7.3 DirectX & VST Plug-Ins

Installed DirectX and VST plug-ins will be listed in the FX Choices listbox. DirectX plug-ins list in pink
and VST plug-ins list in Green. Only VST plug-ins that supply their own graphic interface will be listed
and usable.

I Regarding installation of VST Plug-ins: Many VST installers will ask for a destination folder.
You should choose the VST_PlugIns folder under the SAC main folder. Some of these
installers will create another subfolder inside of the chosen folder. For VST plug-ins to show
up correctly inside of SAC, they must be directly inside of the VST_PlugIns folder. If a VST
plug-in does not show up in the SAC FX Choices list, check the VST_PlugIns folder to see if a
subfolder was created and simply move the applicable plug-in .dll file(s) into the VST_PlugIns
folder directly.

Some VST Plug-In installations will hardcode or otherwise force their plug-in path to remain
intact as installed and will not allow the .dlls to be moved into the SAC VST_PlugIns folder.
SAC will allow VST Plugins to reside in any folder on any drive by placing an .ini file substitute
in the VST_Plugins folder pointing to the full path of the dll file itself. Open the Notepad (or
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any other ascii text editor) to create a new text file. Inside the file, type the full drive and path
and original .dll filename on the first line of the file. Make sure to finish the line with a carriage
return by pressing the [Enter] key to return the cursor to the start of the next line. Then save
the file as an .ini file using the same name as the plugin itself. For example, if a VST Plugin
called TestPlug.dll is installed to D:\VST\Work, then create an .ini file called TestPlug.ini
and inside the file type the line D:\VST\Work\TestPlug.dll followed by a carriage return. This
.ini file, placed in the VST_PlugIns folder under SAC, will now link SAC to find the VST plug-in
in its originally installed path. This can help solve compatibility issues with hardwired path
plug-ins and their various copy protection schemes.

I Regarding VST Plug-In Latency: Some VST plug-ins add a certain amount of latency delay
to the processed buffers depending on their processing algorithms. SAC will not allow the use
of latency causing plugins because it is designed to be a live input driven engine and buffer
size altering or witholding is not possible in a live data stream without causing a delayed
signal. SAC will attempt to detect latency causing plug-ins and automatically bypass them
keeping the live signal data stream in sync.

Operation - DirectX

FX Bypass

8 The DirectX and VST plug-in windows include an FX Bypass icon in the top left corner. [Left-
Clicking] this icon allows each effect to be individually bypassed.

Close

8 [Left-Clicking] the Close button closes the plug-in window. Any settings that were made remain
in effect.

Options Icon

Clicking on the blue pyramid Options icon (available while the engine is Live) displays a small popup
menu containing the following options:

Built-In Presets
This option opens a list of built-in presets that come with the individual plug-ins (if any).

Load SAC Presets
This option loads presets for the filter, that were previously saved with the Save SACPresets option.

Save SAC Presets
For DirectX plug-ins, this option saves presets for the filter. A folder is created under the SAC main
folder called DirectX_Presets and preset files (.dxp) are placed in separate folders for each filter
using the filter's name as a folder name.

Help
This option opens up the plug-in's HelpFile, if provided.

Operation - VST

FX Bypass
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8 The DirectX and VST plug-in windows include an FX Bypass icon in the top left corner. [Left-
Clicking] this icon allows each effect to be individually bypassed.

Close

8 [Left-Clicking] the Close button closes the plug-in window. Any settings that were made remain
in effect.

Options Icon

Clicking on the blue pyramid Options icon (available while the engine is Live) displays a small popup
menu containing the following options:

Set Midi-In Port
This option is active for VST SoftSynth plug-ins as well as VST plugins that accept midi parameter
controls only, and offers selections for all Midi-In hardware ports. The MIDI port selected becomes the
source of trigger information for the SoftSynth to create its sounds. Multiple plugins on different
channels may trigger from the same midi port allowing layering of sounds.

Assign SoftSynth Multi-Out Chans
This option displays a popup menu of synth output channel choices. The stereo / mono grouping of
the synth is displayed next to the associated pre-assigned SAC channel. The channel assignments
follow in sequence starting with the channel that the synth is patched into. The outputs are kept
inactive for performance reasons until selected on this menu. The alternate outputs of the synth are
then routed to the Pre-Fx Patch insert point on the associated channels. You must also manually
assign each of these channel input sources to the FX Source option. By altering the signal flow of the
Pre-Fx Patch insert point, you may route the synth signals directly into the console Eq and Dynamics
section for direct processing. These assignments save with the session edl and also with the SAC
presets.

Disable SoftSynth
This option allows you to completely bypass the internal routing of a VST Synth plug-in and pass
underlying audio track data through. This allows you to keep a patched synth on the track, but still
record the data as audio on the same track and ignore the patched synth, while still keeping it in the
edl with all its settings in case you need to make changes and re-record again. When this option is
active, a large Red X displays across the Blue Pyramid Options Icon. This option saves with the
session edl.

Built-In Presets
This option opens a list of built-in presets that come with the individual plug-ins (if any).

Load SAC Presets
This option loads presets for the filter, that were previously saved with the Save SAC Presets option.

Save SAC Presets
For VST plug-ins, this option saves presets for the plug-in. A folder is created under the SAC main
folder called VST_Presets and preset files (.vsp files) are placed in separate folders for each plug-in
using the plug-in's name as a folder name.

Cancel 'Always On Top' Status
This option cancels the On Top status of the window, allowing misbehaved dialog boxes on some
VST plug-ins to display on top of the plug-in window. This option will remain set even when the
window is hidden. The option will be cleared when the plug-in is unpatched. This option saves with
the session edl.
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VST Virtual Instruments and SoftSynth Plug-Ins

The VST implementation is designed to handle VST Virtual Instruments and SoftSynth plug-ins. If the
plug-in is a synth, you must select a MIDI port from the Options icon menu as the source for the plug-
in to generate sound.

The sound will only be generated while the engine is running.

8 Using The Scenes View

8.1 Overview

8.1.1 Scenes View Overview

The Scenes View window displays all Scenes that have been created as part of the current session.
Scenes are snapshots of all 25 mixer settings and can be used to instantly recall the consoles to a
preset state. Each scene contains a powerful properties dialog that can control exactly what settings
are affected when the scene is recalled. You can activate or de-activate individual controls and
module sections, as well as control which channels and mixers will be affected.You can also set a
fade time for the scene in milliseconds and also select whether switches react first or last when a fade
is active.

A Scene also saves and recalls the patched plugins and plugin settings for each chan on each mixer.
If the plugin patch list stays the same within a mixer channel from scene to scene, the plugin patches
will not be altered and only the plugin settings will be saved and recalled. If the plugin patches on a
channel are different from scene to scene, the patch list will be cleared and the new plugin patches
will be recalled. Therefore, you can actually have a scene add or remove plugin patches from any
mixer channel, as well as only alter plugin settings. The appropriate FX Pre and FX Pst options in the
Scene Properties window must be active for the Plugins to be affected by the scene recall.

Mixer channel re-ordering and channel labels can also be saved and recalled with a scene. The Mixer
Channel re-ordering option operates on all channels within a specific mixer, so the Mixer properties
must be active for the desired mixers to be affected. This can be very useful for doing festival type
jobs where there is more than one band setup. Now each band can have a starting scene that can
reset everything, including new chan labels and chan re-ordering setups without having to stop the
engine and load a new session file. If you are not using these features in a particular scene, turn off
these scene properties options to improve scene recall performance.

The title bar of this window always displays the current Scene count. There is no built in limit to the
number of Scenes one session can handle, only the limitation of your RAM.

8.2 Interface

8.2.1 Scenes View Top-Client Area

Options Icon

8 [Left-Clicking] the blue pyramid Options Icon opens a popup menu of various options.
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Auto Advance After Recall

This option automatically advances to the next scene entry after a scene recall operation…
perfect for stepping through a series of scenes in a show lineup, and can be saved with the
preferences.

Disable SpaceBar Scene Recall

This option will disable the spacebar from activating a scene recall, and can be saved with the
preferences.

Rename Current Scene

This option allows you to rename an existing scene and it will handle the details in the
background by copying the scene file  to a new one with the new name and altering the name in
the listbox. This method allows other sessions linked to the old scene file to still operate
correctly. You must save and update the session to retain the scene listbox changes and the
new scene file links..

Import Scene To Current Session

This option will copy a scene file from another folder into the current session Scenes folder and
add the scene into the current session scene list. If there is a scene name conflict in the list,
you must change the name. If there is a duplicated scene file name already in the current scene
folder, you will be given the option to adjust the name or keep it as is. In the latter case, the
current scene file will be used and the new scene added to the list. This allows you to link in
scenes from different mix session spinoffs within the same folder.

New Button

8 [Left-Clicking] the New button allows you to create a new Scene which takes a snapshot of the
current state of all 25 mixers. A name dialog window is displayed so you can name the Scene.
You must first be in an active Mix Session before you can create Scenes, since the Scenes
are files that are placed in a \Scenes folder under the project folder.  Scene names must also
be legal filenames with only numbers, letters, spaces, underscores, hyphens and a few other
specific punctuation characters allowed. Entering a new scene filename that contains illegal
characters will flag you with a message listing all legal characters you can use and then allow
you to re-enter the name, or cancel.

F You should always create a new folder for each project and place the session files in that
folder. This will keep the \Scenes folder unique to that project and prevent corruption between
projects with the same scene names.

F You can create partial scenes which will overlay only selected channels on selected mixers
and not disturb other mixers and channels when recalled. To create a partial scene, first select
only the channels on whichever mixers you want to be altered when the scene is recalled, and
then create the new scene or update an existing one.

F Each time a scene is created or altered, the scene properties dialog will display that allows
you to set which controls, channels and switches are active within a scene and which mixers
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will be affected. You can also set a fade time for the scene in milliseconds and also select
whether switches react first or last when a fade is active. Fades require the engine to be live
since they use the sample-clock for timing. The display will also show you the channel list of
the scene's active channels. You can see and adjust these options by [Right-Clicking] on a
scene in the Scene View window also. Once in the dialog you can click OK or use the Enter
key to exit and save the changes or click Cancel or use the ESC key to exit and cancel any
changes.

Updt Button

8 [Left-Clicking] the Updt button allows you to update an existing Scene. The selected Scene is
overwritten with the current state of all 25 mixers. You will be asked whether you want to
update the partial channel info or not. If you elect to do so, the current selected chans will be
used to change the original channel selection. You will still have the option inside the
Properties Dialog window to alter the partial channel info again before saving the the updated
properties.

F Each time a scene is created or altered, the scene properties dialog will display that allows
you to set which controls, channels and switches are active within a scene and which mixers
will be affected. You can also set a fade time for the scene in milliseconds and also select
whether switches react first or last when a fade is active. Fades require the engine to be live
since they use the sample-clock for timing. The display will also show you the channel list of
the scene's active channels. You can see and adjust these options by [Right-Clicking] on a
scene in the Scene View window also. Once in the dialog you can click OK or use the Enter
key to exit and save the changes or click Cancel or use the ESC key to exit and cancel any
changes.

Del Button

8 [Left-Clicking] the Del button allows you to delete an existing Scene. The selected Scene is
removed from the Scenes listbox. The actual file is not deleted from the \Scenes folder in case
other spinoff Mix Sessions are also using this Scene.

Clr Button

8 [Left-Clicking] the Clr button allows you to delete all existing Scenes. All Scenes are removed
from the Scenes listbox. The actual files are not deleted from the \Scenes folder in case other
spinoff Mix Sessions are also using any of these Scenes.

Recall Button

8 [Left-Clicking] the Recall button allows you to recall a Scene. Using the [Alt] key with the
Recall button will cancel any fade action that is part of the scene properties. Using the [Ctrl]
key with the Recall button will overide the Select Partial Chans property and force the
selection of partial scene channels as a temporary group.
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8.2.2 Scenes View Navigation - Scenes List Area

Scrolling

7/8 The Scenes List may be scrolled by [Left-Dragging] the right scroll bar area, or by pressing the
[Up-Arrow] or [Down-Arrow] keys.

Scene Selection In The Listbox

78 [Left-Clicking] on a Scene selects and highlights it in the listbox.

7 Using the [Up-Arrow] and [Down-Arrow] keys scrolls up and down the list selecting one Scene
at a time.

7 The [Home] key will jump to the first Scene in the list. The [End] key will jump to the last Scene
in the list.

Recalling Scenes

8 [Double-Clicking] any Scene in the listbox will instantly recall the scene and alter the settings
of all 25 mixers according to the scene properties.

7 Pressing the [SpaceBar] will instantly recall the scene and alter the settings of all 25 mixers
according to the scene properties.

F Pressing the [Alt] key when recalling a scene will cancel any fade action that is part of the
scene properties .

F Pressing the [Ctrl] key when recalling a scene will overide the Select Partial Chans property
and force the selection of partial scene channels as a temporary group.

Changing Scene Properties

8 [Right-Clicking] any Scene in the listbox will display the scene properties dialog and allow you
to alter what controls, channels and mixers are affected in the scene, as well as adjust fade
times and switch channel group selection options.

7 Pressing the [Enter] key will also display the scene properties dialog of the seleceted scene
and allow you to alter what controls, channels and mixers are affected in the scene, as well as
adjust fade times and switch channel group selection options.

The Scene Properties dialog displays many options that control how the scene will recall. In
the center area you will see many lighted switches that allow you to select the various controls
on the three module types. The Input Channel switches on the left, the Return Channel
switches next and the Output Channel switches next. On the right side you will find the mixer
selection switches.

The Select All / Clear All buttons operate on each of the sections independently. Any switch
that is lighted will become an active recall element. Any switch not lit will be ignored during a
recall. The individual mixer switches must also be lighted or that mixer will be ignored during
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the recall.

In the top left corner is a list box which displays the current channel information. If it reads
ALL, then all channels are active during the recall. If it reads PARTIAL, then only the channels
listed within the dropdown listbox will be affected during the recall. When the Properties dialog
opens, all partial channels will be selected in the mixer views, showing which channels are
actively engaged for the scene. You can clear the selected channels in any mixer view and re-
select new ones on the different mixers and then [Left-Click] the Update Channels button to
change the partial information. If no selected channels exist, the channels listbox will be set to
ALL. Individual channels must be selected on each mixer that you expect to be affected during
the recall, and the individual mixer switch must also be lighted for recall activity to occur on
that mixer.

In the top center area are two options which control how fast the scene recalls fader and
variable control data. The Fade ms readout allows you to enter fade times in ms (1000 ms = 1
second) which will automate crossfades for each variable type control from the current value
to the new value when the scene is recalled. The Switches First switch will determine
whether switches (like mutes) are activated first, before the fade occurs, or after the fade is
complete.

The next top option, Select Partial Chans, if lighted, will select the channels that are active
into a temporary group when the scene is recalled, thereby allowing you to create unlimited
special group combinations with scene recalls that then allow you to control multiple selected
channels of controls using any one channel as the master.

In the bottom center area you will find an option that allows Mixer Chan Order to be altered
with scene recalls. This option works hand in hand with the mixer selection switches. Channel
re-ordering is global for each individual mixer and the corresponding mixer switch must be
lighted for that mixer to be affected.

When finished adjusting all settings, you can [Left-Click] the OK button to save and exit the
dialog, or [Left-Click] the Cancel button to exit without altering any settings.

F Fades require the engine to be live since they use the sample-clock for timing. Make sure to
also set the Switches First option on or off depending on whether you want the switches to
operate before or after the fade.

F It is suggested that you select only the channels of interest and only the switch options that
you desire to be recalled for each scene. For example, if you want a scene to mute four input
vocal channels on the FOH mixer, make sure to set the partial chan info to those exact four
channels and clear all other switch lights except the Input chan mute switch, and clear all
mixer switches except only the FOH switch. Create scenes that operate in small chunks on
specific controls of specific channels.

F When using scenes, it is also a good idea to create a Starting Scene with everything selected
to instantly return the consoles to a specific starting condition. It may be a good idea to create
a starting scene for each song in a set list, for example. You may also find a starting scene for
each monitor mixer useful to bring the individual monitors back to a starting condition even
after they have been adjusted during a performance. It can also be useful to create an ending
scene which you can update at the end of the show. The scene properties can then be
adjusted at a later time to recall specific control settings from individual channels and mixers
that you may decide to keep permantly in the main show scenes. For instance, perhaps you
made adjustments to the Guitar channel eq throughout the show and decided that the eq you
ended up with is better than the original eq you had saved in the starting scene. You can
adjust the ending scene properties to activate only the guitar channel and only the eq section
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and then recall that scene over top the starting scene. Now by updating the starting scene, the
ending guitar eq will become part of the original scene.

Moving Scenes Within The List

7 Pressing [Ctrl-Up Arrow] or [Ctrl-Down Arrow] will move the scene position up or down in the
listbox, allowing you to group the scenes in any order you desire. It can be useful to create
blank scenes that take no action (everything off in the scene properties) and use them as title
separators between scene groups. Name them with dashes or stars and a label, for example "-
- - - - Mute Groups - - - - -".

8.3 Operation

8.3.1 Scenes View Editing And Control

Creating Scenes

M To create a new Scene, make any adjustments to the mixers controls and signal routing you
desire, then [Left-Click] the New button on the Scenes View Top Client Area. A name dialog
window is displayed so you can name the Scene. You must first be in an active Mix Session
before you can create Scenes, since the Scenes are files that are placed in a \Scenes folder
under the project folder.  Scene names must also be legal filenames with only numbers,
letters, spaces, underscores, hyphens and a few other specific punctuation characters
allowed. Entering a new scene filename that contains illegal characters will flag you with a
message listing all legal characters you can use and then allow you to re-enter the name, or
cancel.

F You should always create a new folder for each project and place the session files in that
folder. This will keep the \Scenes folder unique to that project and prevent corruption between
projects with the same scene names.

F You can create partial scenes which will overlay only selected channels on selected mixers
and not disturb other mixers and channels when recalled. To create a partial scene, first select
only the channels on whichever mixers you want to be altered when the scene is recalled, and
then create the new scene or update an existing one.

F Each time a scene is created or altered, the scene properties dialog will display that allows
you to set which controls, channels and switches are active within a scene and which mixers
will be affected. You can also set a fade time for the scene in milliseconds and also select
whether switches react first or last when a fade is active. Fades require the engine to be live
since they use the sample-clock for timing. The display will also show you the channel list of
the scene's active channels. You can see and adjust these options by [Right-Clicking] on a
scene in the Scene View window also. Once in the dialog you can click OK or use the Enter
key to exit and save the changes or click Cancel or use the ESC key to exit and cancel any
changes.

Updating Scenes

8 To update an existing Scene, recall the scene you wish to update and make whatever
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changes to the mixer settings you desire, then [Left-Click] the Updt button. You will be given
the option to overwrite the current partial channel information already in the scene with the
current channel selection status, or keep the original partial channel information intact. If you
answer NO, the current partial channels will be automatically selected for you and the scene
update will maintain that info as is. If you answer YES, the current selected channel status will
be used to overwrite the current scene partial information. The selected Scene is overwritten
with the current state of all 25 mixers. The Scene Properties dialog will display so you can
make adjustments if needed. Remember that the recall of the scene will follow the selections
in the Scene Properties dialog and only recall the selected items, even though the scene
snapshots all settings for all 25 mixers.

Deleting Scenes

8 To delete a Scene, select the Scene you wish to delete in the listbox and [Left-Click] the Del
button. The selected Scene is removed from the Scenes listbox. The actual file is not deleted
from the \Scenes folder in case other spinoff Mix Sessions are also using this Scene.

Clearing All Scenes

8 To clear all Scenes from the listbox, [Left-Click] the Clr button. All Scenes are removed from
the Scenes listbox. The actual files are not deleted from the \Scenes folder in case other
spinoff Mix Sessions are also using any of these Scenes.

Recalling Scenes

8 [Double-Click] any Scene in the listbox to instantly recall the scene and alter the settings of all
25 mixers according to the scene properties.

7 Press the [SpaceBar] to instantly recall the scene and alter the settings of all 25 mixers
according to the scene properties.

F Pressing the [Alt] key when recalling a scene will cancel any fade action that is part of the
scene properties .

F Pressing the [Ctrl] key when recalling a scene will overide the Select Partial Chans property
and force the selection of partial scene channels as a temporary group.

9 Using TCP/IP Master/Slave/Remote Mode

9.1 Using the TCP/IP Options

The TCP/IP functions offer a powerful way to link multiple SAC workstations for the purpose of
controlling a Master machine from multiple remote locations. A simple Ethernet 100 base-T or higher
speed wired network or G or higher speed wireless network running the TCP/IP protocol is all that's
needed. One machine is designated as the Host/Master machine, and up to twenty-eight additional
machines may be connected as Remotes using the SACRemote program which is available as a free
download on the www.SoftwareAudioConsole.com website.



Using TCP/IP Master/Slave/Remote Mode 89

© 2008 - 2010 Robert Lentini and RML Labs

The SACRemote program can be freely distributed and installed on desktop or laptop computers to
be used as FOH, MON or Personal Monitor remote control stations for a Host/Master SAC system.
The SACRemote version has no audio engine or hosting abilities and requires connection to a SAC
Host/Master system to be functional, although all other interface functions remain the same and it is
also a perfect way to learn the basic SAC interface and create session templates and scenes while

run in stand-alone mode to be later imported into the main SAC sessions. The SACRemote system
does not require any audio interface cards. The remote pulls settings and metering data from the host

system once a connection is made.

A Remote machine operates directly on the Master machine session, and does not keep its own
session copy locally. It also does not utilize its own audio device, as the Master machine is the only
machine generating audio output. The Remote machine can be used as a sophisticated remote
control device, operating the Master machine from a separate location.

Each computer connected to the system will be assigned a particular User-Rights status. The options
are FOH, MON, MON-FOH, PER-MON-x (Personal Monitor Mixer 1-24) and NO ACCESS. If a remote
computer has NO ACCESS as its setting, all windows will be disabled. The computer will see signal
meters but will have no control of the mixers and other windows. All remote computers start out with
NO ACCESS status until the Host/Master computer sets the user rights in the TCP/IP Computer User-
Rights List option. Remote computers with PER-MON-x (Personal Monitor) access rights can not start
and stop the host live engine.

All connected remote computers should have read and write access to all drives and folders which
SAC will be using, or remote file operations will be limited. You should also be signed on to the
network and have entered any required passwords in Windows before attempting to connect within
SAC. You should verify that you can copy and paste files from and to the host computer in the
Windows explorer before attempting the SAC connection.

Different User-Rights computers will remain independent of each other on the system. FOH users will
have access to all mixers and can maintain a separate solo bus from the rest. MON users will have
access to all monitor mixers 1-24 and also maintain a separate solo bus from the rest. MON-FOH
users will operate as MON users but also have access to the FOH mixer. Personal Monitor users will
only have access to their 1 monitor mixer and will maintain a special in place solo mode that drops
the level of all non-soloed channels 12 db while featuring the soloed channels at normal level in their
own output device.

Independent remote users will maintain their own screen displays, F-Key views and independent midi
controllers and not interfere with what other users are seeing. Users with duplicate User-Rights will
see certain operations duplicate on their machines if they happen to be looking at the same mixer as
changes are made from multiple locations. Scene selections remain independent on different
machines with different access rights. The host computer will echo certain commands through to all
machines of similar access rights.

All TCP/IP options will save with the Preferences, including the current Host or Remote mode option.
This allows the program to automatically startup and immediately activate Host or Remote mode as a
default.

9.2 Activating TCP/IP as Host/Master

M From the Options menu on the main SAC machine, select Activate TCP/IP Host/Master Mode
to allow the program to operate as the Host/Master machine across a standard Ethernet
network. Activating this option displays the Host/Master signature on the main window title bar
and allows the program to accept up to twenty-eight Remote machine connections .
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F The main program title bar will display the Host User-Rights, IP address, computer name, and
the Host/Master mode icon. When a system is active as a Host/Master, you may [Left-Click] on
the Host/Master icon on the main titlebar to display a list of connected remote computers and
their user-rights.

F Each computer connected to the system will be assigned a particular User-Rights status. The
options are FOH, MON, MON-FOH, PER-MON-x (Personal Monitor Mixer 1-24) and NO
ACCESS. If a remote computer has NO ACCESS as its setting, all windows will be disabled.
The computer will see signal meters but will have no control of the mixers and other windows.
All remote computers start out with NO ACCESS status until the Host/Master computer sets
the user rights in the TCP/IP Computer User-Rights List option.

F All connected remote computers should have read and write access to all drives and folders
which SAC will be using, or remote file operations will be limited. You should also be signed on
to the network and have entered any required passwords in Windows before attempting to
connect within SAC. You should verify that you can copy and paste files from and to the host
computer in the Windows explorer before attempting the SAC connection.

9.3 Activating TCP/IP as Remote

To connect as a remote into the main SAC system host, you use the SACRemote program on the
remote machine. This program is free to all and available as a download on the SAC site at
www.SoftwareAudioConsole.com. This program can be freely distributed and installed on desktop or
laptop computers to be used as FOH, MON, MON-FOH or PER-MON-x (Personal Monitor) remote
control stations for a Host/Master SAC system. The SACRemote version has no audio engine or
hosting abilities and requires connection to a SAC Host/Master system to be functional, although all
other interface functions remain the same and it is also a perfect way to learn the basic SAC interface
and create session templates and scenes while run in stand-alone mode to be later imported into the

main SAC sessions. The SACRemote system does not require any audio interface cards  of its own.

The remote pulls settings and metering data from the host system once a connection is made.

M From the Options menu of the SACRemote program, select Activate TCP/IP Remote Mode to
allow the program to operate as a Remote machine that can control another machine running
SAC as the Host/Master. The Remote machine will link and synchronize to the Master
machine when a connection is established. The Host/Master mode must first be activated on
the host machine.

F The main program title bar will display the Remote User-Rights, computer name and Remote
ID number icon. [Left-clicking] on the ID number zone displays a popup menu with one option
allowing you to refresh the Remote machine to re-sync it's data display to the Master in case
unsupported session changes on the Master machine have occurred. Remote computers with
Personal Monitor access rights can not start and stop the host live engine.

F Remotes can make the host connection and synchronize mix data with no sharing necessary.
This special feature serves the data from the host to the remotes, bypassing Windows file
access rights. But… be careful with no sharing access, since you will now not have access to
the host drives for saving session files AS something new in a new folder. Save AS and Save
Copy AS will now force you to the remote local drive since it can not access the host drive
without proper sharing rights. Certain Scene updates and other file based operations will not
be functional on the remote and be limited to the Host computer. It is still recommended that
you share all drives on both the host and remote machines.
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Remote connections can also be made across the internet. To connect across the internet you
just need to forward the port SAC uses in your internet firewall router box to the host machine
IP address. Sharing issues mentioned above apply also across the internet because you do
not normally have access rights to see the host drive directly, unless special adjustments are
made to the firewall router box to allow full drive and folder sharing across the internet.

.

Opening Sessions on a Remote Machine

When a link is first established the Remote will attempt to synchronize all session data from the
Master machine across the network. You will then be able to operate the Master machine from the
Remote machine, controlling the consoles remotely.

Remote Control over a Network

The Remote machine does not use its audio device, it does not even need one installed. Audio only
plays on the Master machine. The Remote machine acts truly as a sophisticated remote interface.
When you save the session, you are saving the Master session as if you were working on the Master
machine. Scene recalls can be done from the remote without sharing access rights, but scene
creation and updates and other file based operations will be limited to the host only, unless all drives
and folders being used are shared between the machines.

Remote Control of Plugins over a Network

Remote control of native plugins can be done for plugins that are SAC network protocol aware. Check
for plugin updates as they become available. The plugins must be installed on both the Host and
Remote machines.

When the remote connects, the FX Choices view will list all plugins installed on the Host machine and
gray-out plugins which do not have a remote local version installed. All plugin choices can be added,
re-ordered and removed using the remote, but only plugins which are not grayed-out will be available
to display and adjust controls and settings. Plugins that are coded completely for remote access will
operate and update live on both the remote and the host when adjusted from either side, and will also
display live meter data on the remote.

Remote control of VST and DirectX plugins can also be done, but there are certain limitations when
using these plugin types since the plugins themselves are not directly aware of the SAC network
control protocols. The plugins must be installed on both the Host and Remote machines. Meters will
not be functional on the remote. Controls can be changed on the remote and then must be updated to
the host by Right-Clicking on the blue pyramid Options icon at the top of the plugin window. If plugin
changes are made directly on the host, they will only be visible and properly updated on the remote
by closing the plugin and re-opening it on the remote, or simply opening the plugin if it is previously
closed.

9.4 Selecting a TCP/IP Port

M From the Options menu, select the TCP/IP Port option to enter the network port to be used for
network communications. The Master and Remote machines must use the same port. There is
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a list of possible available ports in the dialog for setting this value.

F When using SAWStudio in the background on the SAC host and remote machines, you must
set SAWStudio to a different port if SAWStudio remote control is also desired.

9.5 Selecting a Network Computer Name

M From the Options menu in the SACRemote program, select the TCP/IP Host Computer
Name/Address option to enter the network computer name or TCP/IP address for the
Host/Master machine you wish to connect with. This option is only used for the Remote
machines.

10 Using MIDI Controller Devices

10.1 Using MIDI Controller Devices

Various MIDI controller devices can be used to control many of SACs mixing and editing operations
through the use of MIDI-Control Templates. A template contains the MIDI commands and function
hooks for different MIDI controller devices. Each device functions uniquely within the SAC
environment based on its capabilities and the complexity of the template.

F The current templates have all been carried over from the SAWStudio interface. These will be
adjusted in the future to be specific for SAC.

èSetting up a MIDI Controller Device:

1. From the Options menu, select Midi Device Setup and choose a control input and output port for
your computer MIDI interface and click OK.

2. Connect your MIDI controller device to the selected input and output ports.
3. From the File menu, select Midi-Control Template File and click Open.
4. Select the applicable MIDI-Control Template from the dialog box and click Open.
5. From the Smpte/Midi menu, select Midi-Control In Active and Midi-Control Out Active.

The communication between SAC and your MIDI device is now established. This connection can be
saved with the default preferences to automatically be reestablished each time you run SAC.

Below is a list of operational details for the currently supported devices.

Quick jump links:
Behringer BCF2000
Mackie Control Surface
Mackie Baby HUI Control Surface
CMA MotorMix Control Surface
Frontier Design TranzPort
Frontier Design AlphaTrack
Fostex VM200 Mixer
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General MIDI Controller
Korg 168RC Mixer
Panasonic WR-DA7 Mixer
Sony DMX-R100 Mixer
Soundcraft Spirit 328 Mixer
Tascam TM-D1000 Mixer
Yamaha ProMix-01 Mixer
Yamaha ProMix-01V Mixer
Yamaha 03D Mixer

Behringer BCF2000(Top)

The Behringer BCF2000 is one of the most directly functional Templates for use with SAC. The
BCF2000 template gives you control of the 8 faders, in high resolution mode, as well as mutes, solos
and pans. The top 2 buttons in the bottom right corner of the unit can be used to bank switch up or
down, and the bottom 2 buttons of that group can be used to jump forward or backward to console
sections (I, R, O).

To use the BCF2000 Template, you must first download the sysex file of all the presets into the
BCF2000 unit. You can dump this file with any midi sysex dump utility program like Midi-Ox, or
something similar. Save this to a single preset in the unit. Make sure that preset is the selected preset
on the unit. Set the unit to USB-1 mode if using usb connection, or Stand-Alone-4 mode if using midi.

Multiple BCF2000 units may be used up to 4 units for a total of 32 faders. To do this, you must
download each of the respective sysex files to the 4 units and make sure you label them somehow to
connect them in the proper order from 1 thru 4.

Connecting multiple units is done as follows:

Unit 1: USB-4 mode; Out A to Unit 2 In

Unit 2: Stand-Alone 4 mode; Out B to Unit 3 In; Out A back to Unit 1 In if only 2 units, otherwise Out
A to a Midi Merge box In

Unit 3: Stand-Alone 4 mode; Out B to Unit 4 In; Out A to the Midi Merge box In

Unit 4: Stand-Alone 4 mode; Out A to the Midi Merge box In

The Midi Merge box Out must be connected back to Unit 1 In.

With the use of a Midi Merge box for more than 2 units, you may experience fader glitching and odd
behaviour if grabbing more than one fader at the same time across separate units. This can be
caused by the merge not keeping individual NRPN data strings together from each unit. This can be
solved with the use of some virtual mergers, like MidiOX - Midi Yoke, which give you the option to
lock NRPN strings together, keeping the full data packet from being interrupted midstream.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input, Return and Output channels.

Pans Control mixer pans.

Mutes Control mixer mutes.
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Top Buttons In Bot Right Bank Switch up or down.

Bot Buttons In Bot Right Jump To Next Console Section (I, R, O).

Mackie Control Surface  (Top)
The Mackie Control is a very flexible controller surface. The right side of the device can utilize
overlays customized for different application programs. You may obtain a SAWStudio overlay from
Mackie if one was not included with your controller. You may also download the .pdf version at
www.sawstudio.com/downloads.htm as a reference. The button labels referenced in this section refer
to the labels on the overlay - not the default labels on the controller.

The Mackie Control LCD display is used to show parameter and channel labels in the various
selection modes. Pan mode is used as the default mode to display channel numbers or labels for the
current bank as well as signal level meters.

This template defines three special modifier buttons which extend the functionality of many of the
controls and other buttons. They are designated as the Shift, Ctrl, and Alt buttons. Pressing and
releasing one of these buttons engages it's mode, indicated with it's associated flashing light.
Pressing the button again will disengage the mode. Any combination of modes may be simultaneously
engaged. Pressing the Cancel button disengages all active modes.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F The Mackie Control uses multiple MIDI channels and requires it's own MIDI port.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input, Return, and Output channels

based on channel and bank select switches.
Ÿ Ctrl mode: Touching a fader returns it to it's default 0 dB position.

Master Fader Controls Output channel 1 at all times.
Ÿ Ctrl mode: Touching the master fader returns it to it's default 0 dB position.

Mute Buttons Control mixer mutes.

Solo Buttons Control mixer solos.
Ÿ Ctrl mode: Turning off any Solo button clears all active solo buttons.

Select Buttons Control mixer Hot Chan selection within the active bank of eight faders.

Signal Lights Display when active audio data is present.

Channel Left/Right Buttons Increment and decrement mixer Hot Track selection, scrolling the active bank
one channel left or right.

Bank Left/Right Buttons Increment and decrement mixer Hot Track selection, scrolling the active bank
eight channels at a time left or right.
Ÿ Shift mode: Pressing either Bank button selects Return Track 1 as the Hot
Track, and updates the active bank.
Ÿ Ctrl mode: Pressing the left Bank button selects Input Track 1 as the Hot
Track, and updates the active bank.
Pressing the right Bank button selects Output Track 1 as the Hot Track, and
updates the active bank.

Flip Button Updates the active bank, aligning the first controller channel to match the
current SAC Hot Chan.

http://www.sawstudio.com/Downloads.htm#Overlay
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I/O Assignment Button Selects I/O mode.

(I/O Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Attenuation Level.
Rotary Param Knob 1 (push) Sets the mixer Attenuation Level to its default setting.
Rotary Param Knob 2 (push) Controls the mixer Phase switch.
Rotary Param Knob 3 (push) Controls the mixer L/R Swap switch.
Rotary Param Knob 4 (turn) Controls the mixer Mono mode selection.
Rotary Param Knob 4 (push) Sets the mixer Mono mode to its default setting.
Pan Assignment Button Selects Pan mode.

The LCD top row displays the channel numbers or labels. The LCD bottom
row displays the Pan values.
Pressing the button again changes the LCD bottom row to level meter
displays.

(Pan Mode)
Rotary Param Knobs 1-8 Control the associated mixer channel pan.
Sends Assignment Button Selects Aux Send mode.

The LCD top row displays the Param labels. The LCD bottom row displays the
Param values.
Pressing the button repeatedly cycles through the various Aux Send sub
modes.

(Aux Send-1 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Aux-1 Level.
Rotary Param Knob 1 (push) Sets the mixer Aux-1 Level to its default setting.
Rotary Param Knob 2  (turn) Controls the mixer Aux-1 Pan.
Rotary Param Knob 2  (push) Sets the mixer Aux-1 Pan to its default setting.
Rotary Param Knob 3 (push) Controls the mixer Aux-1 In switch.
Rotary Param Knob 4 (push) Controls the mixer Aux-1 Pst-Fader switch.

(Aux Send-2 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Aux-2 Level.
Rotary Param Knob 1 (push) Sets the mixer Aux-2 Level to its default setting.
Rotary Param Knob 2  (turn) Controls the mixer Aux-2 Pan.
Rotary Param Knob 2  (push) Sets the mixer Aux-2 Pan to its default setting.
Rotary Param Knob 3 (push) Controls the mixer Aux-2 In switch.
Rotary Param Knob 4 (push) Controls the mixer Aux-2 Pst-Fader switch.

(Aux Send-3 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Aux-3 Level.
Rotary Param Knob 1 (push) Sets the mixer Aux-3 Level to its default setting.
Rotary Param Knob 2  (turn) Controls the mixer Aux-3 Pan.
Rotary Param Knob 2  (push) Sets the mixer Aux-3 Pan to its default setting.
Rotary Param Knob 3 (push) Controls the mixer Aux-3 In switch.
Rotary Param Knob 4 (push) Controls the mixer Aux-3 Pst-Fader switch.

(Aux Send-4 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Aux-4 Level.
Rotary Param Knob 1 (push) Sets the mixer Aux-4 Level to its default setting.
Rotary Param Knob 2  (turn) Controls the mixer Aux-4 Pan.
Rotary Param Knob 2  (push) Sets the mixer Aux-4 Pan to its default setting.
Rotary Param Knob 3 (push) Controls the mixer Aux-4 In switch.
Rotary Param Knob 4 (push) Controls the mixer Aux-4 Pst-Fader switch.

(Aux Send-5 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Aux-5 Level.
Rotary Param Knob 1 (push) Sets the mixer Aux-5 Level to its default setting.
Rotary Param Knob 2  (turn) Controls the mixer Aux-5 Pan.
Rotary Param Knob 2  (push) Sets the mixer Aux-5 Pan to its default setting.
Rotary Param Knob 3 (push) Controls the mixer Aux-5 In switch.
Rotary Param Knob 4 (push) Controls the mixer Aux-5 Pst-Fader switch.
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(Aux Send-6 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Aux-6 Level.
Rotary Param Knob 1 (push) Sets the mixer Aux-6 Level to its default setting.
Rotary Param Knob 2  (turn) Controls the mixer Aux-6 Pan.
Rotary Param Knob 2  (push) Sets the mixer Aux-6 Pan to its default setting.
Rotary Param Knob 3 (push) Controls the mixer Aux-6 In switch.
Rotary Param Knob 4 (push) Controls the mixer Aux-6 Pst-Fader switch.

Dyn Assignment Button Selects Dynamics mode.
The LCD top row displays the Param labels. The LCD bottom row displays the
Param values.
Pressing the button repeatedly cycles through the various Dynamics sub
modes.

(Dyn Comp Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Comp Attack.
Rotary Param Knob 1 (push) Sets the mixer Comp Attack to its default setting.
Rotary Param Knob 2 (turn) Controls the mixer Comp Release.
Rotary Param Knob 2 (push) Sets the mixer Comp Release to its default setting.
Rotary Param Knob 3 (turn) Controls the mixer Comp Ratio.
Rotary Param Knob 3 (push) Sets the mixer Comp Ratio to its default setting.
Rotary Param Knob 4 (turn) Controls the mixer Comp Threshold.
Rotary Param Knob 4 (push) Sets the mixer Comp Threshold to its default setting.
Rotary Param Knob 5 (push) Controls the mixer Comp On switch.

(Dyn Gate Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Gate Attack.
Rotary Param Knob 1 (push) Sets the mixer Gate Attack to its default setting.
Rotary Param Knob 2 (turn) Controls the mixer Gate Release.
Rotary Param Knob 2 (push) Sets the mixer Gate Release to its default setting.
Rotary Param Knob 3 (turn) Controls the mixer Gate Floor.
Rotary Param Knob 3 (push) Sets the mixer Gate Floor to its default setting.
Rotary Param Knob 4 (turn) Controls the mixer Gate Threshold.
Rotary Param Knob 4 (push) Sets the mixer Gate Threshold to its default setting.
Rotary Param Knob 5 (push) Controls the mixer Gate On switch.
Rotary Param Knob 6 (push) Controls the mixer Gate Reverse switch.

(Dyn Key Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer Dyn Key selection.
Rotary Param Knob 1 (push) Sets the mixer Dyn Key to its default setting.
Rotary Param Knob 2 (turn) Controls the mixer Dyn Key Low EQ.
Rotary Param Knob 2 (push) Sets the mixer Dyn Key Low EQ to its default setting.
Rotary Param Knob 3 (turn) Controls the mixer Dyn Key High EQ.
Rotary Param Knob 3 (push) Sets the mixer Dyn Key High EQ to its default setting.
Rotary Param Knob 4 (push) Controls the mixer Dyn Key Listen switch.
EQ Assignment Button Selects EQ mode.

The LCD top row displays the Param labels. The LCD bottom row displays the
Param values.
Pressing the button repeatedly cycles through the various EQ sub modes.

(EQ Gain Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer EQ Band-1 Gain.
Rotary Param Knob 1 (push) Sets the mixer EQ Band-1 Gain to its default setting.
Rotary Param Knob 2 (turn) Controls the mixer EQ Band-2 Gain.
Rotary Param Knob 2 (push) Sets the mixer EQ Band-2 Gain to its default setting.
Rotary Param Knob 3 (turn) Controls the mixer EQ Band-3 Gain.
Rotary Param Knob 3 (push) Sets the mixer EQ Band-3 Gain to its default setting.
Rotary Param Knob 4 (turn) Controls the mixer EQ Band-4 Gain.
Rotary Param Knob 4 (push) Sets the mixer EQ Band-4 Gain to its default setting.
Rotary Param Knob 5 (turn) Controls the mixer EQ Band-5 Gain.
Rotary Param Knob 5 (push) Sets the mixer EQ Band-5 Gain to its default setting.
Rotary Param Knob 6 (push) Controls the mixer EQ In switch.
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(EQ Frequency Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer EQ Band-1 Frequency.
Rotary Param Knob 1 (push) Sets the mixer EQ Band-1 Frequency to its default setting.
Rotary Param Knob 2 (turn) Controls the mixer EQ Band-2 Frequency.
Rotary Param Knob 2 (push) Sets the mixer EQ Band-2 Frequency to its default setting.
Rotary Param Knob 3 (turn) Controls the mixer EQ Band-3 Frequency.
Rotary Param Knob 3 (push) Sets the mixer EQ Band-3 Frequency to its default setting.
Rotary Param Knob 4 (turn) Controls the mixer EQ Band-4 Frequency.
Rotary Param Knob 4 (push) Sets the mixer EQ Band-4 Frequency to its default setting.
Rotary Param Knob 5 (turn) Controls the mixer EQ Band-5 Frequency.
Rotary Param Knob 5 (push) Sets the mixer EQ Band-5 Frequency to its default setting.

(EQ Q Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer EQ Band-1 Q (Bandwidth).
Rotary Param Knob 1 (push) Sets the mixer EQ Band-1 Q to its default setting.
Rotary Param Knob 2 (turn) Controls the mixer EQ Band-2 Q (Bandwidth).
Rotary Param Knob 2 (push) Sets the mixer EQ Band-2 Q to its default setting.
Rotary Param Knob 3 (turn) Controls the mixer EQ Band-3 Q (Bandwidth).
Rotary Param Knob 3 (push) Sets the mixer EQ Band-3 Q to its default setting.
Rotary Param Knob 4 (turn) Controls the mixer EQ Band-4 Q (Bandwidth).
Rotary Param Knob 4 (push) Sets the mixer EQ Band-4 Q to its default setting.
Rotary Param Knob 5 (turn) Controls the mixer EQ Band-5 Q (Bandwidth).
Rotary Param Knob 5 (push) Sets the mixer EQ Band-5 Q to its default setting.

(EQ Lo/Hi Cut Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 (turn) Controls the mixer EQ Lo-Cut Frequency.
Rotary Param Knob 1 (push) Sets the mixer EQ Lo-Cut Frequency to its default setting.
Rotary Param Knob 2 (push) Controls the mixer EQ Lo-Cut In switch.
Rotary Param Knob 3 (turn) Controls the mixer EQ Hi-Cut Frequency.
Rotary Param Knob 3 (push) Sets the mixer EQ Hi-Cut Frequency to its default setting.
Rotary Param Knob 4 (push) Controls the mixer EQ Hi-Cut In switch.

(Plug-Ins Mode) Activates and opens (if needed) the FX Pre and FX Pst views.
Ÿ Ctrl mode: Closes all FX patch views.

Left/Right Arrow Buttons Ÿ Menu mode: Navigate left/right in any menu.

Up/Down Arrow Buttons Increment/decrement the current Hot Chan in any mixer view.
Ÿ Menu mode: Navigate up/down in any menu.

Zoom Button Toggles Zoom mode On/Off.
F The Zoom button light is on when Zoom mode is active.

Scrub Button Toggles Scrub mode On/Off. This button interacts with the scrub wheel to
provide alternate functionality.
F The Scrub button light is on when Scrub mode is active.

Scrub Wheel Ÿ Menu mode: Navigate up/down in any menu.

Scrub Wheel
(Zoom Mixer View active) Scrolls up/down mixer module.

Scrub Wheel
(Control Track View active) Navigates up/down through list box entries.

Shift Button Toggles Shift mode On/Off.
F The Shift button light flashes when engaged.

Ctrl Button Toggles Ctrl mode On/Off.
F The Ctrl button light flashes when engaged.

Alt Button Toggles Alt mode On/Off.
F The Alt button light flashes when engaged.
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Auto Mode Button Toggles Mixer Automation mode On/Off.

Fade Button Writes a default automation fade-in or out for the Selected channels, when
Automation mode is active.

View Filter Button Toggles the Automation View filter On/Off.

Enter Button Emulates the Enter key for answering dialog boxes.

Cancel Button Emulates the Esc (cancel) key for answering dialog boxes.
Cancels Shift, Ctrl, or Alt mode operations.

Undo/Redo Button Undo the last operation.
Ÿ Shift mode: Redo the last undo.

F-Key View Buttons (1-8) Selects the associated workspace view.
Ÿ Shift mode: Sets the associated workspace view to the current screen
display.
Ÿ Alt mode: Performs the operation on the alternate workspace view set,
providing a total of 16 workspace views.

Snapshot Session Button Creates an undo file of the current session state.

Save/Update Session Button Saves and updates the current session.

Mackie Baby HUI Surface  (Top)

The Mackie Baby HUI Surface gives you a wide range of control in a small box.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input, Return, and Output channels

based on channel and bank select switches.

Mute Buttons Control mixer mutes.

Solo Buttons Control mixer solos.

Signal Lights Display when active audio data is present.

Rotary Knobs with Shift Btn
(Rec/Rdy) Open and close record meters for the corresponding track.

Left/Right Arrow Btns (Bank) Increment and decrement mixer Hot Chan selection, scrolling the active bank
eight channels at a time left or right.

With Shift Button (Channel) Increment and decrement mixer Channel selection, scrolling the active bank
one channel left or right.

Mixer Button Updates the active bank, aligning the first controller channel to match the
current SAC Hot Chan.

Pan Assignment Button Selects Pan mode.
(Pan Mode)
Rotary Param Knobs 1-8 Control the associated mixer channel pan.

Send (1 thru 4) Assignment
Buttons Select Aux Send mode.
(Aux Send 1 Mode)
Rotary Param Knobs 1-8 (turn) Control the associated mixer channel Aux-1 Level
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Rotary Param Knobs 1-8 (push) Set the mixer Aux-1 Level to its default setting.

(Aux Send 2 Mode)
Rotary Param Knobs 1-8 (turn) Control the associated mixer channel Aux-2 Level
Rotary Param Knobs 1-8 (push) Set the mixer Aux-2 Level to its default setting.

(Aux Send 3 Mode)
Rotary Param Knobs 1-8 (turn) Control the associated mixer channel Aux-3 Level
Rotary Param Knobs 1-8 (push) Set the mixer Aux-3 Level to its default setting.

(Aux Send 4 Mode)
Rotary Param Knobs 1-8 (turn) Control the associated mixer channel Aux-4 Level
Rotary Param Knobs 1-8 (push) Set the mixer Aux-4 Level to its default setting.

Rewind Button 
When a popup menu is active Navigates up the menu options

Fast Fwd Button
When a popup menu is active Navigates down the menu options

Stop Button
When a popup menu is active Acts as the Cancel key.

Play Button
When a popup menu is active Acts as the Enter key.

Write Button Toggles MultiTrack Automation mode On/Off.

Undo Button Undo the last operation.

LED Display Displays the first channel number of the current bank.

CMA MotorMix Control Surface (Top)

The MotorMix LCD display is used to show parameter and channel labels in the various selection
modes. Pan mode is used as the default mode to display channel numbers or labels for the current
bank.

An alternate midi controller template has been added to allow two MotorMix controllers to be used at
the same time for 16 channels of control. The MotorMix units must be upgraded with a new internal
ROM chip available from MotorMix in order for this to work. When ganged together and turned ON,
each controller will set itself to a different midi chan. (chan-1 and chan-2).

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F If using a single controller make sure it is transmitting and receiving on MIDI channel 1 to ensure
compatibility with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input, Return, and Output channels

based on channel and bank select switches.

Mute Buttons Control mixer mutes.

Solo Buttons Control mixer solos.
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A-H Buttons Control mixer Hot Chan selection within the active bank of eight faders.

View Left/Right Arrow Buttons Increment and decrement mixer Hot Chan selection, scrolling the active bank
one channel left or right.

Bank Button Turns bank selection on and off. When this function is active, the View Left
and Right Arrow buttons scroll one bank of eight channels at a time.

Next / Last Button Jumps to the next or previous mixer section (Inputs, Returns, Outputs)

Rotary Selector Knob (Turn) Selects between Pan, Aux Sends, Dynamics, and EQ mode, designating
which group of mixer settings will be adjusted by the parameter knobs and
buttons.

(Pan Mode)
Rotary Param Knobs 1-8 Control the associated mixer channel pan.

(Aux Send-1 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Aux-1 Level.
Rotary Param Knob 2 Controls the mixer Aux-1 Pan.
1 Button Sets the mixer Aux-1 Level to its default setting.
2 Button Sets the mixer Aux-1 Pan to its default setting.
3 Button Controls the mixer Aux-1 In switch.
4 Button Controls the mixer Aux-1 Pst-Fader switch.

(Aux Send-2 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Aux-2 Level.
Rotary Param Knob 2 Controls the mixer Aux-2 Pan.
1 Button Sets the mixer Aux-2 Level to its default setting.
2 Button Sets the mixer Aux-2 Pan to its default setting.
3 Button Controls the mixer Aux-2 In switch.
4 Button Controls the mixer Aux-2 Pst-Fader switch.

(Aux Send-3 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Aux-3 Level.
Rotary Param Knob 2 Controls the mixer Aux-3 Pan.
1 Button Sets the mixer Aux-3 Level to its default setting.
2 Button Sets the mixer Aux-3 Pan to its default setting.
3 Button Controls the mixer Aux-3 In switch.
4 Button Controls the mixer Aux-3 Pst-Fader switch.

(Aux Send-4 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Aux-4 Level.
Rotary Param Knob 2 Controls the mixer Aux-4 Pan.
1 Button Sets the mixer Aux-4 Level to its default setting.
2 Button Sets the mixer Aux-4 Pan to its default setting.
3 Button Controls the mixer Aux-4 In switch.
4 Button Controls the mixer Aux-4 Pst-Fader switch.

(Aux Send-5 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Aux-5 Level.
Rotary Param Knob 2 Controls the mixer Aux-5 Pan.
1 Button Sets the mixer Aux-5 Level to its default setting.
2 Button Sets the mixer Aux-5 Pan to its default setting.
3 Button Controls the mixer Aux-5 In switch.
4 Button Controls the mixer Aux-5 Pst-Fader switch.

(Aux Send-6 Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Aux-6 Level.
Rotary Param Knob 2 Controls the mixer Aux-6 Pan.
1 Button Sets the mixer Aux-6 Level to its default setting.
2 Button Sets the mixer Aux-6 Pan to its default setting.
3 Button Controls the mixer Aux-6 In switch.
4 Button Controls the mixer Aux-6 Pst-Fader switch.
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(Dyn Comp Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Comp Attack.
Rotary Param Knob 2 Controls the mixer Comp Release.
Rotary Param Knob 3 Controls the mixer Comp Ratio.
Rotary Param Knob 4 Controls the mixer Comp Threshold.
1 Button Sets the mixer Comp Attack to its default setting.
2 Button Sets the mixer Comp Release to its default setting.
3 Button Sets the mixer Comp Ratio to its default setting.
4 Button Sets the mixer Comp Threshold to its default setting.
5 Button Controls the mixer Comp On switch.

(Dyn Gate Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Gate Attack.
Rotary Param Knob 2 Controls the mixer Gate Release.
Rotary Param Knob 3 Controls the mixer Gate Floor.
Rotary Param Knob 4 Controls the mixer Gate Threshold.
1 Button Sets the mixer Gate Attack to its default setting.
2 Button Sets the mixer Gate Release to its default setting.
3 Button Sets the mixer Gate Floor to its default setting.
4 Button Sets the mixer Gate Threshold to its default setting.
5 Button Controls the mixer Gate On switch
6 Button Controls the mixer Gate Reverse switch.

(Dyn Key Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer Dyn Key selection.
Rotary Param Knob 2 Controls the mixer Dyn Key Low EQ.
Rotary Param Knob 3 Controls the mixer Dyn Key High EQ.
1 Button Sets the mixer Dyn Key to its default setting.
2 Button Sets the mixer Dyn Key Low EQ to its default setting.
3 Button Sets the mixer Dyn Key High EQ to its default setting.
4 Button Controls the mixer Dyn Key Listen switch.

(EQ Gain Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer EQ Band-1 Gain.
Rotary Param Knob 2 Controls the mixer EQ Band-2 Gain.
Rotary Param Knob 3 Controls the mixer EQ Band-3 Gain.
Rotary Param Knob 4 Controls the mixer EQ Band-4 Gain.
Rotary Param Knob 5 Controls the mixer EQ Band-5 Gain.
1 Button Sets the mixer EQ Band-1 Gain to its default setting.
2 Button Sets the mixer EQ Band-2 Gain to its default setting.
3 Button Sets the mixer EQ Band-3 Gain to its default setting.
4 Button Sets the mixer EQ Band-4 Gain to its default setting.
5 Button Sets the mixer EQ Band-5 Gain to its default setting.
6 Button Controls the mixer EQ In switch.

(EQ Frequency Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer EQ Band-1 Frequency.
Rotary Param Knob 2 Controls the mixer EQ Band-2 Frequency.
Rotary Param Knob 3 Controls the mixer EQ Band-3 Frequency.
Rotary Param Knob 4 Controls the mixer EQ Band-4 Frequency.
Rotary Param Knob 5 Controls the mixer EQ Band-5 Frequency.
1 Button Sets the mixer EQ Band-1 Frequency to its default setting.
2 Button Sets the mixer EQ Band-2 Frequency to its default setting.
3 Button Sets the mixer EQ Band-3 Frequency to its default setting.
4 Button Sets the mixer EQ Band-4 Frequency to its default setting.
5 Button Sets the mixer EQ Band-5 Frequency to its default setting.

(EQ Q Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer EQ Band-1 Q (Bandwidth).
Rotary Param Knob 2 Controls the mixer EQ Band-2 Q (Bandwidth).
Rotary Param Knob 3 Controls the mixer EQ Band-3 Q (Bandwidth).
Rotary Param Knob 4 Controls the mixer EQ Band-4 Q (Bandwidth).
Rotary Param Knob 5 Controls the mixer EQ Band-5 Q (Bandwidth).
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1 Button Sets the mixer EQ Band-1 Q (Bandwidth) to its default setting.
2 Button Sets the mixer EQ Band-2 Q (Bandwidth) to its default setting.
3 Button Sets the mixer EQ Band-3 Q (Bandwidth) to its default setting.
4 Button Sets the mixer EQ Band-4 Q (Bandwidth) to its default setting.
5 Button Sets the mixer EQ Band-5 Q (Bandwidth) to its default setting.

(EQ Lo/Hi Cut Mode) (Operates on the current Hot Chan.)
Rotary Param Knob 1 Controls the mixer EQ Lo-Cut Frequency.
Rotary Param Knob 3 Controls the mixer EQ Hi-Cut Frequency.
1 Button Sets the mixer EQ Lo-Cut Frequency to its default setting.
2 Button Controls the mixer EQ Lo-Cut In switch.
3 Button Sets the mixer EQ Hi-Cut Frequency to its default setting.
4 Button Controls the mixer EQ Hi-Cut In switch.

LCD Display Displays all mode control labels and settings.

Frontier Design TranzPort  (Top)

The Frontier Design TranzPort is a wireless remote controller with a lot of power packed into a very
small box. The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F Make sure your controller is set to Native Mode (TaskBar Icon) to ensure compatibility with this
template.

Controller Surface SAC
Track / Channel Buttons Increments and decrements the channel.

Ÿ Shift mode:  Increments and decrements by eight channels.

Mute Button Toggles Mute on and off for the current channel.

Solo Button Toggles Solo on and off for the current channel.
Ÿ Shift mode:  Toggles all active solos off.

Punch Button Used as a special function button. When active, it causes the scrubwheel to
act as a function selector, scanning through different control types. The
current selectable control types are: Layers; Fader; Pan; Aux 1 In; Aux 1 Pst
Fdr; Aux 1 Lvl; Aux 1 Pan; Aux 2 In; Aux 2 Pst Fdr; Aux 2 Lvl; Aux 2 Pan; Aux
3 In; Aux 3 Pst Fdr; Aux 3 Lvl; Aux 3 Pan; Aux 4 In; Aux 4 Pst Fdr; Aux 4 Lvl;
Aux 4 Pan; Aux 5 In; Aux 5 Pst Fdr; Aux 5 Lvl; Aux 5 Pan; Aux 6 In; Aux 6 Pst
Fdr; Aux 6 Lvl; Aux 6 Pan; Comp In; Comp Gn; Comp Thr; Comp Ratio; Comp
Rel; Comp Att; Gate In; Gate Rvs; Gate Thr; Gate Flr; Gate Rel; Gate Att; Dyn
Key Listen; Dyn Eq Lo; Dyn Eq Hi; Dyn Key; Eq In; Eq LoCut In; Eq LoCut Frq;
Eq HiCut In; Eq HiCut Frq; Eq Gn 1; Eq Frq 1; Eq Q (Bandwidth) 1; Eq Gn 2;
Eq Frq 2; Eq Q (Bandwidth) 2; Eq Gn 3; Eq Frq 3; Eq Q (Bandwidth) 3; Eq Gn
4; Eq Frq 4; Eq Q (Bandwidth) 4; Eq Gn 5; Eq Frq 5; Eq Q (Bandwidth) 5;
Mono; Swap LR; Phase Rvs; Attenuator. The LCD dislays the currently
selected type and value.
Ÿ Shift mode:  Resets the current selected control type to its default value.

Shift Button Used as a momentary modifier key in conjunction with other buttons.

Scrubwheel When the special function (Punch button) mode is not active, the scrubwheel
adjusts the MultiTrack cursor position forward and backward on the timeline.
The LCD displays the current time position in all timeline display modes.
Ÿ Special Function (Punch Button) mode:  Selects various control types.
Ÿ Shift mode:  Adjusts the current control type.



Using MIDI Controller Devices 103

© 2008 - 2010 Robert Lentini and RML Labs

Transport Stop Button Stops playback, record and live input operations.
Ÿ Shift mode:  Saves and updates the session edl.
Ÿ Msg / Dialog mode:  When a message dialog box is active, acts as a
cancel or "no" response. The LCD will display many important messages
directly.

Transport Play Button Ÿ Msg / Dialog mode:  Acts an Okay, Yes, or Enter response.

Frontier Design AlphaTrack  (Top)

The Frontier Design AlphaTrack is a usb connected remote controller with a full sized fader in a small
box.

The LCD display is used to show parameter and channel labels in the various selection modes.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F Make sure your controller is set to Native Mode (TaskBar Icon) to ensure compatibility with this
template.

F Using the Shift Mode does not require you to hold down the Shift Button. Just press it once and
it will engage and light up to show that Shift Mode is active. You can cancel Shift Mode by
pressing the button again. Most commands that use Shift Mode will automatically disengage it
after the command is executed.

Controller Surface SAC
Fader Control mixer channel faders. Can operate Input, Return, and Output channels

based on track / channel select switches. Touching and adjusting the fader
will automatically switch the LCD to Fader Mode and display the fader data.

Shift Button Toggles Shift Mode on / off. Using the Shift Mode does not require you
to hold down the Shift Button. Just press it once and it will engage and
light up to show that Shift Mode is active. You can cancel Shift Mode
by pressing the button again. Most commands that use Shift Mode
will automatically disengage it aftter the command is executed

Solo Button Toggles Solo on and off for the current channel.
Ÿ Shift Mode:  Toggles all active solos off.

Mute Button Toggles Mute on and off for the current channel.

Left or Right Parameter Knob Either of these knobs act as a function selector, scanning through different
control types. Use the left or right knob, depending on whether you are left or
right handed so you do not cover up the display as you turn the knob.

The current selectable control types are: Layer; Fader; Pan; Aux 1 In; Aux 1
Pst Fdr; Aux 1 Lvl; Aux 1 Pan; Aux 2 In; Aux 2 Pst Fdr; Aux 2 Lvl; Aux 2 Pan;
Aux 3 In; Aux 3 Pst Fdr; Aux 3 Lvl; Aux 3 Pan; Aux 4 In; Aux 4 Pst Fdr; Aux 4
Lvl; Aux 4 Pan; Aux 5 In; Aux 5 Pst Fdr; Aux 5 Lvl; Aux 5 Pan; Aux 6 In; Aux 6
Pst Fdr; Aux 6 Lvl; Aux 6 Pan; Comp In; Comp Gn; Comp Thr; Comp Ratio;
Comp Rel; Comp Att; Gate In; Gate Rvs; Gate Thr; Gate Flr; Gate Rel; Gate
Att; Dyn Key Listen; Dyn Eq Lo; Dyn Eq Hi; Dyn Key; Eq In; Eq LoCut In; Eq
LoCut Frq; Eq HiCut In; Eq HiCut Frq; Eq Gn 1; Eq Frq 1; Eq Q (Bandwidth) 1;
Eq Gn 2; Eq Frq 2; Eq Q (Bandwidth) 2; Eq Gn 3; Eq Frq 3; Eq Q (Bandwidth)
3; Eq Gn 4; Eq Frq 4; Eq Q (Bandwidth) 4; Eq Gn 5; Eq Frq 5; Eq Q
(Bandwidth) 5; Mono; Swap LR; Phase Rvs; Attenuator; MultiTrack Position
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The LCD dislays the currently selected type and value.

Center Parameter Knob This knob adjusts the value for the currently selected control type.

Pressing the knob as a switch sets the control to the default value.
Ÿ Shift Mode:  For Aux_Lvl control types sets the control to -inf.

Pan Button Switches the Control Type to Pan for the current channel. The Pan LED lights
when in Pan Mode.

Send Button Switches the Control Type to Aux_Lvl_1 for the current channel. Repeated
pressings switch to Aux_Lvl_2, Aux_Lvl_3, Aux_Lvl_4, Aux_Lvl_5,
Aux_Lvl_6, and then back around to the beginning. The Send LED lights
when in Aux Mode.

EQ Button Switches the Control Type to Eq_In for the current channel. Repeated
pressings switch to Eq_Lo_In, Eq_Hi_In, Eq_Gain_1, Eq_Gain_2,
Eq_Gain_3, Eq_Gain_4, Eq_Gain_5, and then back around to the beginning.
The EQ LED Lights when in Eq Mode.

Plug In Button Activates and opens (if needed) the FX_Pre and FX_Pst  views.
Ÿ Shift Mode: Closes all FX patch views.

Track < Button Decrements the Channel.
Ÿ Ctrl Mode:  Set by pushing the left or right parameter knob. Lights both track
button LEDs and jumps down one section from Output to Return to Input
channels.

Track > Button Increments the Channel.
Ÿ Ctrl Mode:  Set by pushing the left or right parameter knob. Lights both track
button LEDs and jumps up one section from Input to Return to Output
channels.

Flip Button Switches the Control Type to Position. The LCD now displays Timeline
position information in the current Timeline display mode. Pressing the button
again switches the Control Type back to the previous type selection.

Transport Stop Button Stops playback, record and live input operations.
Ÿ Shift Mode:  Saves and updates the session edl.
Ÿ Msg / Dialog Mode:  When a message dialog box is active, acts as a cancel
or "no" response. The LCD will display many important messages directly.

Transport Play Button Ÿ Shift Mode:  Activates Live Mode.
Ÿ Msg / Dialog Mode:  Acts an Okay, Yes, or Enter response.

Touch Strip Acts as a position shuttle which adjusts the MultiTrack cursor position. When
first touched, the Flip button is activated and the LCD will display the cursor
position.

Fostex VM200 Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.
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F Make sure your controller is transmitting and receiving on MIDI channel 1 to ensure compatibility
with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Master Fader Controls the mixer Output-1 fader.

Pans Control mixer pans.

Mutes Control mixer mutes.

General MIDI Controller (Top)

The General MIDI Template requires the use of a separate MIDI channel for each control channel.
The basic General MIDI Template controls sixteen channels, and the 8-Wide General MIDI Template
controls eight channels.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Pans Control mixer pans.

Mutes Control mixer mutes.

Korg 168RC Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F Make sure your controller is transmitting and receiving on MIDI channel 1 to ensure compatibility
with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Pans Control mixer pans.

Mutes Control mixer mutes.

Solos Control mixer solos.

Panasonic WR-DA7 Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
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are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F Make sure your controller is transmitting and receiving on MIDI channel 1 to ensure compatibility
with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Master Fader Controls the mixer Output-1 fader.

Pans Control mixer pans.

Mutes Control mixer mutes.

Sony DMX-R100 Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F Make sure your controller is transmitting and receiving on MIDI channel 1 to ensure compatibility
with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Pans Control mixer pans.

Mutes Control mixer mutes.

Soundcraft Spirit 328 Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F Make sure your controller is transmitting and receiving on MIDI channel 1 to ensure compatibility
with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Pans Control mixer pans.
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Mutes Control mixer mutes.

Solos Control mixer solos.

Tascam TM-D1000 Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F This template requires the use of a separate MIDI channel for each control channel.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Pans Control mixer pans.

Mutes Control mixer mutes.

Yamaha ProMix-01 Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F Make sure your controller is transmitting and receiving on MIDI channel 1 to ensure compatibility
with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Master Fader Controls the mixer Output-1 fader.

Mutes Control mixer mutes.

Yamaha ProMix-01V Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.
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F Make sure your controller is transmitting and receiving on MIDI channel 1 to ensure compatibility
with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Pans Control mixer pans.

Mutes Control mixer mutes.

Yamaha 03D Mixer (Top)

Since a mixer manipulates the audio connected to it's inputs on its own, using a mixer as a controller
requires special consideration. Since the mixer controls will now control SAC's virtual mixer, and SAC
will be manipulating the audio, the audio signals should not be run through the same channels that
are being used as the controller. In most cases, the audio should be kept completely out of the mixer.

The surface can be made to chase SAC's Hot Chan by using one of the Mixer Menu Midi Hardware
Controller Link options.

F Make sure your controller is transmitting and receiving on MIDI channel 1 to ensure compatibility
with this template.

Controller Surface SAC
Faders Control mixer channel faders. Can operate Input channels only.

Pans Control mixer pans.

Mutes Control mixer mutes.

11 Using The SAWStudio Links

11.1 Using The SAWStudio Links

SAC includes internal links directly to SAWStudio Lite and Full. The SAC Link option is activated from
within the SAWStudio app and once a connection link between SAWStudio and SAC has been
established, you can now pass data in both directions for recording and playback with SAWStudio
using internal shared memory buffers that completely bypass the Windows soundcard drivers.
SAWStudio will automatically disconnect from the drivers and use the internal shared buffers to
communicate with the outside world through the SAC engine.

The menu options are selected from within SAWStudio and show up as follows:

The Activate SAC Link option on the SAWStudio Options menu will establish the internal connection
between the two programs. SAC and SAWStudio must both be running at the time, and when the
connection is established, a SAC<–>LINK icon will appear in the left corner of the SAWStudio main
titlebar.

The SAC Link Options option expands out to include these following choices:

The Export Mix Data To SAC option allows you to instantly transfer the main MT track and channel
mix data directly to the SAC FOH console. This will also automatically preset each SAC console
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channel input source to point to the associated SAWStudio MT track. This option allows you to
playback the SAWStudio MT tracks in a 1 to 1 configuration through the SAC console. You can then
use the SAC Monitor mixers to setup separate performer mixes. SAWStudio will not play audio
through its own driver devices while the SAC Link is active. You do not have to make any preference
changes in SAWStudio… the buffer settings will be internally set to relax the SAWStudio cpu load
and rely on SAC to handle the low latency performance. The internal link will adjust for SAWStudio
playback buffer size changing and latency causing plugins and deliver a fixed data stream to SAC
with no changes needed to your edl session in SAWStudio.

The Import Mix Data From SAC Input Chans (Active/Selected) option allows you to instantly
transfer the SAC FOH console setup directly into SAWStudio, including automatically creating a
record template with all channel input assignments preset, ready for a live recording of the current
SAC session. This function includes only active (input source assigned and not disabled) input chans
and properly handles re-ordered SAC chans  when creating the new Record Template. If SAC chans
are selected, then only those chans are included in the import. All that is needed after this option is
activated is to [Ctrl-Click] the first track's record button in the SAWStudio MT to open all record
meters for all active SAC channels, already pre-assigned. You may also [Alt-Click] any track's record
button to automatically open the record template on the proper first imported track. Once again,
SAWStudio completely bypasses the soundcard drivers and gathers its audio data directly from the
SAC engine. This allows SAWStudio to perform the MT record operation with very little added cpu
load on the system, and also relaxes the buffer settings to essentially coast along quietly in the
background while SAC handles the low latency monitoring load.

The Arm Last Imported Record Template option opens the record template and assures that the
record arming begins on the proper imported start track so that all record input assignments will
correctly follow the imported SAC channels. You may also [Alt-Click] any track's record button to
automatically open the record template on the proper first imported track.

The Input Chan Play Tap At SRC option selects the SAWStudio tap for sending its track data to
SAC. This option sends the data from the SRC position at the top of the chan module just after the
Mono section. Using this option means you are essentially sending the playback data directly from
the wav files on each track with no added processing from the SAWStudio virtual console.

The Input Chan Play Tap At PRE-PATCH option selects the SAWStudio tap for sending its track
data to SAC. This option sends the data from just after the PRE-PATCH position within the chan
module. This option would allow VST Synths data to be passed onto SAC and the Pre-Patch position
routing options within SAWStudio will still apply, so some signal processing from SAWStudio may be
part of the signal chain before the data reaches SAC.

The Input Chan Play Tap At PST-FDR option selects the SAWStudio tap for sending its track data to
SAC. This option sends the data from the bottom of the chan module, which includes all chan
processing and automation. Very useful for show playback of pre-recorded tracks.

Once the SAC Link is initiated, the SAC input source options will expand to allow individual
SAWStudio Mixer Chan selections instead of just the hardware device selections. You will see all
SAWStudio label references for each channel in the list. You may select any Input Chan from
SAWStudio or any Output Chan. Selecting an Output Chan allows you to maintain a complete mix in
the SAWStudio environment and only use one stereo input chan in SAC to playback the entire 72
tracks from SAWStudio. Any Input Chan selection is subject to the above mentioned Tap points set in
SAWStudio.

Likewise in SAWStudio, the record meter Input Zone will display the SAC channel list with the SAC
labels. You may record from any SAC channel which will automatically adjust the record meter to
mono or stereo based on the SAC source assignment. An added bonus here is that you now have the
ability to record extra channels in your current SAWStudio version than is possible with SAWStudio
alone. For instance… SAWStudio Lite allows up to 24 record meters which are normally connected to
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the 12 possible stereo hardware devices. Normally that translates to 12 stereo tracks or 24 mono
tracks or any combination in between. But with SAC's ability to handle 36 stereo devices, you would
now have the ability to pass on up to 72 signals in any combination of mono/stereo to the 24 record
meters. Therefore, you can now record up to 24 stereo tracks (48 channels worth of data) in Lite as
long as you have that many channels of hardware devices connected to SAC.

By using the various playback tap points and SAWStudio Mixer Channel source selections, you can
set SAC to play SAWStudio tracks one on one with processing coming from SAWStudio and SAC set
flat, or with SAWStudio set flat and SAC handling the processing. You can also use Output Channel
sources to playback complex sessions as a single stereo mix or with multiple sub assignments and
have SAC handle the playback as stems from the original session, thereby taking less SAC channels
but still giving you hands on live control of various sub groups from the original session.

Recording a live session from the SAC FOH setup is a breeze with SAWStudio running in the
background in a relaxed state accepting signals direct from SAC's input assignments on a channel by
channel basis. And the SAC mix setup and input assignments can be easily passed to SAWStudio
with a single menu option so SAWStudio is ready to record in seconds.

The record signal comes from the Source input of the SAC channels. If the FX Pre-Patch point is
moved to the top of the channel, the record signal will pickup after the Pre-Patch signal. Use this
method for recording from VST synth plugins on a SAC channel.

There are also various Control Track options for sending commands thru the SAC Link to control
various SAC functions, like recalling scenes, etc.

12 Menu Reference Guide

12.1 [SAW - Link]

This option allows a quick link to switch to SAWStudio when the SAWStudio-SAC Link is
active. It will restore and switch to the SAWStudio or SAWStudioLite program when that
program is running and linked with the SAWStudio/SAC Link option.

12.2 File Menu

Open Mix Session

This option opens an existing Mix Session MXS file. Mix Sessions should always be created in their
own project folder. A Mix Session saves all mixer sttings as well as Scenes and Sequence and
Automation data.

F When first opening a Mix Session, the live engine will be forced to shutdown until the
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settings have been processed. The Live light will flash when the session is ready to go.
[Right-Click] the Live Light to start streaming audio.

Close Mix Session

This option closes the current Mix Session and clears the Mixers to default settings.

Recent Mix Session FileList

This option displays a list of the last 30 accessed Mix Session files and complete paths, which can be
used to quickly re-open commonly accessed session files. The list is ordered with the most recent
session file on top.

78 Pressing the [Shift] key when selecting an entry will remove that entry from the list.

Open Last AutoSave Session

This option allows you to open the last AutoSave session file if one exists from the activated
automatic background save option. Note the session name will reflect that you are inside the
autosave session file, not the original session file which may have been opened at the time. The
original file was never overwritten unless you chose to manually save it before you exited the program
or choose to save and overwrite it now.

Save And Update Mix Session (Ctrl-S)

This updates and overwrites the current Mix Session File with no further prompting.

Save Mix Session As…

This options saves the current Mix Session to an MXS file with a new name and makes that the
current session. If the new save destination is in a different folder, this function will automatically
extract and save all the session scene files in that new folder within the Save operation.

Save Mix Session Copy As…

This option saves the current Mix Session to an MXS file with a new name, but does not switch
sessions to the new one. If the new save destination is in a different folder, this function will
automatically extract and save all the session scene files in that new folder within the Save operation.

Mix Template File

Mix template files can be overlaid on the current session at any time. These files store all console
settings, all FX patch information, and Mixer labels.

The installation includes some basic mix templates to make it easy to start a new session and assign
chan sources in groups of 8 chans. When starting a new session, just use one of the basic mix
templates found in the SAC\Mix folder.

The following sub-menu choices are available Mix Template options:
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Ø Open

This option opens an existing Mix Template file which controls the entire mixing console layout,
assignments and settings, including channel names. These files can be overlaid on the current
session without disturbing existing Scenes.

Ø Save

This option saves the current mix template information to a .MXT file.

Ø Save Default

This option saves the current mixing console setup as the default setup. This setup will be used each
time the program is started or a session is closed to start a new one.

Ø Clear Default

This option clears the current default Mix Template file and SAC will revert back to using its internal
mixing console defaults for new sessions.

F When first opening a Mix Template, the live engine will be forced to shutdown until the
settings have been processed. The Live light will flash when the session is ready to go.
[Right-Click] the Live Light to start streaming audio.

Midi-Control Template

F For specific MIDI controller device details, see the chapter titled Using MIDI Controller Devices.

The following sub-menu choices are available Midi-Control Template File options:

Ø Open

This option loads a template containing the MIDI commands and function hooks for different MIDI
Controller devices. A dialog box will be displayed showing the currently available MIDI control
templates.

F New templates will be added as the different controller data becomes available.

The active template can be saved with your preferences.

Ø Save

This option saves the current MIDI commands and function hooks to a .MCT file.

Ø Clear

This option clears the currently open MIDI controller template.

F If preferences have been saved with an open MIDI controller template, the program will always
load with that template active. Using this option to clear the open template, and then saving the
preferences, will allow the program to load without an active template.

F-Key File

The following sub-menu choices are available F-Key File options:

Ø Open

This option opens a Function-Key template file that contains a complete set of workspace views, and
makes this the active set of function keys.
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F When you exit the program and restart the program, the current workspace views will be return to
the default F-Key Template. To save the current set of workspaces as the default function keys,
use the Save Default F-Key File option from the File menu.

Ø Save

This option saves the current Function-Key workspace views to a .FKY file. This can be handy for
creating different workspace environments for different project types or screen resolutions.

Ø Open Alternate

This option opens a Function-Key template file that contains a complete set of alternate workspace
views, and makes this the active set of alternate function keys.

Ø Save Alternate

This option saves the current alternate Function-Key workspace views to a .FKY file.

Ø Save Default

This option saves the current Function-Key setup as the default for when the program starts.

Ø Clear Default

This option clears the default Function-Key file and SAC will revert back to its internal F-Key defaults.

Preferences File

The following sub-menu choices are available Preferences File options:

Ø Open

This option opens an existing Preferences configuration file and re-initializes the program to those
settings.

Ø Save

This option saves the current program setup as a .PRF file. This is handy for saving different
configurations or sound card setups for different project types.

Ø Save Default

This option saves the current setup as the default Preferences for when the program starts.

F Use this option each time you change a global setting or option that you wish to retain each time
you start the program.

Ø Clear Default

This clears the default Preferences file and SAC will revert back to its internal defaults.

Shades

This option allows you to load different graphic libraries called Shades (available as free downloads
at www.SoftwareAudioConsole.com and from third party developers), which completely control how
the SAC interface looks. The following sub-menu choices are available Shades options:

Ø Open

This option displays the Open Shades File dialog box to the Shades program folder where you may
choose from available .shd  graphics files listed. The name of a loaded shade file will be displayed
next to this option.

Ø Reset To Original Vintage



SAC User Manual114

© 2008 - 2010 Robert Lentini and RML Labs

This option allows you to switch back to the original SAC interface graphics. The active graphic
library can be saved with the Preferences as the default.

Exit

This option exits the program. If the engine is still live, the program will display a warning message.
You must manually shutdown the engine before exiting.

12.3 Edit Menu

Undo Session (Ctrl-<)

This option allows you to Undo the last session manipulation (i.e. functions affecting mix changes,
etc.). SAC has the ability to maintain up to 99 levels of multiple undos. Each time this option is used,
SAC steps backward one more level in the undo history. When the oldest undo level is recalled, this
option will be grayed and unavailable.

Redo Session (Ctrl->)

This option allows you to Redo the last undo operation. SAC has the ability to maintain up to 99
levels of multiple undos. Each time this option is used, SAC steps forward one more level in the undo
history. When the newest undo level is recalled, this option will be grayed and unavailable.

Recover Session Last Undo

This option opens a file dialog displaying the U00 undo data information files for your different
sessions. Pick the session of interest and the last stored undo file will attempt to be opened. In most
cases this will recover you from unsaved or crashed data circumstances to the last, or close to the
last, editing operation performed when the session was last open.

F If your session crashed or was closed without saving, exercise this option to open the session for
the best chance of recovering potentially lost data. If this option fails to recover your session, try
the Display Session Undo History option to access all of the undo history files available for this
session.

Recover Session Undo

This option allows you to see all undo files (.u01 - .u99) for each session in a folder. You may select
any one of them to attempt to recover a session that was somehow lost or corrupted. If there is an
active session, only the undo files for that session name will be displayed. If there is no active
session, all undo files for all sessions will be displayed.

Display Session Undo History

This option displays an Undo History listbox, with undo history listed from the most recent change to
the oldest change, going back as many levels as you have setup in the Set Session Undo Levels
configuration. Each entry will have a date and time stamp and a text message describing the event.
[Double-Clicking] any of the items will safely open that undo file allowing you to freely look around the
entire history. This does not damage the list or main file in any way. The top of the list is the most
recent operation saved. Sometimes one more level of redo is available to reach the final status of the
session.
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F Session undo history is saved as separate MXS files, and can be accessed at anytime - even
weeks or months after the session was last open.

Clear Session Undo History

This option clears the undo files and the history of the open session or a session of your choice if
there is no active session open.

If the current session has not been named, selecting this option opens the File dialog box, displaying
all .u00 files for all sessions. Select the session history file you wish to clear, and click OK.  All
associated .uxx history files for that Session will be deleted.

If the current session is named, a confirmation prompt is displayed. Click OK to delete the history files
for the current Session, or Cancel to cancel the operation.

Set Session Undo Levels

This option allows you to select the number of undo levels that will be saved during Session
manipulations.

When selecting this option, a dialog box is displayed allowing you to enter a number from 1 to 99.

This setting can be saved with your preferences.

I Regarding setting undo levels: It is recommended that undo levels be set to a reasonable number
like 10 or 20 to avoid creating large numbers of history files for each of your sessions and using
up valuable hard drive space unnecessarily. In most cases, the session condition has changed
significantly after 10-20 manipulations, most likely making it meaningless to recover a session
beyond that level.

*Special Snapshot Function*

Pressing the [*] key on the keyboard numpad will force a snapshot (undo) of your current session.
This can later be recovered as an undo item. Use this before performing automation or recording so
you can revert back to before the numerous changes were made if you change your mind.

12.4 Mixer Menu

SampleRate

This option displays a list of SampleRate choices for the entire session. This determines the
destination session SampleRate. The following sub-menu choices are available:

Ø 44100
Ø 48000
Ø 88200
Ø 96000
Ø Custom (Select any rate between 3000 and 400000)



SAC User Manual116

© 2008 - 2010 Robert Lentini and RML Labs

This setting can be saved with your preferences.

Resolution

This option displays a list of resolution settings for the entire session. This determines the destination
resolution of the session and the audio device hardware must be capable of playback at this setting.
The Mix Engine internally keeps all data at the 24 bit level and dithers or truncates on the final output
only, according to the chosen settings. The following sub-menu choices are available:

Ø 16 Bits
Ø 20 Bits
Ø 24 Bits

This setting can be saved with your preferences.

Dither

This option will add a 1 bit random dither noise pattern to the output device buffers.

Unfortunately, the newer Behringer ADA8000 units (since Dec 2009… Date Code 0912) have
changed the audio codec chip to a new Cirrus Logic chip. This chip has become popular in other
devices as well. This chip is supposed to be of higher quality than the previous codec, but has a
default Auto Mute behavior which mutes the DAC side of the chip when it sees a series of 8192 zero
data buffers.

The chip then un-mutes when it sees new data with non-zero values. Unfortunately, the un-muting
can behave in a random fashion and actually ramp up in a slow manner like a slow timed release
gate… sometimes taking 3-6 secs to open up completely depending on the audio material.

The chip can be programmed to disable this so called feature, unfortunately the Behringer units do
not do this at this time (currently July 2010). This behavior causes the initial attack of playback
material, or solo material to be lost for a random amount of time. Any audio software that starts and
stops playback will miss the first audio attacks.

The dither option can be activated in SAC to keep the chip active at all times, fixing this otherwise
annoying behavior. Unfortunately, there is no current method for fixing this behavior within
SAWStudio, the Media Player, I-Tunes player, or any other audio program that starts and stops
playback. Hopefully Behringer will address this issue, and hopefully other hardware products using
this chip will properly disable this behavior.

If you have newer ADA8000 units that exhibit this missing data behavior on startup or on the solo bus,
activate the Dither option and save the preferences.

Clear All Mixers To Default

This option clears all mixers to the internal default or default mix template settings.

Clear Current Mixer

This option clears only the current mixer, including the monitor Master Out 1 label if the mixer is a
monitor mixer.
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Clear All Mixer Labels

This option clears all the mixer labels.

Clear Current (Or Selected) Mixer Labels

This option clears selected channel mixer labels or all channel mixer labels for the current mixer only.

Meter Active

This option activates the built-in meter displays on the Full, Zoom and Wide Mixer Views. The meters
do add CPU overhead to the mix engine and can therefore be de-activated if needed. The following
sub-menu choices are available:

Ø Full Mixer View
Controls meter displays for the Full Mixer View.

Ø Exploded/Zoom/Wide Mixer View
Controls meter displays for the Exploded, Zoom, and Wide Mixer Views.

These settings can be saved with your preferences.

Meter PeakHold

This option controls how the peak information is displayed on the meters. The following sub-menu
choices are available:

Ø Off
PeakHold information is not displayed.

Ø Infinite
PeakHold information is displayed forever. Higher peaks keep pushing the display to a higher notch
on the meters.

Ø Slow
PeakHold information is retained on the meter for a reasonable length of time and then starts to
decay. Higher peaks will push the display higher again.

Ø Fast
PeakHold information is retained on the meter for a short time and then starts to decay. Higher peaks
will push the display higher again.

These settings can be saved with your preferences.

Meter Response

This option controls the response time of the meters to transient information. The following sub-menu
choices are available:

Ø Slow
Meters have a long decay period essentially smoothing out the overall response and absorbing fast
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transient material.

Ø Med
Meters have a good average decay period allowing for a smooth visual display but still catching and
displaying fast transient material.

Ø Fast
Meters have a short decay period effectively display all very fast transient material. Overall
appearance can become jerky.

These settings can be saved with your preferences.

Meter Tap Point

This option controls the tap point within the channel signal flow for the meter data.. The following sub-
menu choices are available:

Ø Input/Return - Src
This option displays the meter data at the source position at the top of the module, after the
attenuator, phase and mono sections.

Ø Input/Return - Pre-Fdr
This option displays the meter data just before the mute switch and fader.

Ø Input/Return - Pst-Fdr
This option displays the meter data at the end of the channel signal chain.

Ø Output - Src
This option displays the meter data at the source position at the top of the module, after the
attenuator, phase and mono sections.

Ø Output - Pre-Fdr
This option displays the meter data just before the mute switch and fader.

Ø Output - Pst-Fdr
This option displays the meter data at the end of the channel signal chain.

The separate Input/Return and Output settings can be quite handy for example, to monitor input src
signals to set mic pre gain trims, while at the same time monitor output pst fader levels to see actual
mix levels being sent to the amps . These settings can be saved with your preferences.

Chan Fader Taper

This option allows you to select from different fader control tapers that affect how the fader reacts in
its dB to movement ratio, effectively allowing you to control the 'sweet spot' of the fader in five
separate zones.

Ø Standard Log
This is the default option, and is a true log taper reacting very much like a long throw physical console
fader in its movement to dB ratio. There is a comfortable working range in the center of the fader to
make finer adjustments to dB level changes.

Ø Expanded Log
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This option expands the sweet spot around the zero dB position to allow for smaller increments in dB
changes with longer movements of the fader in both directions.

Ø Condensed Log
This option condenses the sweet spot toward a more even or linear reaction near the zero dB
position.

Ø Linear
This option creates an even scaling of motion to dB changes across the entire range of the fader.

Ø Custom
This is a special option that allows you to alter the way the fader reacts in five actual scaling zones.
When selecting this option, an exploded view of Channel 1 is displayed and the main fader shows
three nodes along the right side of the fader zone. These three nodes control the +6dB, -12dB and -
36dB points starting from the top down. The +6dB node controls the plus section of the fader above
the zero dB position, providing two separate scaling areas above and below the node. The other two
nodes control the reaction of the fader below the zero dB position, providing three more scaling
zones.
By [Left-Dragging] these nodes, you can control the actual stretching or shrinking of the various
zones and determine how the main sweet spot center area of the fader reacts to movement. You may
also select one of the preset tapers while this special edit mode is active which will allow you to start
with that as a basis for building your own taper. The custom taper is updated when you close this
special exploded view window.
Selecting any one of these options and then saving your default preferences will save your selected
fader taper and use that as the default each time you open the program.

Navigation Links

This option controls how the various views link together during navigation. Combined with the use of
the individual view lock option, this offers some exciting operational flexibility. The following sub-menu
choices are available:

Ø Link Full Mixer View To HotChan
When activated, causes the Full Mixer view to chase the current Hot Channel.

Ø Link Zoom Mixer View To HotChan
When activated, causes the Zoom Mixer view to chase the current Hot Channel.

Ø Link Wide Mixer View To HotChan
When activated, causes the Wide Mixer view to chase the current Hot Channel.

Ø Link Epld Mixer View To HotChan
When activated, causes the Exploded Mixer view to chase the current Hot Channel.

Ø Link Midi Hardware Controller To HotChan
When activated, causes the Midi Hardware Controller to chase the current Hot Channel, aligning the
first fader to the Hot Channel.

Ø Link Midi Hardware Controller To Full Mixer View
When activated, causes the Midi Hardware Controller to chase the Full Mixer View only, aligning the
first fader to the Hot Channel.

Ø Link Midi Hardware Controller To Zoom Mixer View
When activated, causes the Midi Hardware Controller to chase the Zoom Mixer View only, aligning
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the first fader to the Hot Channel.

Ø Link Midi Hardware Controller To Wide Mixer View
When activated, causes the Midi Hardware Controller to chase the Wide Mixer View only, aligning the
first fader to the Hot Channel.

These settings can be saved with your preferences.

F [Right-Clicking] on the Close button of the Full, Zoom, Exploded or Wide mixer view, locks or
unlocks that view. Moving around in any of the other views will not cause the current locked view
to chase along. You may still change chans in the locked view itself, but it will no longer be linked.
The Close button will change to display a small padlock when the view is locked.

Full Mixer Label Position

This option allows you to place the Full Mixer vertical labels at the top, center or bottom position
within the label area. The following sub-menu choices are available:

Ø Top
Ø Center
Ø Bottom

This setting can be saved with your preferences.

Pre-Fx Patch Signal Flow

This option allows the Pre-Fx Patch insert point to be moved in front of the Eq and Dynamics sections
to the source position of the channel modules on a channel by channel basis. Selecting this option
displays a popup channel menu. [Left-Click] any channel to toggle the option on and off. You may
also [Ctrl-Left-Click] any channel to toggle all channels at the same time.

F Moving the Pre-Fx Patch insert point to the front can be very useful when using VST Synth plug-
ins. This allows you to use the Mono, Attenuator, Phase Rvs, Swap LR and Eq and Dynamics
section of the channel to directly process the synth output signals. These settings save with the
Mixer Templates and also with each session edl file. These settings clear when  sessions are
closed. If you use a default Mixer Template, you can arrange the default console signal routing
any way you like and those settings will be used each time the console is reset.

Eq / Dyn Signal Flow

This option allows the Dynamics section to be moved in front of the Eq section of the channel
modules on a channel by channel basis. Selecting this option displays a popup channel menu. [Left-
Click] any channel to toggle the option on and off. You may also [Ctrl-Left-Click] any channel to toggle
all channels at the same time.

F These settings save with the Mixer Templates and also with each session file. These settings
clear when  sessions are closed. If you use a default Mixer Template, you can arrange the default
console signal routing any way you like and those settings will be used each time the console is
reset.
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SAC Link Rec / Play Tap Point At SRC PRE ATT

This option sets the record and playback tap point for SAWStudio using the SAC Link connection to
the source signal before the Attenuator control. The playback signal from SAWStudio (when changing
the input source to the SS Mixer Chan) will insert at the same place, so that the exact signal will be
fed thru the module chain to facilitate the virtual band mix tweaking concept. You can create a scene
with all inputs set to device sources for recording, then create another scene with all inputs set to the
corresponding SS Mixer Chan for virtual Band playback. Recall the scenes to switch back and forth
between the live inputs and the virtual band playback.

SAC Link Rec / Play Tap Point At SRC PST ATT

This option sets the record and playback tap point for SAWStudio using the SAC Link connection to
the source signal after the Attenuator control. The playback signal from SAWStudio (when changing
the input source to the SS Mixer Chan) will insert at the same place, so that the exact signal will be
fed thru the module chain to facilitate the virtual band mix tweaking concept. You can create a scene
with all inputs set to device sources for recording, then create another scene with all inputs set to the
corresponding SS Mixer Chan for virtual Band playback. Recall the scenes to switch back and forth
between the live inputs and the virtual band playback.

SAC Link Rec / Play Tap Point At PRE FDR

This option sets the record and playback tap point for SAWStudio using the SAC Link connection to
the source signal just before the main fader. The playback signal from SAWStudio (when changing
the input source to the SS Mixer Chan) will insert at the same place, so that the exact signal will be
fed thru the module chain to facilitate the virtual band mix tweaking concept. You can create a scene
with all inputs set to device sources for recording, then create another scene with all inputs set to the
corresponding SS Mixer Chan for virtual Band playback. Recall the scenes to switch back and forth
between the live inputs and the virtual band playback.

Solo Mode

These options select the way in which the solo switches operate. Solo Bus mode is generally used for
live mixing situations and routes the solo signal to one of the solo bus devices without disturbing the
FOH or any other outputs.

There are two independent solo buses, one for FOH and one for Monitors. This allows a FOH and
Monitor engineer access to the same host system with independent routing of solo selections. Any
connected computer that has FOH User Rights will solo out to the FOH Solo Bus Device, while MON
User Rights computers will solo out to the MON Solo Bus Device.

Solo In Place mode is used more for studio mixing situations where an exact reference of position and
level are needed. This operates by muting all other signals and leaving the soloed signals in place.

Remote computers with Personal Monitor User Rights use an enhanced solo mode that acts similar to
Solo In Place mode. Engaging solo on a remote personal monitor computer will highlite the soloed
channel in place by dropping the other chans 12 db. This allows the performer to stay in time with the
rest of the performance while still hearing the soloed channel clearly above the rest.

Ø The Solo Bus – Pre Fader
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This mode functions as a true console PFL Solo. This mode leaves all other channels alone and
feeds the pre-fader signal of soloed channels into a separate mix bus which can be assigned with the
Solo Bus Out Device option. If this device is your main mix bus, the solo signal will interrupt the main
mix output, but not disturb any other channel signals. The solo level may also be adjusted with the
Solo Bus Level options.

Ø The Solo Bus – Post Fader

This mode functions as a true console bus solo. This mode leaves all other channels alone and feeds
the post-fader signal of soloed channels into a separate mix bus which can be assigned with the Solo
Bus Out Device option. If this device is your main mix bus, the solo signal will interrupt the main mix
output, but not disturb any other channel signals. The solo level may also be adjusted with the Solo
Bus Level options.

Ø The Solo Bus – Pre Fader (Input/Return) /  Post Fader (Output)

This mode functions as a combination console bus solo. For Input and Return channels., this mode
leaves all other channels alone and feeds the pre-fader signal of soloed channels into a separate mix
bus which can be assigned with the Solo Bus Out Device option. For Output channels, it feeds the
post-fader signal. If the Solo Bus device is your main mix bus, the solo signal will interrupt the main
mix output, but not disturb any other channel signals. The solo level may also be adjusted with the
Solo Bus Level options.

Ø The Solo Bus – Post Fader (Input/Return) /  Pre Fader (Output)

This mode functions as a combination console bus solo. For Input and Return channels., this mode
leaves all other channels alone and feeds the post-fader signal of soloed channels into a separate
mix bus which can be assigned with the Solo Bus Out Device option. For Output channels, it feeds the
pret-fader signal. This mode is similar to a solo-in-place mode but without other channels being
muted. It maintains a fairly constant level between input, return and output chan solos and keeps the
chans stereo image within the mix. If the Solo Bus device is your main mix bus, the solo signal will
interrupt the main mix output, but not disturb any other channel signals. The solo level may also be
adjusted with the Solo Bus Level options.

Ø The Output Post Fader Solo Tap At Post-Fx

This option taps output post solo modes after the Pst-Fx patch point. The default mode for post-fader
solos is pre of the Pst-Fx patch. This is useful when you do not want to hear various output monitor
eq patches in your solo monitors, that may be inserted strictly to adjust for different monitor speakers
and in-ear monitor variations. Activating this option taps the post solo signals after the Pst-Fx so you
will hear any Fx patched there

Ø The FOH Solo Bus Out Device

This option can be used to route the FOH solo signal to a separate device output to monitors or
headphones, leaving the main mix bus intact, so as not to disturb the FOH signal.

Ø The MON Solo Bus Out Device

This option can be used to route the Monitor solo signal to a separate device output to monitors or
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headphones, leaving the main mix bus intact, so as not to disturb the FOH or Monitor signals.

Ø The Solo Bus Level

This option can be used to adjust the solo level feeding the Solo Device. This can also be set by
[Right-Clicking] the Main Solo light when the solo mode is set to one of the bus modes.

Ø The Clear Solo Bus Master Offset Chan

This option clears any preset Master Solo Offset Output Chan which is used as a latch that allows the
master solo bus level to chase a specific output chan fader. You can set any output chan fader as the
master offset chan by Right-Clicking on its solo switch and selecting the Master Solo Offset option.
Very useful in a studio configuration where your solo bus device is the same as the Control Room.
Setting the Master Output channel as the Master Solo Offset chan, will keep the solos chasing the
control room volume when they interrupt the normal mix. You can also use this option to designate an
extra output fader onscreen to control the master solo level instead of using the popup menus

Ø The Solo In Place (Mutes Other Channels)

This mode internally mutes channels that are not soloed, giving a true exact In Place Solo for critical
mix decision making. This mode will affect channel signals and console outputs.

F All of these options can be saved in the preferences file.

Touch Screen Mode

When this option is active, it forces you to touch the fader knobs accurately and will not attempt to
jump the touch position to the knob as it does with the mouse click position. This will also adjust the
popup fader window position to place the current knob under your touch position. This mode keeps
you from radically jumping a fader when using a touch screen.

12.5 View Menu

Full Mixer

Displays the Full Mixer View and brings it to the top.

Zoom Mixer

Displays the Zoom Mixer View and brings it to the top.

Wide Mixer

Displays the Wide Mixer View and brings it to the top.
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FX Choices

Displays the FX Choices View and brings it to the top.

FX Pre Patches

Displays the FX Pre Patches View and brings it to the top.

FX Post Patches

Displays the FX Post Patches View and brings it to the top.

FX Solo Patches

Displays the FX Solo Patches View and brings it to the top.

1 - Scenes

Displays the Scenes View and brings it to the top.

2 - Sequence

Displays the Sequence View  and brings it to the top.

3 - Control

Displays the Control View and brings it to the top.

Touch Panel

Displays the floating Touch Panel View and brings it to the top.

Touch Panel Visable As Default

Forces the display of the the floating Touch Panel View as the default. Select this option, then Save
the Prefernces Default File.

12.6 Smpte/Midi Menu

Smpte/Mtc Format
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This option allows you to choose a Smpte/MTC Format for your project. This setting saves with the
Session. The following sub-menu choices are available:

Ø 30 Non-Drop
Ø 30 Drop
Ø 29.97 Non-Drop
Ø 29.97 Drop
Ø 25
Ø 24
Ø 23.97 Non-Drop

Smpte/Mtc Sync

This option allows you to select a method to synchronize SAC to other software applications or
hardware devices.

These settings save with individual MXS files.

The following sub-menu choices are available:

Ø Generate Smpte Sync
Causes SAC to generate Smpte LTC timecode as the master to any selected stereo audio device out,
with no additional SMPTE hardware required. The device is selected in the Sync Device Setup option
under the Options menu. The software generated timecode is extremely precise and maintains exact
sync with the audio device clock. The Output Chan controls for the specific device out allow you to
route and adjust the timecode data level. The Output Chan will be automatically labeled and assigned
as a direct device out.

Ø Generate Mtc Sync
Causes SAC to generate MTC MIDI timecode as the master through any selected MIDI out port. The
port is selected in the Sync Device Setup option under the Options menu. The software generated
MTC code can then be routed back to a MIDI In port on the same computer or to another computer or
hardware sequencer to lock MIDI sequencer playback to the Sequence position.

Ø Generate Smpte And Mtc Sync
Causes SAC to generate both SMPTE LTC and MTC MIDI timecode to their respective output
devices.

Ø Trigger From Smpte Sync
Not yet active.

Ø Trigger From Mtc Sync
This option sets the system ready to read incoming timecode for triggered Sequence operations. This
mode only looks for external sync when you first press the [SpaceBar] or [Return] key. The Sync Light
flashes yellow notifying you that the system is waiting for external timecode to start the Sequence
operation. You may press the [SpaceBar] or [Return] key again to cancel the waiting mode.

The system reads the incoming timecode, skipping the Delay Frame Count number of frames, then
immediately jumps the Sequence position to the proper cue point, and adjusts the position by the
Trigger Advance and Latency Adjust values, pre-loads the data and starts synchronized sequence
playback when the timecode reaches the cue position.

This is a one time operation. When the Sequence is stopped, you are free to work without the
external sync until you initiate the waiting sequence again with the [SpaceBar] or [Return] key.
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You may also [Left-Click] on the Sync Light to temporarily toggle the Trigger Mode on and off. The
system remembers the mode it was in when it toggles off and resets the same mode when it toggles
on.

Ø Chase Trigger From Smpte Sync
Not yet active.

Ø Mtc Trigger Sync Advance
Determines how many seconds of preload time is added when determining the trigger point. On fast
systems with smaller session loads, you can set this value to 2 or 3 seconds. On dense sessions
which take a few seconds to pre-load before Sequence operation begins, you should set this value to
4-6 seconds. If this value is set too low, the session will miss the trigger point and simply drop out of
lock and stop the operation. This value saves with the preferences.

Ø Mtc Trigger Sync Delay Frame Count
Determines how many frames are thrown away when the first sync signals arrive. This allows you to
adjust for skewing problems as a tape deck with sync code comes up to speed or a sync generator
that creates initial noise or spikes when first started, before settling down to a steady code output.
This value saves with the preferences.

Ø Mtc Trigger Sync Latency Adjust
Allows you to compensate for MIDI latency by offsetting the trigger point by a certain number of sub-
frames. This allows you to adjust for inherent system delays and gain a more accurate sync. This
value saves with the preferences.

Ø Sync Trigger Auto Format Detect
Activates a format auto detection function when sync is first received. If this option is on, whenever a
new format is detected in the incoming timecode, the format is changed to match and the Sequence is
re-cued. If this option is off, you may preset the format and it will not be changed even when timecode
is received in a different format. This can be useful for receiving 29.97 MTC code for instance,
because there is no provision in the MTC protocol to define this format. This value saves with the
preferences.

Ø Sync Trigger Auto Stop Detect
Activates the auto stop detection function. If this option is on, whenever incoming sync trigger
timecode is lost for any reason, the program disengages any active Sequence operation. This value
saves with the preferences.

Smpte/Mtc Start Offset

This option allows you to set the SMPTE/MTC Start Offset time for the Sequence session. When a
start offset is set, the entire Sequence timeline will be shifted so that the home position is then equal
to the start offset value, and all lesser values are no longer visible. When selecting this option, the
Enter Smpte dialog box is displayed. Set the desired time and click OK.

F While in Smpte Mode you may [Left-Click] in the Position Readout area to display the Input
Smpte Dialog Box. Entering a Smpte position will jump the Sequence position to that position
when the dialog box is closed without canceling.

F For more information on using the Enter Smpte dialog box,  see the Working with Smpte/Mtc
TimeCode helpfile section.

Midi-Control In Active
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This option activates the MIDI-Control input functions. This allows external hardware MIDI controller
devices to send commands to SAC controlling many mix and transport operations. This option
requires a MIDI device to be setup in the Midi Device Setup option under the Options menu.

This setting can be saved with your preferences.

Midi-Control In Filter

This option filters incoming signals from MIDI controllers or mixers. The commands that are filtered
are ignored. The following sub-menu options are available:

Ø Faders Off
Ø Mutes Off
Ø Solos Off

This setting can be saved with your preferences.

Midi-Control Out Active

This option activates the MIDI-Control output functions. This allows SAC to send MIDI controller
commands to external Midi devices for control and feedback of many mix and transport operations.
This option requires a MIDI device to be setup in the Midi Device Setup option under the Options
menu.

This setting can be saved with your preferences.

Midi-Control Out Filter

This option filters outgoing signals to MIDI controllers or mixers. The commands that are filtered are
not sent to the controllers. The following sub-menu options are available:

Ø Faders Off
Ø Mutes Off
Ø Solos Off

This setting can be saved with your preferences.

12.7 Options Menu

Audio Device Setup

This option opens a dialog of options to setup your audio device hardware and settings which control
audio playback and real-time latency. The following settings are available in the Audio Device Setup
dialog box.

Up/Dn Arrow Zone

Switches the display of Wave Devices between the first 18 and the second 18.

Out/In
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Switches the display of Wave Devices between Output devices and Input devices.

Reset

Resets all Wave Devices of the displayed type to None.

Cancel

Cancels all changes and exits the dialog box.

Ok

Accepts changes and exits the dialog box.

Wave Devices

Assigns a audio device driver to a specific Wave Device in SAC.

PreLoad Buffers

This setting controls how many buffers of data are preloaded to the audio device before output
streaming begins. This affects the response time of live controls such as mutes, solos, faders, etc. If
this setting is too low for your system, audio stuttering or glitching during playback may occur,
especially when minimizing or sizing windows, etc. on a complex session. This setting combines with
the Out Buffer Size setting to determine the final latency.

Use the PreLoad Buffers listbox to choose a setting between 1 and 6. Lower values will give you
faster response times.

Buffer Size

Use the Buffer Size listbox to choose from six different settings ranging from 32 to 1024 samples.

The combination of the Buffer Size and the PreLoad Buffer value control the latency of the real-time
engine. Lower latency values give live, instantaneous response and the feel of a real physical
console. You eill need to acheive settings of 3 x 128 or lower for a realtime live audio console feel.

F Some combinations that result in the same low latency value will cause the system to glitch while
other combinations will perform comfortably. For instance, 2 buffers at 128 size might cause static
or glitching on certain audio devices, but the same latency value can be obtained by using 4
buffers at 64 size, and the audio device may play back perfectly.

When you are finished with all adjustments, click OK, then save your default settings by clicking on
the File menu and selecting Preferences File | Save Default.

Midi Device Setup

This option opens a dialog of options to setup your Midi devices for hardware controller devices. The
following settings are available in the Midi Device Setup dialog box.

Reset

Resets all Midi Devices to None.

Cancel

Cancels all changes and exits the dialog box.

Ok

Accepts changes and exits the dialog box.

Midi In/Out Devices

Assigns a driver to a Midi In and Out device for receiving and sending Midi controller information to
external hardware controller devices.
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These settings can be saved with the preferences.

Sync Device Setup

This option opens a dialog of options to setup your Sync devices for SMPTE or MIDI MTC
synchronization. The following settings are available in the Sync Device Setup dialog box.

Reset

Resets all Sync Devices to None.

Cancel

Cancels all changes and exits the dialog box.

Ok

Accepts changes and exits the dialog box.

MTC In/Out Devices

Assigns a driver to an MTC In and Out device for receiving and sending MIDI MTC synchronization
code.

SMPTE In/Out Devices

Assigns a driver to a SMPTE In and Out device for receiving and sending SMPTE synchronization
code. The SMPTE Out device that you select must be one of the Audio Out devices set up in the
Audio Device Setup. For example, if you have a 16-channel sound card, your Audio Device Setup
would list devices 1-8 (stereo devices - 2 channels per device.) Selecting Device 8 for the SMPTE
Out device would send SMPTE out channels 15 and 16 of your sound card.

These settings can be saved with the preferences.

Touch Device Setup

Added support for the 3M MicroTouch 10 finger touch screen. Now you can grab multiple faders at
once onscreen with your fingers. I recommend you set the Touchscreen mode in the Mixer Menu to
avoid faders snapping to your finger position.

You must install the MT7 drivers and select Legacy Mode when asked. I also recommend you then
use the driver calibration tool to calibrate the touch screen and also set the double-click area to about
50% of the slider bar.

Some useful gestures built into the SAC MT7 driver support to learn and practice are:

[Right-Click]… done by tapping two fingers held very close together in a short single tap movement.
The finger to the left is the actual right-click screen point, so you can use this as the actual tap
position as if you right-clicked with a mouse pointer at that specific screen position. There is only a
single tap, but both fingers must hit the screen at the same time.

[Right-Hold]… done by creating the right-click two finger gesture, but keeping the fingers in contact
with the screen… the left finger is the important touch position. This can then be used for vertical
scrolling the Zoom Mixer window, by sliding the finger up or down in the same manner as when using
the mouse. Only the left finger needs be held on the screen once the two finger right-click gesture is
recognized.

[Left-Flick]… done by a single finger touch and a quick flick motion to the left with the finger dragging
on the screen. This can be used in the mixer views to page flip the current mixer to lower chan
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numbers. For instance… if 8 Z-Mixer chans are visible and the start chan is currently chan 9, this
gesture would flip the view to start on chan 1.

[Right-Flick]… done by a single finger touch and a quick flick motion to the right with the finger
dragging on the screen. This can be used in the mixer views to page flip the current mixer to higher
chan numbers. For instance… if 8 Z-Mixer chans are visible and the start chan is currently chan 1,
this gesture would flip the view to start on chan 9.

3M MicroTouch Resolution

Sets the screen resolution of your 3M MicroTouch display.

3M MicroTouch X-Offset

Sets the X-Offset of the display if it is used as a second monitor.

3M MicroTouch Y-Offset

Sets the Y-Offset of the display if it is used as a second monitor.

These settings can be saved with the preferences.

File Path Setup

This option sets up various default paths for session, configuration, data and other files used within
the SAC environment. The following settings are available in the File Path Setup dialog box.

Click in the desired path you wish to change and type the new path, or click the Browse or Current
Path zones to select a new path.

Browse

Opens a browse dialog for navigating to the folder of your choice.

Current Path

Inserts the path currently being used for the specified choice.

Reset

Resets all paths to internal defaults.

Cancel

Cancels all changes and exits the dialog box.

Ok

Accepts changes and exits the dialog box.

Session EDL Path

The Mix Session Path text box allows you to specify the default location you wish to access when
either opening or saving a Mix Session (mxs file). By default, this path is set to the Mix folder inside
the SAC program folder on the drive you installed the program. This default is intended as a
temporary path only. We recommend creating a Mix-Session folder in a separate location from your
SAC program folder, and on a drive containing sufficient hard disk space. It is also recommended
that for each new session project, you first create a separate project folder and then place the mxs
session files inside that. Scenes and other operations will create other files and folders under the
project folder.

Mix Template Path
Sets the default path used for Mix Template files.
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EDL Undo Path
The Session Undo Path determines the default location for all session undo files. If left blank, all undo
files will be saved to the currently open Session file path location. You may create a separate Undo
folder to store all undos for all sessions, if desired.

Another option is to enter a sub-folder of the EDL project folder by starting the folder name with a
backslash character. For example, entering \Undo will force all undo files for each session to be
saved in a sub-folder named Undo under the session folder. This helps keep the session folder better
organized and easier to maintain. If you decide to use this feature, you must manually create the
same folder under existing session folders and copy all existing undo files for current sessions into
this folder in order for them to be automatically available. New sessions will automatically create this

folder when the first undo file is created.

These settings can be saved with the preferences.

Color Setup

This option allows you to set Mixer Channel Label Colors as well as the Mixer Hot Channel color. This
option pops up a dialog listing 16 label colors and the Hot Channel color. Clicking in any one of the
color squares pops up the Windows Color Picker dialog. You may change any of the colors and then
click OK to exit and save the new color selections. If you click CANCEL, no changes will be applied.
When color data has been altered a SAC_CustomColor.dat file is created in the main SAC folder.
When using remotes, the color set of the Host machine will be sent to each remote when first
connecting, so that session color information matches on each remote. When the remote disconnects,
the original remote color set is restored.

Audio Driver Model

This option displays a choice of driver models. The following sub-menu options are available:

Ø Standard MultiMedia
This choice is the common Windows MultiMedia driver mode.

Ø Hi Performance MultiMedia
This choice eliminates certain redundant driver function calls during playback/record operations for
slightly higher performance possibilities. Not all sound cards support this mode.

Ø 24 Bit WDM Compatible MultiMedia
This choice allows full 24 bit operation for newer sound cards which use only the WDM driver model.
Previous Multimedia compatibility would only work in 16 bit mode.

Ø DWave Protocol
The DWave Protocol is a SAWStudio and SAC original driver model offering much more direct
communication between the sound card and the application for very high performance possibilities.
This mode is currently still under development.

Ø Asio Protocol
Asio Protocol should allow low buffer latencies to be attainable on most machines if your audio card
has ASIO drivers. When this mode is engaged, all input and output devices supported by the ASIO
driver are setup as default in the Audio Device Setup section. If you're not using all inputs and
outputs, you might obtain slightly better performance by clearing unused devices from the Audio
Device Setup section. The ASIO driver dictates the buffer size to the host application. Therefore,
when the ASIO protocol is engaged, the buffer size option in the Audio Device Setup section reflects
the size set by the driver, but is not adjustable in this location. If the ASIO driver requests a buffer
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size that is not an even power of 2 (i.e. 64, 128, 256, 512, etc.) performance may be slightly impaired.
In this situation, try using the ASIO Driver Setup option, and see if the driver allows you to adjust the
buffer size in the driver control panel to an even power of two for best performance.

Whenever the Asio Protocol mode is selected, the ASIO Data Format Type will be displayed on the
Asio Protocol menu option line. This information will display the Integer or Floating Point data format
type that the driver uses.

Ø Asio Driver Setup
This option allows access to the ASIO Driver Control Panel settings if the driver supports that option.
If any driver settings are adjusted, SAC will automatically reinitialize the driver link and reset all
applicable data buffer settings. If settings are changed, some ASIO drivers will only issue a reset
request once the engine is started. In this case, SAC will handle the re-initialization at that time and
there will be slight delay before data streaming begins.

Activate TCP/IP Host/Master Mode

This option is available on the main SAC program only, and allows the program to operate as the
Host/Master machine across a standard Ethernet 100 base-T network. Activating this option displays
the Host/Master signature on the main window title bar and allows the program to accept up to 28
Remote machine connections. [Left-Clicking] in the Host/Master icon area will display a list of all
connected remotes and their user-rights.

Activate TCP/IP Remote Mode

This option is available on the SACRemote program only, and allows the program to operate as a
Remote machine that can control another machine running SAC as the Host/Master. The Remote
machine will link and synchronize to the Master machine when a connection is established.

Activate TCP/IP Slave Mode

This option allows the program to operate as a Slave machine that can sync to another machine
running SAC as the Host/Master. The Slave machine will link and synchronize to the Master machine
when a connection is established.

TCP/IP Computer User-Rights List

This option allows you to set user rights for the Host/Master computer as well as all remote connected
computers. You can assign each computer by name and lock it's user rights to FOH, MON, MON-
FOH, or any one of the Personal Monitor Mixers. These settings automatically save in their own .ini
file each time they are altered. If a remote computer has NO ACCESS as its setting, all windows will
be disabled. The computer will see signal meters but will have no control of the mixers and other
windows. All remote computers start out with NO ACCESS status until the Host/Master computer sets
the user rights in the TCP/IP Computer User-Rights List option.

A user with FOH rights has access to all mixers and uses the FOH Solo bus when soloing.

A user with MON rights hass access to all monitor mixers only and uses the MON Solo bus when
soloing..

A user with MON-FOH rights has access to all mixers but still uses the MON solo bus when soloing.
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A user with PER 1-24 rights has access to only his own mixer and uses the special 12db cut of all
other chans when soloing.

TCP/IP Port

This option allows you to enter the network port to be used for network communications. The Master
and Slave/Remote machines must use the same port. There is a list of possible available ports in the
dialog for setting this value.

TCP/IP Host Computer Name/Address

This option allows you to enter the network computer name or TCP/IP address for the Host/Master
machine. This option is only used for the Slave and Remote machines.

Auto Save/Recall ShutDown Session

This option will auto save the current session settings to a background Shutdown.mxs file located in
the SAC\Mix folder. When you restart the program, this file will be recalled resetting all mixer
settings. Note the session name will reflect that you are inside the shutdown session file, not the
original session file which may have been opened at the time. The original file was never overwritten
unless you chose to manually save it before you exited the program or choose to save and overwrite
it now. After activating this option, save the preferences.

Background AutoSave Delay Time

This option allows you to set a delay time from 0 to 300 secs which will auto save the current session
settings to a background AutoSave.mxs file located in the SAC\Mix folder. The option is turned off if
the value is set to zero. The File menu now includes an option to open this AutoSave session file at
any time. Note the session name will reflect that you are inside the autosave session file, not the
original session file which may have been opened at the time. The original file was never overwritten
unless you chose to manually save it before you exited the program or choose to save and overwrite
it now. After activating this option, save the preferences.

Force Single CPU

This option allows you to force the Mix Engine back to one CPU, if desired, for testing and comparing,
or to allow other applications full use of the second processor. This option will be grayed out and
unavailable on single CPU machines.

Force High Priority Class

This option allows for safely increasing the process priority internally to High priority. You may force
the priority of the program to be raised above normal for a possibly more robust performance level.
Be careful with this, however, because you will force SAC above other system processes and if the
program locks for some reason, you may not be able to escape, even from the Task manager. This
can be useful, however, for stopping interference from other background services and processes and
may allow smooth audio operation at very low latency settings.

Force RealTime Priority Class

This option allows for safely increasing the process priority internally to RealTime priority. You may
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force the priority of the program to be raised above normal for a possibly more robust performance
level. Be careful with this, however, because you will force SAC above other system processes and if
the program locks for some reason, you may not be able to escape, even from the Task manager.
This can be useful, however, for stopping interference from other background services and processes
and may allow smooth audio operation at very low latency settings.

Message/Dialog Box Position

This option allows control over message and dialog box placement on dual screen monitors. The
following sub-menu options are available:

Ø Top Left
Ø Top Center
Ø Top Right
Ø Center Left
Ø Center
Ø Center Right
Ø Bottom Left
Ø Bottom Center
Ø Bottom Right
Ø Follow Mouse

This option saves with the preferences.

Monitor Configuration

This option allows the program to keep popup messages and dialogs that follow mouse positions from
splitting across the gap between monitors. The following sub-menu options are available:

Ø Single
Ø Dual Left To Right
Ø Dual Top To Bottom

This option saves with the preferences.

Max Screen Resolution Override

The program attempts to determine the full virtual screen resolution across all monitors. This will not
work on all systems or video card drivers, so the reported resolution can be overridden if needed, and
new values can be manually entered and saved with the preferences. This option allows you to set a
new max screen resolution which will control the limits of all window positions.

12.8 Info Menu

Help Contents

This option opens the SAC HelpFile.

Latest Release Notes
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This option opens the Latest Release Notes file. All update enhancements and bug-fixes will be listed
here. Check this file every time you receive a new version update.

About

This option displays the latest version information about the program.
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